# Table of Contents

## Introduction

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>FreeFlow Web Services</td>
<td>1</td>
</tr>
<tr>
<td>The Print Service Provider Guide</td>
<td>1</td>
</tr>
</tbody>
</table>

## Web Services User Overview

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessing Web Services</td>
<td>4</td>
</tr>
<tr>
<td>Accessing Web Services locally</td>
<td>4</td>
</tr>
<tr>
<td>Status Icon</td>
<td>5</td>
</tr>
<tr>
<td>Frequently Used Terminology</td>
<td>5</td>
</tr>
<tr>
<td>Navigating Web Services</td>
<td>6</td>
</tr>
<tr>
<td>Logging Out of Web Services</td>
<td>6</td>
</tr>
</tbody>
</table>

## Conventions Used in Web Services

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing Queues</td>
<td>7</td>
</tr>
<tr>
<td>Displaying and Hiding Queue Columns</td>
<td>8</td>
</tr>
<tr>
<td>Sorting Jobs</td>
<td>8</td>
</tr>
<tr>
<td>Repositioning Jobs</td>
<td>8</td>
</tr>
</tbody>
</table>

## Using Web Services Features

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing Attachments</td>
<td>9</td>
</tr>
<tr>
<td>Uploading Files</td>
<td>9</td>
</tr>
<tr>
<td>Downloading Files</td>
<td>10</td>
</tr>
<tr>
<td>Importing and Exporting Database Files</td>
<td>10</td>
</tr>
<tr>
<td>Generating and Editing Job Tickets</td>
<td>12</td>
</tr>
</tbody>
</table>

## Defining System Settings

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring System Properties</td>
<td>14</td>
</tr>
<tr>
<td>Defining Connection Properties</td>
<td>14</td>
</tr>
<tr>
<td>Allowing FTP Uploads</td>
<td>14</td>
</tr>
<tr>
<td>Defining Calendar and Work Hours</td>
<td>15</td>
</tr>
<tr>
<td>Defining the PDF Preview</td>
<td>16</td>
</tr>
<tr>
<td>Enabling Remote Assistance</td>
<td>16</td>
</tr>
</tbody>
</table>
Setting Up an SSL Server ....................................................................................................................... 17

Defining Language ................................................................................................................................. 17

Defining Terms and Conditions .............................................................................................................. 18

Customizing the Home Page .................................................................................................................. 19
  Defining the Customize Link .................................................................................................................. 19
  Defining the Logout link ......................................................................................................................... 20
  Accessing the FAQ Link ........................................................................................................................ 20
  Customizing Help .................................................................................................................................. 21
  Defining Contact Information .............................................................................................................. 21
  Defining the Contact Us Link ................................................................................................................. 22
  Defining Home Page Text ...................................................................................................................... 22
  Defining Home Page Images .................................................................................................................. 23

Setting System User Privileges ............................................................................................................. 23
  Print Buyer User Privileges Tables ...................................................................................................... 24

Defining Print Service Provider Users .................................................................................................. 26

Defining System Email Settings ........................................................................................................... 27

Verifying System Fonts .......................................................................................................................... 28

Setting Job Expiration Time Limits ......................................................................................................... 29

Customizing Fields ................................................................................................................................. 29
  Editing a Dropdown List ........................................................................................................................ 30

Defining Data Export .............................................................................................................................. 31

Defining Credit Card Integration ........................................................................................................... 31

Integrating Web Services with Other Systems ....................................................................................... 32

Defining Print Settings ............................................................................................................................. 33

Defining Production Parameters ............................................................................................................ 34
  Setting Image Resolution Warning ...................................................................................................... 34
  Setting Size Difference .......................................................................................................................... 34
  Setting Default Gutters .......................................................................................................................... 35

Managing Output Devices ....................................................................................................................... 36
  Adding Output Devices .......................................................................................................................... 36
  Defining General Output Device Parameters ....................................................................................... 36
Accessing the Output Device list ................................................................. 36
Adding ICC Profiles to the System ................................................................. 37

**Defining Output Device Channels** ................................................................. 38
 Removing Output Devices ............................................................................... 40

**Defining Print Imposition** ............................................................................... 41

**Defining Third-party Imposition Jobs** .......................................................... 47

**Defining Press Setup Parameters for Pricing Calculation** ............................... 48

**Setting Speed and Waste** ............................................................................... 48

**Defining Labor Charges** .................................................................................. 49

**Defining Click Charges** .................................................................................. 50

**Managing the Stock Library** ........................................................................... 50

**Importing and Exporting Stock** ...................................................................... 51

**Searching the Stock Library** ............................................................................ 52

**Setting Paper Sizes** ........................................................................................ 54

**Defining Shipping** ........................................................................................... 55
 Defining Carriers .............................................................................................. 55
 Defining Shipping Methods .............................................................................. 55
 Defining Carrier Pricing .................................................................................. 58
 UPS ....................................................................................................................... 58
 USPS - United States Postal Service .................................................................. 59
 FedEx Online ..................................................................................................... 60
 Registering with FedEx ....................................................................................... 60
 Defining Shipping Method Groups ................................................................... 62

**Account Setup** ................................................................................................. 63

**Account Setup Overview** ................................................................................. 64
 Using the Accounts Pane .................................................................................. 65

**Creating a New Account** ............................................................................... 66
 Defining General Settings for a New Account .................................................. 66
 Defining Users for a New Account ................................................................... 67
 Defining the Account Checkout Process .......................................................... 69
Managing Accounts ................................................................. 71
Managing Account Access .......................................................... 71
Modifying Account Preferences .................................................. 71
Defining Account Utilities .......................................................... 72
Defining the PDF Preview ............................................................. 74
Defining Self Registration Details .............................................. 74
Defining Pricing Settings ............................................................. 75
Setting the Account Job-ordering Windows ................................... 78
Defining Account Branding .......................................................... 79
Selecting Shipping Method Groups for the Account ..................... 80
Managing Users ............................................................................. 81
Defining User Groups Settings .................................................... 83
Managing the Account Departments ............................................ 84
Defining the Account Cost Centers .............................................. 84
Defining Email Notification Settings .......................................... 86
Customizing Order Fields at the Account Level ............................. 87

Store Setup ................................................................................. 89

Catalog Overview .......................................................................... 90
Superstore Catalogs ....................................................................... 90
Superstore Look and Feel .............................................................. 91
HTML Catalogs ............................................................................ 94

Creating and Managing Superstore Catalogs ............................... 95
Managing Superstores ................................................................. 95
Moving a Category ......................................................................... 95
Copying a Category ....................................................................... 95
Renaming a Category .................................................................... 95
Deleting a Category ....................................................................... 96
Creating a Superstore ................................................................. 96
Adding Products to a Superstore ................................................ 97
Defining Superstore Content Using the Add Products Option .......... 97
Defining Superstore Content Using the Add Queries Option .......... 97
Removing Items from the Content List .......................................... 99
Applying a Layout Theme to a Superstore .................................... 99
Using the Edit Layout Theme Wizard .......................................... 100
Defining the Items Area ............................................................... 102
Defining the Cross Sale Area ....................................................... 102
Defining the Navigation Pane ...................................................... 103
Adding Messages ........................................................................ 104
Previewing the Superstore or Category ....................................... 104

Creating and Managing HTML Catalogs .................................. 105
Managing HTML Catalogs ......................................................... 105
Renaming a Catalog .................................................................... 105
### Table of Contents

Deleting a Catalog .......................................................................................................................... 105  
Creating an HTML Catalog .............................................................................................................. 105  
Adding Templates to an HTML Catalog ............................................................................................ 106  
Setting HTML Catalog Template Parameters .................................................................................. 106  
Defining a Catalog’s Properties .......................................................................................................... 107  
Exporting an HTML Catalog ............................................................................................................. 110  
Sending an HTML Catalog by Email ................................................................................................. 110

**Managing the Cross Sales Library** ............................................................................................. 110  
Managing Cross Sales ..................................................................................................................... 111  
Duplicating a Cross Sale ................................................................................................................... 111  
Deleting a Cross Sale ........................................................................................................................ 111  
Creating and Populating Cross Sales ............................................................................................... 111  
Removing a Product from a Cross Sale ............................................................................................ 112

**Managing the Image Library** ....................................................................................................... 112  
Managing Folders ............................................................................................................................ 112  
Creating a New Folder ..................................................................................................................... 112  
Renaming a Folder ........................................................................................................................... 112  
Deleting a Folder .............................................................................................................................. 112  
Managing Images ............................................................................................................................. 113  
Changing the Image Display Mode ................................................................................................. 113  
Moving One or More Images Between Folders .............................................................................. 113  
Creating a Copy of One or More Images in Another Folder ........................................................... 113  
Renaming an Image .......................................................................................................................... 113  
Deleting One or More Images ......................................................................................................... 113  
Downloading One or More Images ................................................................................................... 114  
Uploading Images ............................................................................................................................ 114

**Managing the Database Library** ................................................................................................. 115  
Adding a Database to the Library .................................................................................................... 115  
Checking a Database ........................................................................................................................ 115  
Deleting a Database ........................................................................................................................ 115  
Updating a Database ....................................................................................................................... 116

**Job Business Flow** ..................................................................................................................... 117

**General Overview** ....................................................................................................................... 118

**Joblets** ......................................................................................................................................... 119  
Managing Joblets ............................................................................................................................ 120  
Renaming a Joblet ............................................................................................................................. 120  
Deleting a Joblet ............................................................................................................................... 121  
Disabling a Joblet ............................................................................................................................. 121  
Creating a New Joblet ....................................................................................................................... 121  
Editing a Joblet ................................................................................................................................ 121
Print Service Provider Guide

Job Types ................................................................................................................................. 127
  How Many Job Types to Create? ......................................................................................... 128
  Managing Job Types .......................................................................................................... 128
  Renaming a Job Type ........................................................................................................ 128
  Deleting a Job Type ........................................................................................................... 129
  Disabling a Job Type ......................................................................................................... 129
  Duplicating a Job Type ...................................................................................................... 129
  Editing a Job Type ............................................................................................................. 129
  Creating a Simple Job Type ............................................................................................... 129
  Adding General Information to a Job Type ...................................................................... 130
  Intent ..................................................................................................................................... 130
  Ordering Sequence ........................................................................................................... 134
  Settings ............................................................................................................................... 137
  Job Type Groups .................................................................................................................. 141

Templates .............................................................................................................................. 143
  Template Types ................................................................................................................... 143
  Template Creation ............................................................................................................. 143
  Template Structure ............................................................................................................. 144
  Content ................................................................................................................................. 144
  Intent ..................................................................................................................................... 144
  File Report .......................................................................................................................... 144
  Managing Templates .......................................................................................................... 144
  Renaming a Template ........................................................................................................ 144
  Deleting a Template .......................................................................................................... 145
  Copying a Template ........................................................................................................... 145
  Moving a Template ............................................................................................................ 145
  Editing a Template ............................................................................................................. 145
  Adding an Archive to a Template ....................................................................................... 146
Managing the Workflow Policy of a Template ................................................................. 146
Managing the Access Rights of a Template ................................................................. 146
Sending a Template as MailToPrint ........................................................................... 147
Enabling a Template for Inventory ............................................................................. 148
Creating a New Template ......................................................................................... 149
Adding General Information to a Template ............................................................. 149
Upload File .................................................................................................................. 149
Specifying the Intent .................................................................................................... 150
Using the File Report .................................................................................................... 150
Variable Information ..................................................................................................... 152
Defining the Ordering Sequence .................................................................................. 153
Defining the Settings ...................................................................................................... 153
Creating a New Template from an Existing Job ......................................................... 154

Creating Variable Data Templates ............................................................................. 155
Select Variable Data Fields .......................................................................................... 155
Selecting Variable Text Fields ..................................................................................... 155
Selecting Variable Image Fields .................................................................................. 156
Defining Variable Data Field Properties .................................................................... 156
Text Fields .................................................................................................................... 156
Image Fields .................................................................................................................. 163
Advanced Options ......................................................................................................... 165
Arrange Fields ............................................................................................................... 172
Changing the Sequence of Fields ................................................................................ 172
Splitting Fields into Several Tabs ................................................................................. 173

Pricing ............................................................................................................................. 175

Pricing Overview ......................................................................................................... 176
  Concepts ....................................................................................................................... 176
  Calculation Model ....................................................................................................... 176
  Line Item ....................................................................................................................... 177
  Tax Package .................................................................................................................. 178
  Pricing Process Overview .......................................................................................... 178
  Setup .............................................................................................................................. 178
  Job Pricing .................................................................................................................... 179
  Order Pricing ............................................................................................................... 179
  Price Management ....................................................................................................... 180

Setup ............................................................................................................................... 181
  Set-up Tax Packages ................................................................................................... 181
  Managing the Tax Packages ....................................................................................... 182
  Managing Taxes .......................................................................................................... 184
  Set-up Job Type Pricing .............................................................................................. 186
  Selecting a Job Type .................................................................................................... 186
  Selecting a Template ................................................................................................... 186
Setting-up Intent Pricing...................................................................................................................... 186
Intent Pricing Examples .......................................................................................................................... 188
Setting-up Manual Pricing.................................................................................................................... 191

Price Management .......................................................................................................................... 192
Manually Pricing a Job.......................................................................................................................... 192
Checking and Modifying Job Pricing.................................................................................................... 193
Checking and Modifying Order Pricing............................................................................................. 193

Line Item Library ............................................................................................................................ 195
Types of Line Items .............................................................................................................................. 195
Setup Line Items .................................................................................................................................. 195
Result Line Items .................................................................................................................................. 195
Managing the Line Item Library ......................................................................................................... 195
Searching for a Line Item .................................................................................................................... 196
Creating a New Line Item .................................................................................................................... 196
Editing Line Items .................................................................................................................................. 196

Managing Site Customization Skins .............................................................................................. 199

Creating Skins................................................................................................................................... 200
Accessing The Skin Editor .................................................................................................................. 200
Customizing the Login Page ............................................................................................................... 200
Customizing the Site Frame ............................................................................................................... 201
Customizing the Launch Pad ............................................................................................................... 202
Customizing the Email Banner .......................................................................................................... 203
Customizing the Catalog Banner ....................................................................................................... 204
Saving and Previewing Views ............................................................................................................ 204

Editing Skin Elements ...................................................................................................................... 205
Uploading Images .............................................................................................................................. 206
Editing the Final Design .................................................................................................................... 207

Uploading Designs............................................................................................................................ 208
Converting HTML Pages to .mht Files .............................................................................................. 208

Activating Page Elements ................................................................................................................ 209
Selecting Languages .......................................................................................................................... 211
Specifying First Page After Login .................................................................................................... 211
Defining User Privilege Views ......................................................................................................... 212
Defining and Editing for the Various User Types ............................................................................. 212

Managing the Skin Library .............................................................................................................. 213
Accessing the Skin Library ............................................................................................................... 213
Assigning Skins to Print Buyers ......................................................................................................... 214
Designating a Default Skin ................................................................................................................ 214
Production Management 215

Production Queue Overview ............................................................... 216

Managing Jobs in the Production Queue ................................. 217
Managing the Production Queue Job List ........................................ 217
The Job Details Panel ........................................................................ 217
Viewing and Editing Job Properties .................................................... 219
Attaching Files to the Job ................................................................. 220
Viewing and Modifying a Job’s Crop and Bleed Parameters ........ 221
Editing Job Imposition ........................................................................ 222
Manual Impose .................................................................................. 225
Imposition Schemes .......................................................................... 225
Ganging Jobs for Production .............................................................. 227
Layout Maker Overview ...................................................................... 227
Printing Jobs Using the Layout Maker .................................................. 228
Printing Book Assembly Jobs on More Than One Output Device 229
Creating a Job Ticket ......................................................................... 230
Editing a Job Ticket .......................................................................... 231
Viewing Book Assembly Job Details .................................................. 231

Managing Notifications and Alerts ........................................ 232

Producing Jobs .................................................................................. 234
Outsourcing Jobs to a Partner Print Service Provider .......................... 234
Print Service Provider Workflow ......................................................... 234
Partner Print Service Provider Workflow ............................................. 235
Changing the Status of a Job .............................................................. 235
Approving a Job for Printing .............................................................. 236

Delivery Queue ................................................................................ 237
Delivery Queue Overview ............................................................... 237
Managing the Jobs for Delivery Panel ............................................... 238
Managing Delivery in the Batch Order Panel ...................................... 239
Viewing Carrier Tracking Status ...................................................... 239
Editing Delivery Information .............................................................. 240
Printing Shipping Labels ................................................................. 241
Estimating Shipping Costs ................................................................. 241
Approving Jobs for Delivery .............................................................. 242
Managing the Shipped Deliveries Panel .............................................. 242

Track Jobs ....................................................................................... 244
Searching for Jobs ............................................................................ 244
Defining Job Search Criteria .............................................................. 244
Defining and Saving Job Search Information ........................................ 247
Managing Tracked Jobs ...................................................................... 247
Creating a Template with a Local Database ....................................................................................... 273
Ordering a Job with a Local Database ............................................................................................... 275
Viewing Job Details ............................................................................................................................ 248
Changing Job Status ............................................................................................................................ 248
Deleting Jobs ........................................................................................................................................ 249
Viewing and Editing Job Properties .................................................................................................... 250
Viewing and Editing Job Pricing ......................................................................................................... 250
Viewing and Editing Job Ticket .......................................................................................................... 251
Viewing and Editing Order Pricing .................................................................................................... 251
Reprinting Job ...................................................................................................................................... 252
Saving a Job as a Template .................................................................................................................. 253
Searching for an Order ....................................................................................................................... 253

**Direct Marketing Links**

**DirectSmile Image Generator** ......................................................... 256
- Installing DirectSmile Image Generator ......................................................................................... 256
- New Setup ........................................................................................................................................ 256
- Verification ....................................................................................................................................... 256
- Upgrade .......................................................................................................................................... 257
- Creating a Template with a DirectSmile Image ............................................................................ 257
- Ordering a Job from a Template with a DirectSmile Image ........................................................... 259

**XMPie PersonalEffect Integration** .............................................. 260
- Installing XMPie PersonalEffect .................................................................................................... 260
- New Setup ....................................................................................................................................... 260
- Upgrade .......................................................................................................................................... 261
- XMPie PersonalEffect Server Information .................................................................................... 261
- Print Service Provider Side ............................................................................................................ 261
- Importing an XMPie PersonalEffect Template to the Web Services System .................................. 263
- Print Buyer Side ................................................................................................................................ 264
- Restrictions and Known Limitations ............................................................................................... 265

**USADATA** .................................................................................... 265
- Installing USADATA ......................................................................................................................... 265
- Verification ....................................................................................................................................... 266
- Upgrade .......................................................................................................................................... 266
- Creating a Template with a USADATA Database ........................................................................... 267
- Ordering a Job with a USADATA Database ..................................................................................... 269

**Local DB List Acquisition** .......................................................... 271
- Installing Local DB List Acquisition ............................................................................................... 271
- New Setup ....................................................................................................................................... 271
- Upgrade .......................................................................................................................................... 272
- Creating a Template with a Local Database .................................................................................... 273
- Ordering a Job with a Local Database ............................................................................................. 275
# Table of Contents

## Credit Card

- Integrating with Web Services Credit Card Vendors ........................................ 278
- Adding Web Services Credit Card Service Vendors ........................................ 279

## Excel Pricing

- Settings in Web Services ......................................................................................... 282
  - Assigning Excel Pricing to a Print Buyer ................................................................. 282
  - Importing/Exporting the Excel Pricing File ............................................................... 282
- Excel Pricing File Format ......................................................................................... 283
  - Understanding the File Format ................................................................................. 283
  - Column A .................................................................................................................... 283
  - Column B .................................................................................................................... 284
  - Column C .................................................................................................................... 288
  - Column D .................................................................................................................... 289
  - Excel Pricing with the Book Assembly Module ......................................................... 289
- Excel Programming and Useful Excel Functions .................................................... 290
  - IF Function ................................................................................................................ 290
  - Sample IF Syntax ...................................................................................................... 290
  - Vlookup Function .................................................................................................... 290
  - MATCH ...................................................................................................................... 291
  - INDEX ...................................................................................................................... 291
  - DGET Function ....................................................................................................... 291
  - VBA ......................................................................................................................... 292

## Set

- Set Definitions ............................................................................................................ 294
  - Binding Styles .......................................................................................................... 294
  - Components ............................................................................................................. 294
  - Set Pricing ................................................................................................................. 294
- Defining a Set Job Type ............................................................................................. 295
  - Defining Binding Properties .................................................................................... 295
  - Setting General Properties ..................................................................................... 295
  - Setting Page Size Properties .................................................................................. 296
  - Setting Material Properties .................................................................................... 296
  - Setting Pricing Properties ....................................................................................... 296
  - Defining Component Properties ............................................................................ 296
  - General Properties ................................................................................................. 296
Paper Selection Properties ................................................................. 297
Color Channel Properties ........................................................................... 297
Finishing Properties .................................................................................. 297
Pricing Properties ..................................................................................... 297

**Defining a Set Preview** ................................................................. 298
Preparation .......................................................................................... 299
Optional Spine ................................................................................... 299
Establish the Preview Size ......................................................................... 299
Establish the Left and Right Page Position .............................................. 300
Setting up a New Preview ........................................................................ 301
Setting up a Binding Preview ................................................................. 301

**Producing a Set Job** ................................................................. 301
List of Figures

Figure 1: Web Services Toolbox ................................................................. 4
Figure 2: Status Icon on the Status Bar ..................................................... 5
Figure 3: Frequently Used Terminology ..................................................... 5
Figure 4: Links .......................................................................................... 6
Figure 5: Queues ....................................................................................... 7
Figure 6: Import Database .......................................................................... 10
Figure 7: Print Buyer User Privileges ......................................................... 24
Figure 8: Default Gutter ........................................................................... 35
Figure 9: Print Imposition Option Graphic Representations ....................... 43
Figure 10: Original Business Card with no Bleed ........................................ 45
Figure 11: Re-scaled Business Card .......................................................... 45
Figure 12: Reduced Size Business Card ...................................................... 45
Figure 13: Account Setup - General Info window ........................................ 64
Figure 14: Export Account dialog box ........................................................ 65
Figure 15: Account Setup - New User window ............................................ 68
Figure 16: User Types and their privileges ................................................. 69
Figure 17: Account Setup - Checkout window ............................................ 70
Figure 18: Account Setup - Preferences window, Utilities panel ................. 72
Figure 19: Account Setup - Preferences window, Pricing panel .................. 75
Figure 20: Account Setup - Cost Centers window ....................................... 85
Figure 21: Panel Layouts .......................................................................... 91
Figure 22: Account Selection List ............................................................. 96
Figure 23: Account Selection List ............................................................. 106
Figure 24: Joblet Library .......................................................................... 120
Figure 25: Job Type Library ..................................................................... 128
Figure 26: Job Type Intent Tab ................................................................. 131
Figure 27: Job Type Ordering Sequence Tab ............................................. 136
Figure 28: Job Type - Settings - Quantity ............................................... 138
Figure 29: Quantity Example .................................................................... 139
Figure 30: Job Type Groups ..................................................................... 142
Figure 31: Detailed File Report ................................................................. 151
## List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>Selective Upload</td>
<td>155</td>
</tr>
<tr>
<td>33</td>
<td>Output Format</td>
<td>159</td>
</tr>
<tr>
<td>34</td>
<td>Simple Drop-down Menu</td>
<td>160</td>
</tr>
<tr>
<td>35</td>
<td>Complex Drop-down Menu</td>
<td>162</td>
</tr>
<tr>
<td>36</td>
<td>Position Links</td>
<td>167</td>
</tr>
<tr>
<td>37</td>
<td>Suffix</td>
<td>168</td>
</tr>
<tr>
<td>38</td>
<td>Group Centering</td>
<td>169</td>
</tr>
<tr>
<td>39</td>
<td>Empty Fields</td>
<td>170</td>
</tr>
<tr>
<td>40</td>
<td>Identical Input Fields</td>
<td>171</td>
</tr>
<tr>
<td>41</td>
<td>Style Selection</td>
<td>172</td>
</tr>
<tr>
<td>42</td>
<td>Multiple-tax Package</td>
<td>183</td>
</tr>
<tr>
<td>43</td>
<td>Area-dependent Tax</td>
<td>185</td>
</tr>
<tr>
<td>44</td>
<td>Planner with Multiple Quantities</td>
<td>187</td>
</tr>
<tr>
<td>45</td>
<td>Product Base Price with Ranges</td>
<td>188</td>
</tr>
<tr>
<td>46</td>
<td>Manual Job Pricing</td>
<td>192</td>
</tr>
<tr>
<td>47</td>
<td>Job Pricing for Intent-priced Job</td>
<td>193</td>
</tr>
<tr>
<td>48</td>
<td>Order Pricing Result Matrix</td>
<td>194</td>
</tr>
<tr>
<td>49</td>
<td>JBF Option Line Item</td>
<td>197</td>
</tr>
<tr>
<td>50</td>
<td>Production Queue window</td>
<td>216</td>
</tr>
<tr>
<td>51</td>
<td>Job Properties dialog box</td>
<td>219</td>
</tr>
<tr>
<td>52</td>
<td>ITrims &amp; Bleeds Editor - Advanced tab</td>
<td>221</td>
</tr>
<tr>
<td>53</td>
<td>Device and Imposition dialog box</td>
<td>222</td>
</tr>
<tr>
<td>54</td>
<td>Imposition Scheme: Vertical Orientation</td>
<td>225</td>
</tr>
<tr>
<td>55</td>
<td>Imposition Scheme: Horizontal Orientation</td>
<td>226</td>
</tr>
<tr>
<td>56</td>
<td>Imposition Scheme: Close Up View</td>
<td>226</td>
</tr>
<tr>
<td>57</td>
<td>Layout Maker window</td>
<td>228</td>
</tr>
<tr>
<td>58</td>
<td>Job Ticket Creation dialog box</td>
<td>230</td>
</tr>
<tr>
<td>59</td>
<td>Delivery window</td>
<td>237</td>
</tr>
<tr>
<td>60</td>
<td>Delivery Information dialog box</td>
<td>240</td>
</tr>
<tr>
<td>61</td>
<td>Track Jobs - Search window</td>
<td>245</td>
</tr>
<tr>
<td>62</td>
<td>Track Jobs - Job List window</td>
<td>245</td>
</tr>
<tr>
<td>63</td>
<td>Advanced Search dialog box</td>
<td>246</td>
</tr>
<tr>
<td>64</td>
<td>Track Jobs ribbon</td>
<td>246</td>
</tr>
<tr>
<td>65</td>
<td>Change Job Status window</td>
<td>249</td>
</tr>
<tr>
<td>66</td>
<td>Job Pricing dialog box</td>
<td>250</td>
</tr>
<tr>
<td>67</td>
<td>Order Pricing dialog box</td>
<td>251</td>
</tr>
</tbody>
</table>
Figure 68: Reprint dialog box ................................................................. 252
Figure 69: Save Job As Template dialog box ........................................ 253
Figure 70: Enter Variable Data .............................................................. 270
Figure 71: Excel Pricing Information Flow .......................................... 281
Figure 72: Stages of a Set Preview ....................................................... 299
FreeFlow Web Services

FreeFlow Web Services™ is a Business Flow Automation solution that allows you to create, customize, order, print, and deliver print jobs in one streamlined operation.

Web Services enables you to respond to changing market conditions, as well as leverage new business opportunities by providing you with the following features:

- Personalized, on-demand, printing capabilities – integrate independent and data-based variable information to create variable data jobs and campaigns.
- Advanced reprint abilities – access jobs and templates for reprinting or updating print material.
- Advanced tracking abilities – you and your customers can track orders from the moment they enter your organization, until they arrive at their final destination.
- Simplified production and ordering process – generate jobs, receive automated pre-flighting, and create soft proofs prior to ordering. Make use of pre-press capabilities, output management, delivery, and billing abilities. The entire process is designed to reduce the number of interactions with your customers.
- An open system - communicate with your customers’ system and with your own peripheral systems; you can receive orders from any environment including branded websites, emails, intranet, procurement systems, or print drivers, as well as interact with other systems that provide diverse services.

The Print Service Provider Guide

The Print Service Provider guide provides you with instructions for managing the administration and production workflows, with the purpose of:

- Introducing Web Services software features.
- Entering and organizing data that is processed by Web Services, allowing you to provide automatic price generation and enabling job production.
- Assisting your organization in configuring Web Services printing, account, and system settings.
- Enabling quick implementation of Web Services so you can improve and enhance your business.

Before working with the guide, we recommend that you complete the comprehensive Customer Driven Deployment Program (CDDP) and gain the implementation skills that will enable you to begin working with your customers.
The FreeFlow Web Services User Overview describes terminology, conventions, and features used in Web Services.

The chapter includes the following sections:

- Accessing Web Services
- Frequently Used Terminology
- Conventions Used in Web Services
- Using Web Services Features
Accessing Web Services

Web Services runs on the Windows operating system. As a Print Service Provider user, you can access Web Services either via the internet (World Wide Web), or on an intranet, by typing a Uniform Resource Locator (URL) into an Internet Explorer browser address field. Print Buyers can access the Print Buyer application site using either Internet Explorer, Mozilla Firefox, or Apple Safari browsers.

To access Web Services in a browser

1. Open an Internet browser window.
2. Type the Web Services URL into the browser address text field.
   For example: http://x.x.x.x/Web Services/
3. Press Enter on your keyboard; Web Services is accessed.

Accessing Web Services locally

A computer with Web Services installed locally is called an Web Services Server.

Ensure that the Web Services server is dedicated (used solely as a network server) and that the application installation is on an internal driver, and not on an external one.

The Web Services Toolbox appears in the top-right corner of the Web Services Server desktop.

Figure 1: Web Services Toolbox
Frequently Used Terminology

You can use the Web Services Toolbox to perform the following tasks:

- **Start Director** – start running the Internet Information server and the Web Services processes.
- **Start Director** – stop running the Internet Information server and the Web Services processes.
- **Restart Director** – stop and restart the Internet Information server and the Web Services processes.
- **Log Window** – open the system feedback window. A full record of all past actions, and their execution times, available to facilitate application trouble shooting.
- **Task Manager** – open the Windows Task Manager.
- **Explorer** – open Windows Explorer.

**Status Icon**

The status icons, located on the Status Bar at the bottom-right corner of the desktop, indicate two operational modes of the system:

**Figure 2: Status Icon on the Status Bar**

- ✓ – indicates the system is operating; both the Internet Information server and Web Services are running.
- ! – indicates the system is in the process of becoming operational or shutting down.
- ☢ – indicates not operating correctly; either the Internet Information server or Web Services is down. The **Connection Failure** prompt appears.

**Frequently Used Terminology**

Figure 3 and Figure 4 describe terminology used in the Print Service Provider interface structure.

**Figure 3: Frequently Used Terminology**

- **Ribbon**
- **Menus**
- **Window**
- **Panel**
- **Sub-panel**
- **Pane**
Web Services User Overview

Figure 4: Links

The following list describes Web Services Print Service Provider user interface terminology:

- **Screen** – refers to the entire monitor screen, including the operating system toolbars.
- **Window** – part of the screen; opens by clicking any of the Workflow or Administration tabs in the Web Services taskbar.
- **Panel** – part of a window; can contain sub-panels.
- **Sub-panel** – part of a panel.
- **Pane** – a large box, usually located on the left side of the window.
- **Operation Button** – used for performing various operations; appears in a panel or a sub-panel, or below a pane.

**Navigating Web Services**

After logging in to Web Services, **do not use** the browser toolbar buttons. Click the selected menu to refresh the display, and use the menus, ribbons, and ribbon menus to navigate within Web Services. **Previous** and **Next** buttons appear when the option to return to a previous window or to move to a following window exists.

If you want the application open in more then one browser window, **do not open** another browser tab; open another browser window instead.

**Logging Out of Web Services**

Ensure that you use Web Services’s log out link (displayed in Figure 4) and not the window’s **close** control, or browser **File** menu command, when you want to log out of the application.
Conventions Used in Web Services

Web Services uses several interface conventions. These conventions are documented below, and are referred to throughout the documentation.

Managing Queues

Figure 5: Queues

Queues are used in Web Services to display the current status of jobs. You can view and edit jobs in each queue by clicking icons in the queue columns, or in the Job Details pane.

All queues have the following features and tools:

- Search Filter – a dropdown list containing an alphabetically ordered list of search criteria.
- Value Definition Filters – a dropdown list containing definitions to filter the search. For value definition filter descriptions, refer to Table 1.
- Column selection
- Job sorting according to column
- Job repositioning
- Job details viewing and editing

Table 1: Value Definition Filters

<table>
<thead>
<tr>
<th>Filter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal to</td>
</tr>
</tbody>
</table>
Displaying and Hiding Queue Columns

Queues show job information according to the columns that are displayed. You can select which columns to display or hide.

To display and hide queue columns:

1. Click Column Selection; the Column Selection dialog box appears, the number of selected check boxes corresponds with the number of columns displayed in the queue.
2. Select or clear check boxes to display or hide columns.
3. Click OK; queue columns are displayed or hidden, as defined in Step 2.

- Adding more than ten columns can distort the view of the individual columns.
- When the Payment Method column is selected, the payment method appears as PO, CC, or EDD. For more information, refer to Defining Pricing Settings on page 75.
- Process indicates that the processing of the job(s) has not yet been completed.

Sorting Jobs

You can sort information in queues according to columns.

Click a column heading to arrange queue information in alphabetical, ascending or descending order; the ▲ or ▼ arrow appears in the column header, indicating the directional order in the column.

Repositioning Jobs

When a job enters a queue, the job is positioned according to the system-assigned job number. You can reposition the job within the queue.

To move jobs up or down one row:

1. Select one or more job rows and click ▲ or ▼.
2. Repeat Step 1 until the job is queued as you want it.
To move a job to the top or to the bottom of the queue:

- Select the job and click ; the job moves to the bottom of the queue.
- Select the job and click ; the job moves to the top of the queue.

To restore the queue to the original status:

Click Default Sort; the jobs appear in the original queue positions (lowest number at the top and the highest number at the bottom).

To update the queue with new jobs:

Click the Refresh button; new jobs entered to the system appear in the queue.

Using Web Services Features

You can use several features within Web Services to store or modify information, all of which can be accessed from various locations within the application.

Managing Attachments

You can upload files to jobs and download attached files to any folder in your system.

Uploading Files

Click Upload Files or Upload Images; the Upload File dialog box appears.

- To upload a single file, click the Upload a single file radio button, and complete the instructions in the Upload File dialog box.
- To upload multiple files, click the Upload multiple files, using FTP Multi-file Upload radio button, and complete the instructions in the Upload File dialog box.

To work with the FTP Multi-file Upload option, you must enable and activate the FTP functionality on your server:

- To verify that FTP is active on your server, see the Installation Guide, Configuring FTP User Permission.
- To enable FTP Upload, navigate Web Services to System Setup > Basic > General > File Upload. For more information, refer to Allowing FTP Uploads on page 14.
Web Services User Overview

Downloading Files

3 Select a target file and click the Download File dialog box appears.
4 Complete the instructions in the Download File dialog box.
5 Click Close.

Importing and Exporting Database Files

You can use database files when you need to create variable data jobs containing many parameters, or when you populate lists of users, addresses, stock, and other database elements.

Import – import an Excel file from within or outside the system.

Export – create an Excel file of the data contained in an associated list.

To import a database list:

1 Click Import; the Import dialog box appears.
2 Browse to the target file and choose one of the following options:
   - Select File Format – select the file type and encoding values in the dropdown lists.
   - Upload, Using a Custom Scheme – select a customer scheme option in the dropdown list. For information on how to create customer schemes, refer to To define a new mapping scheme: on page 11.
3 Click Start Uploading; the Import Database dialog box appears.

Figure 6: Import Database
To prevent the first row of data appearing in the printed job, select the **First Row Contains Field Names** checkbox.

**To map fields:**

Choose one of the following options in the **Scheme** dropdown list:

- **New Scheme** – define a new field mapping scheme.
- **Last Used** – map according to the scheme that was last used. For more information, refer to **To create a new database mapping scheme** on page 11.

**To define a new mapping scheme:**

1. Select **New Scheme** from the dropdown list.
2. Map the names with valid field names in the dropdown lists.
3. Click **Next**; the **Import Finished** dialog box appears.

4. Click **Close**.

**Problematic names, for example Login Name, where a login name already exists, appear with the icon, and the Message column contains an explanation.**

**The Link to Import Report File link accesses an Excel file worksheet containing the imported names. You can edit the Excel file.**

**To create a new database mapping scheme:**

1. Click the **Scheme** link; the **Scheme Management** dialog box appears.
2. Select **New Scheme** and click **Save As**; the **Save As** dialog box appears.
3. Type a new scheme name and click **OK**; the new scheme name appears in the list.
4. Click **Close**.

**To export an internal system list:**

1. Click **Export**; the **Export** dialog box appears.
2. Select the file type and encoding in the dropdown lists, and click **Export**; the **Download File** dialog box appears.
3. Complete the instructions in the dialog box, and save the file in a folder.
Generating and Editing Job Tickets

The Job Ticket is a document containing information detailing job production, finishing, delivery, and pricing. The Job Ticket can be printed out and completed by the various people in the print production process.

A Job Ticket can be generated, viewed, and edited from either the Production or Printing windows, or from any active Job Tracking status window.

To view a Job Ticket:

1. Select a job, and click **Open Job Ticket**; the Job Ticket Creation dialog box appears.
2. Select one or more of the following options:
   - **Production**
   - **Finishing**
   - **Delivery**
   - **Pricing Information**
3. Click **Set Printing Deadline**; the Printing Date dialog box appears, the current date is selected.
4. Set the desired time and date and click **OK**; the date appears in the Job Ticket Creation dialog box.
5. Click **Set Finishing Deadline**, and repeat Step 4 to set the finishing deadline parameters.
6. Click **OK**; the Download File window appears.
7. Complete the instructions for downloading the Job Ticket to a suitable location.

To edit the Job Ticket:

1. Select a job, and click **Edit Job Ticket**; the Job Ticket appears in MS Word format.
2. Edit and save the document.
This chapter describes how you configure the application system settings when initiating FreeFlow Web Services for the first time, and periodically, as the need arises. Some system settings are configured as system defaults on a global level, such as the system language, and company contact data, whereas other settings can be adjusted at the account level after the system has been configured, such as Print Buyer account email settings. This chapter includes the following sections:

- Configuring System Properties
- Defining Language
- Defining Terms and Conditions
- Customizing the Home Page
- Setting System User Privileges
- Defining Print Service Provider Users
- Defining System Email Settings
- Verifying System Fonts
- Setting Job Expiration Time Limits
- Customizing Fields
- Defining Data Export
- Defining Credit Card Integration
- Integrating Web Services with Other Systems
Defining System Settings

Configuring System Properties

You configure system properties when you initiate the application for the first time, or when you perform periodic application system maintenance. These settings are the default system parameters suited to your organization's daily operational business needs, and includes the following parameter settings:

- **Web Services Server Address** – the DNS name (URL) of your server.
- **Connections** – the maximum number of simultaneous users.
- **File Upload** – allowing FTP for multiple file uploads.
- **Calendar Options** – your company's working days and hours, and Print Buyer calendar options for ordering services.
- **Date and Time Format** – the date and time display format.
- **PDF Preview** – whether to include footers or watermarks in your Print Buyer’s PDF preview.
- **Remote Support** – whether the Web Services Support Department have access to your server system options to assist with system complications and service difficulties.

To define the system properties in the **System Properties** window, select **System Setup > General**; the **System Properties** window appears.

Defining Connection Properties

You can define your server DNS name (URL) and define the maximum number of simultaneous users in your system, which might be important if you experience performance problems. You can enable Secure Sockets Layer (SSL) server security features to accommodate Print Buyers with content-sensitive print jobs on your 'certified as secure' site. (SSL certification is required to enable SSL.)

**To define connection properties:**

1. In the **Server Address** field of the **System Properties** window, enter the DNS name of your web site.
2. In the **Maximum Users** dropdown list, select the maximum number of users authorized to work simultaneously.
3. To enable SSL server security features, on the **Connections** sub-panel, select the **Use Secure Connection** check box and click **Save**. For more information regarding SSL server, refer to **Setting Up an SSL Server** on page 17.

Allowing FTP Uploads

You can determine whether or not to allow users to upload multiple files with File Transfer Protocol (FTP) and define the FTP port. You can also determine whether or not those Print Buyers require authentication after FTP upload is allowed, in which case, you determine the Print Buyer’s user name and password.

**To allow FTP uploads:**

1. On the **File Upload** sub-panel, in the **System Properties** window, select the **Allow FTP Upload** option.
2. Type a valid FTP port value in the **FTP Port value** field (the default port being 21).
3  (Optional) Select the **Requires Authentication** check box.
   
   a  Type a user name and password in the respective fields and click **Save**.
   
   b  From the computer on which the Web Services server is installed, click the **Start** menu, right-click **My Computer** and select **Manage**; the **Computer Management** window appears.
   
   c  Navigate to **Local Users and Groups > Users** and right-click the **Users** folder.
   
   d  Select **New User**; the **New User** dialog box appears.
   
   e  Type the user name and password in the respective fields.
   
   f  Select the **User cannot change password** and **Password never expires** check boxes. (Ensure the other two check boxes are cleared.)
   
   g  Click **Create**.
   
   h  Navigate to **D: > NewEdition > temp > FtpRoot > FtpUploadRoot** (where **D** is the drive on which Web Services is installed) and right-click the **FtpUploadRoot** folder.
   
   i  Select **Properties** and in the **Security** tab, click **Add**; the **Select or Users Groups** dialog appears.
   
   j  Click the **Locations** button and in the resulting **Locations** dialog box, select the valid computer name and click **OK**.
   
   k  Type the user name in the field and click **OK**.

**Defining Calendar and Work Hours**

You can specify your company’s operational hours and days for providing print production and services, thus defining your Print Buyer’s calendar options for ordering and receiving print production services.

**To define calendar and work hours:**

1  On the **Calendar Options** sub-panel in the **System Properties** window, use the dropdown lists to define your company’s operating hours, as well as the days for the weekend.

2  On the **Date and Time Format** sub-panel, use the dropdown lists to select the date and time formats and the separators, and click **Save**.
Defining System Settings

Defining the PDF Preview

PDF Previews provide both you and your Print Buyers the ability to view the job before it is actually produced, which is useful for verifying the accuracy of the job. Footers and watermarks appear in the PDF preview, which are especially provided to prevent Print Buyers from using the preview as a means of printing the job on printers other than those in your system or organization.

1. On the PDF Preview sub-panel, in the System Properties window, click the Footer File dropdown box and choose one of the following options:
   - None - if you do not want to add a footer to the PDF preview.
   - SampleFooter.pdf – a PDF preview footer option.

2. Click the Footer File link and upload footer image(s) to add additional footer file options to the dropdown menu.

3. Select the Enable Watermark check box to add a watermark to the PDF; the Watermark Text and Font fields are activated.

   - Type a value in the Watermark Text field.
   - Define the Font settings.

4. Click Save.

Enabling Remote Assistance

You can authorize and enable FreeFlow Web Services Support to access your server system options remotely for assistance with any system complications and service difficulties.

To enable remote Web Services support:


2. Type the remote IP and password values of your Web Services server in the Remote IP and Password fields.

3. Click Save.
Setting Up an SSL Server

You can set up a Secure Sockets Layer (SSL) communications protocol on your Web Services server, which enables server security features that verify incoming Print Buyer identity and content integrity, and provides network transmission encryption.

**To set up SSL:**

1. Acquire and install a valid server certificate to establish SSL communications on your system.

2. Ensure the **Use Secure Connection** check box is selected (Connections sub-panel, in the **System Properties** window) to enable the server on which you want to use SSL to be assigned to port 443 (the default port for secure communications).

3. Ensure that port 443 is open for both inbound and outbound connections in case a Firewall is configured on a local network.

Defining Language

You can define your Web Services site default language and the languages available to Print Buyers when they access the Web Services home page. When you define languages, you automatically set the unit of measurement applied to your jobs, inches or millimeters, to suit countries of the languages you define.

**To define languages:**

1. Select **System Setup > Languages**; the **Languages** window appears.

2. In the **Default Languages** dropdown list, select the default language for the site.

3. On the **Languages Available on Customer Interface** panel, select the check boxes for the languages you support.

4. Click **Save**.
Defining System Settings

Defining Terms and Conditions
You can define the Terms and Conditions for your Print Buyers to accept before they place their job orders.

Use HTML conventions when applying character and paragraph formatting to Terms and Conditions text. Text is saved in HTML format.

To define Terms and Conditions:

1. Select System Setup > Terms And Conditions; the Terms And Conditions window appears.
2. In the Language list, select the language.
3. Click the Text pane and type the valid text within.
4. Click Save.
5. Repeat steps 2 through 4 to define the terms and conditions in other languages.
Customizing the Home Page

You can customize home page elements, including the GUI link settings, home page text, and images. The home page serves as the login page.

Defining the Customize Link

You can create a button link to a customized window containing text and images designed for your Print Buyers’ use. Alternatively, you can define the button to direct Print Buyers to an external 'Customize' Page option to enable your Print Buyers access to an external web page.

To define the Customize link:

1. Select System Setup > Home Page Customization > Customize; the Customize Link dialog box appears.
2. In the Customize Link dialog box, select one of the following option buttons:
   - Do not use Customize page – to not display the Customize Page link on the home page.
   - Use System 'Customize' Page – to display the Customize Page link and connect it to a customized page. Continue with Step 3.
   - Use External 'Customize' Page – to link your Print Buyers to an external web page. Continue with Step 4.
3. If you select Use System 'Customize' Page,
   i. From the Language list, select a language.
   ii. In the Title field, type a name for the customized window and button.
   iii. In the Text field, type a message (such as Terms and Conditions) and click OK.
4. If you select Use External 'Customize' Page,
   i. From the Language list, select a language.
   ii. In the Title field, type a name for the customized window and button.
   i. In the URL field, enter the external web page’s URL address and click OK.
5. In the Home Page Customization window, click Save.
**Defining System Settings**

**Defining the Logout link**
You can define whether your Print Buyers, after logging out, are automatically redirected back to your Login window, or to a different web site.

By default, Print Buyers are automatically redirected back to your Login window.

To define the Logout link:
1. Select System Setup > Home Page Customization > Logout; the External Home Page Links dialog box appears.
2. Select the Use External URL check box to direct your Print Buyers to an external website.
3. Define the login and logout URL, and click OK.

**Accessing the FAQ Link**
The FAQ button accesses the Web Services FAQ (Frequently Asked Questions) page, which contains a collection of commonly asked questions about Web Services, and the respective answers. You can provide your Print Buyers access to the Web Services FAQ page(s) or any other page(s), and present the page(s) either within your Web Services home page (as a panel) or as an independent, floating window.

Only page files located externally to the Web Services server can be displayed within an independent floating window.

To access the FAQ link:
1. Select System Setup > Home Page Customization > FAQ; the FAQ Page dialog box appears.
2. In the FAQ Page dialog box, select one of the following option buttons:
   - **Do not use FAQ page** if you do not want the FAQ Page link to be displayed on the home page
   - **Use System FAQ Page** for your Print Buyers to access the Web Services FAQ pages
   - **Use External FAQ Page** to link your Print Buyers to an external web page.
   If you select Use External FAQ Page, insert the target URL in the field, and click OK.

Select Always on top to make sure the FAQ Page window, when open, remains open over the Home Page window.
Customizing Help

You can customize your Web Services online Help. You can provide your Print Buyers with access to the Web Services online Help files that are located within the application, or to an external Help system on the Internet. Additionally, you can configure the Help to appear either within your Web Services home page (as a panel) or as an independent, floating window. Alternatively, you can ‘hide’ the Help button altogether, effectively disabling Help access.

To customize Help:

1. Select System Setup > Home Page Customization > Help; the Help dialog box appears.
2. In the Help dialog box, select one of the following option buttons:
   - Do not use Help if you do not want the Help button to be displayed on the home page, or
   - Show System Help for your Print Buyers to access the Web Services Help pages, or
   - Use External Help to link your Print Buyers to external Help pages.

   If you select Use External Help, insert the target URL in the field, and click OK.

Defining Contact Information

You can define your Web Services site Contact Us information, such as telephone numbers and email addresses. The information you define provides a choice of options your Print Buyers can use to correspond directly with your organization.

To define contact information:

1. Select System Setup > Contact Details; the Contact Information window appears.
2. Insert the information details in the fields, and click Save.
Defining System Settings

Defining the Contact Us Link

You can define the target of the Contact Us link. Generally used to access Web Services’s Contact Us site information page, you can define the Contact Us link to target a different URL address on the internet, such as your own organization’s web site.

To define the Contact Us link:

1. Select System Setup > Home Page Customization > Contact Us; the Contact Us Page dialog box appears.
2. In the Contact Us Page dialog box, select one of the following option buttons:
   - Do not use Contact Us Page – do not display the Contact Us link on the home page.
   - Use System Contact Us Page – use the system Contact Us page.
   - Use External Contact Us Page – enter the target URL in the field.
3. Click OK.

Defining Home Page Text

You can define and edit home page text, including the language, main title, subtitle and body text.

To define Home Page text:

1. Select System Setup > Home Page Customization, and in the Select Language to Edit dropdown list, select the home page text language.
2. In the Main Title field, type the text you want to appear as the title for the home page.
3. Type the text that you want to appear as the subtitle and body of the home page, in their respective fields, and click Save.

Click Always on top to make sure the Contact Us Page window, when open, remains open over the Web Services window.

You can have more languages added to the Select Language to Edit list. For more information regarding languages, refer to your local distributor.
Defining Home Page Images

You can define three separate home page image areas; the company logo image, the home page image, and an advertisement image. Make sure images to be used are located in the system Images Library. For further information about uploading images, refer to Managing Attachments on page 9.

To define Home Page images:

1. Select System Setup > Home Page Customization, and in the Customization dialog box, click one of the three image areas; the Image Customization folder appears.
2. Upload the image required and select it.
3. Click Save.

Setting System User Privileges

Table 2 lists the default Web Services system users and their privileges.

Table 2: System User Privileges (Sheet 1 of 2)

<table>
<thead>
<tr>
<th>System User</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Buyer Side</td>
<td></td>
</tr>
<tr>
<td>Administrator</td>
<td>Full user abilities, including account administration. The Administrator can design jobs, send jobs to the Shopping Cart, and place orders. In addition, the Administrator is responsible for determining the user privileges of all members of the Print Buyer organization.</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Full user abilities except access to account administration. The Supervisor can design jobs, send jobs to the Shopping Cart, and place orders.</td>
</tr>
<tr>
<td>Designer</td>
<td>Responsible for designing simple jobs and jobs based on variable data and variable data fields.</td>
</tr>
<tr>
<td>Super User</td>
<td>Creates jobs using templates, iForm, and variable data. Can order jobs.</td>
</tr>
<tr>
<td>User</td>
<td>Creates jobs using templates, iForm, and variable data. Cannot order jobs.</td>
</tr>
<tr>
<td>Guest</td>
<td>New or occasional users who can create jobs based on Print Account catalogs.</td>
</tr>
<tr>
<td>Custom</td>
<td>As a default, creates jobs using templates, iForm, and variable data. Cannot order jobs. Custom allows the Print Buyer to create an additional user type with specific abilities.</td>
</tr>
</tbody>
</table>
Defining System Settings

Print Buyer User Privileges Tables

A System Administrator sets the default Print Buyer system user abilities at the Print Service Provider System Setup level. However, you can change the Print Buyer system user abilities per customer at the Print Service Provider Accounts level.

To change Print Buyer user abilities:

1. Select System Setup > Advanced > User Types.
2. Clear or select the check boxes to assign or remove privileges.
3. Click Save.

To restore the privilege defaults, click Reset Defaults.

To revert back to the last saved configuration, click Revert.

Figure 7: Print Buyer User Privileges
**Table 3: Default Print Buyer User Abilities**

<table>
<thead>
<tr>
<th>Privileges</th>
<th>Privilege Level</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Administrator</td>
</tr>
<tr>
<td>User Administration</td>
<td>✓</td>
</tr>
<tr>
<td>Manage Template Library</td>
<td>✓</td>
</tr>
<tr>
<td>View Jobs of other Users (from the same Customer)</td>
<td>✓</td>
</tr>
<tr>
<td>Place an Order/Get Quote</td>
<td>✓</td>
</tr>
<tr>
<td>Upload Job Content</td>
<td>✓</td>
</tr>
<tr>
<td>Edit Job Properties</td>
<td>✓</td>
</tr>
<tr>
<td>Use Form Editor</td>
<td>✓</td>
</tr>
<tr>
<td>Use Variable Data Archive</td>
<td>✓</td>
</tr>
<tr>
<td>Use Variable Data Archive</td>
<td>✓</td>
</tr>
<tr>
<td>Send MailToPrint</td>
<td>✓</td>
</tr>
<tr>
<td>Download Plugins</td>
<td>✓</td>
</tr>
<tr>
<td>View Address Book</td>
<td>✓</td>
</tr>
<tr>
<td>Edit Contact Details</td>
<td>✓</td>
</tr>
</tbody>
</table>

*Note: The table shows the default print buyer user abilities across different privilege levels, with '✓' indicating availability and ' ' indicating non-availability.*
Defining System Settings

Table 4: Print Service Provider User Abilities

<table>
<thead>
<tr>
<th>Feature</th>
<th>Ability</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>System Admin</td>
</tr>
<tr>
<td>Print Service Provider Administration</td>
<td>✓</td>
</tr>
<tr>
<td>Print Service Provider Track Jobs</td>
<td>✓</td>
</tr>
<tr>
<td>Print Service Provider Production</td>
<td>✓</td>
</tr>
<tr>
<td>Print Service Provider Delivery Desk</td>
<td>✓</td>
</tr>
<tr>
<td>Print Service Provider Info Center</td>
<td>✓</td>
</tr>
<tr>
<td>Pricing</td>
<td>✓</td>
</tr>
<tr>
<td>Job Ticket Library</td>
<td>✓</td>
</tr>
<tr>
<td>Customers</td>
<td>✓</td>
</tr>
</tbody>
</table>

Defining Print Service Provider Users

You can define which members of your company are authorized to be operators of your Web Services system and create a user account for each employee, giving them their respective user privileges.

To define system users, select System Setup > Users; the Print Service Provider Users window appears, listing the current users.

To define a new User:

1. In the Print Service Provider Users window, click Add.
2. Insert the First Name and Last Name field values.
3. In the Login Name field, accept the default, or insert a login name.
4. In the Password field, insert a password.
5. In User Type dropdown list, select one of the following User Type options:
   - System Admin
   - Operator
   - Manager

For information regarding Print Service Provider user types and their system privileges, refer to Defining Print Service Provider Users on page 23.

- To delete a user from the Users list, select the user and click Delete, and Yes.
- To search for a user, insert the user name in the search field, and click Search.
- To reset the Users list to display all users, click Reset.
- To reset the Users list to the original status after making changes that have not been saved, click Revert.
Defining System Email Settings

You can direct job notification emails to one or several users in your Print Buyer's organization as well as service provider users in your organization. Notification emails are an effective, automated method of notifying of a specific job's general status which may require a 'warning'. Notification categories such as 'Job Arrived at the Pre-Press Queue' or 'Job Price Changed', or 'Job Arrived at the Print Buyer Approval Queue' are sent.

You can set system email settings as a default for all your Print Buyers in the Email window, as described in this section. Alternatively, email settings defined in the Accounts Customers window are for specific Print Buyers. For more information regarding email settings for specific Print Buyers, refer to Defining System Email Settings on page 27.

To set up an email account for notification:

1. Select System Setup > Advanced > Email; the Email window appears.

2. In the Email Account panel, define the following field values:
   - SMTP Server – The name of your SMTP server.
   - Account Name – Specifies the SMTP server account name necessary for authentication.
   - Password – Specifies the SMTP server password necessary for authentication.
   - Email Address for Testing – Type an email address for testing the account.

3. Select which events should trigger email notification, and click the adjacent Contacts link; the respective dialog box appears.

4. Define who appears as the email sender, and which users receive notification. You can direct email notification for the following specific job events:
   - Price Failure – Notifies that the system is not configured correctly to generate a price, due to several possible reasons. For example, an output device wrongly configured, or a parameter missing from the job description.
   - Job Arrived at the Artwork Queue – Notifies that the job is at the artwork queue.
   - Job Arrived at the Production Queue – Notifies that the job is at the production queue.
   - Order Confirmation – Notifies the Print Buyer that an order has been placed.
   - Job Price Has Been Changed – Notifies the Print Buyer that a quoted price has been changed.
   - Job Shipped – Notifies the Print Buyer that a job has been shipped.
   - Inventory Below Minimum Level – Notifies the Print Buyer that the number of copies of an item in the inventory has dropped below the minimum set level.
   - Preorder Jobs Expiration – Notifies the Print Buyer that a job remains in the Saved Jobs, Approval Queue, or Shopping Cart for longer than the allotted time, and is about to expire.
   - Shipped Jobs Expiration – Notifies the Print Buyer that a shipped job remains in the shipped status for longer than the allotted time, and is about to expire.
   - Job Arrived at the Print Buyer Approval Queue – Notifies the Print Buyer that a job has arrived at the Print Buyer Approval queue.

5. For each event, on the Sender panel, select a Sender option button, or select Other Email and define the sender email address.
For each event, on the **Recipients** panel, select the target recipients and insert an email address in the **Other Email** field (if required), and click **OK**; all settings are saved, and the dialog box closes.

In the **Email** window, click **Save**.

### Verifying System Fonts

You can verify the fonts and font parameters supported within your Web Services system.

Font parameters include:

- **Font Name** – Specifies the font name.
- **Font Family** – Specifies the font family type.
- **Font Type** – Specifies if a ‘true’ or ‘open’ font type.
- **File Name** – Specifies the name of the font file.
- **Comments** – Notifies of administrator comments defined for the font.

You verify system fonts in the **Fonts** window.

To access the **Fonts** window, select **System Setup > Advanced > Fonts**; the **Fonts** window appears, containing the following elements:

- **Available Fonts** table – Lists the fonts supported in the Web Services system.
- **Refresh** button – Scans the system and updates the **Available Fonts** list with new font additions.
- **Imposition Marks Font** dropdown list – Lists fonts used for imposition marks.
- **Compatibility** dropdown list – Select one of the following options:
  - Acrobat 2.0 (PDF 1.1)
  - Acrobat 3.0 (PDF 1.2)

In the event of RIP (Raster Image Processing) font incompatibility, your Print Buyer can create a PDF file compatible with the listed Adobe® Acrobat® versions (and up). If a Print Buyer creates a PDF, the embedded font format must conform with your organization’s needs.

The system supports both True Type and Open Type fonts. If Open Type fonts are chosen and the job has a font that does not support the Open Type format, the system embeds the True Type font.
Setting Job Expiration Time Limits

You can define time periods for automatic job expiration—at which point jobs are automatically deleted from the system—to prevent the accumulation of jobs that are no longer required. This option removes jobs from the queue that are no longer valid, or have lapsed due to Print Buyer indecision. This function serves to reduce system 'cluttering', and maximizes Web Services's ability to perform at top speed.

You can apply these definitions to jobs in any of the following statuses:

- Jobs not yet ordered:
  - Design
  - Print buyer Approval
  - Shopping Cart
- Jobs already ordered:
  - Shipped
  - Received

To define expiration dates:

1. Select System Setup > Advanced > Job Expiration; the Job Expiration Settings window appears.
2. In the Pre-order Jobs Expiration and Shipped Jobs Expiration dropdown lists, select the how many days a job remains in the system prior to being deleted, and respectively, the number of days a warning appears prior to the deletion, and click OK.

Customizing Fields

You can customize fields used for Print Buyer contact information, address information, account information, and order forms throughout the system. You can also change the order in which fields appear in the various views, deem them as 'mandatory' fields, assign dialog boxes, choose whether they are to be 'free text', or 'dropdown' list boxes, and choose the panels where these items are to appear.

You enable customizing fields in the Customize Fields window.

To access the Customize Fields window, select System Setup > Advanced > Customized Fields; the Customize Fields window appears.

To customize fields:

1. In the Customize Fields window, select Enable Customize Fields.
2. Select one of the following tabs:
   - Contact Information — customize Print Buyer user Contact Information fields located throughout the system.
   - Address — customize Print Buyer user address fields located throughout the system.
   - Account Information — customize the Print Buyer user Account Information fields located on the Accounts General Info panel.
Defining System Settings

- **Order** – customize the fields on the Print Buyer Order forms located throughout the system.

3 Select a field row, and click [Move Up] or [Move Down] to edit the field’s panel location.

4 Select the **Visible** check box to define that a field will be visible in the system.

5 Select the **Mandatory** check box to define that a field is marked as mandatory for data entry.

6 In the **Field Caption** column, customize the field name.

7 In the **Field Type** column, choose **Free Text** or **Dropdown List**.

8 If you choose the dropdown list option, edit the list. For information regarding editing the dropdown list, refer to **Editing a Dropdown List**.

9 Click **Save**.

Editing a Dropdown List

You can define the options available in a dropdown list, when customizing fields.

To edit a dropdown list:

1 After choosing the dropdown list option in the **Customize Fields** window, **Field Type** column, click **Edit List**; the **Custom Field Options** dialog box appears.

2 Click the **Add new Custom Field Option** link, and type a value in the resulting field.

3 Click **Add**; the newly added value is listed in the dialog box.

4 Repeat Steps 2 and 3 for additional field options, and click **Done**.

5 Click **Save**.

For information regarding customizing fields at the account level, refer to **Customizing Order Fields at the Account Level** on page 87.
Defining Data Export

You can integrate your Web Services system with peripheral systems within your organization specifically designed and dedicated to perform tasks which enhance your services, such as accounting or estimation software systems. An XML file with job or order data can be transferred through the Web Services server to the other systems when the following events occur in Web Services:

- Get Quote – a Print Buyer has clicked Get Quote in the Web Services Shopping Cart.
- Job Order – a Print Buyer has placed an order.
- Edit Imposition – a Print Service Provider operator has clicked Edit Imposition in the Production Queue.
- Job Shipped – a Print Service Provider operator has clicked Approve Delivery in the Delivery Queue.

You define the integration with external systems in the Web Services Links window.

To access the Web Services Links window, select System Setup > Integration; the Web Services Links window appears.

To enable an Web Services link:

1. In the Web Services Links window, select the Enable check box adjacent to the system link to be enabled.
2. In the Folder Path field, define a path to a folder in which to store the XML file.
3. Click Save.

Defining Credit Card Integration

You can enable Print Buyers to pay for your services through a Credit Card service. Credit Card is available depending on licensing authorization.

To define Credit Card payments:

1. Select System Setup > Integration > Credit Card; the Credit Card window appears.
2. In the Payment Service dropdown list, select a service option and click Settings; the Payment Service Settings dialog box appears.
3. Type data into the fields (for example Account ID, Store Key, or Merchant ID, depending on the Payment Service type) and click OK.

You obtain personalized Credit Card service data only after registering with participating payment organizations, done typically via the Credit Card service provider web site.

4. Define the field values, and click Save.
Integrating Web Services with Other Systems

You can integrate your Web Services application to with other systems located within your overall system.

To integrate with another system:

1. Select System Setup > Integration > External Systems; the External Systems window appears.
2. In the Systems list, select a system; the right panel shows either an Enable check box or data fields.

Adobe CS3 appears in the Systems list by default. Additional external systems appear in the Systems list in accordance with your Web Services licence agreement.

3. Select the Enable check box (when provided) and type the valid data received from the external system organization into the fields.
4. Click Check Configuration; the Production Server Tests window appears showing a configuration diagnostic report.
   
   When the system is configured correctly, the Production Server Tests window status appears as ‘Passed’. If configured incorrectly, the status appears as ‘Failed’, and a possible failure reasons are listed.
5. When the external system is configured correctly, click OK.
This chapter describes how you define your print settings and service provision parameters. Options and defaults presented here include print output methods available, stock, setup and imposition options, finishing options and shipping alternatives. The chapter includes the following sections:

- Defining Production Parameters
- Managing Output Devices
- Defining Output Device Channels
- Defining Print Imposition
- Defining Third-party Imposition Jobs
- Defining Press Setup Parameters for Pricing Calculation
- Setting Speed and Waste
- Defining Labor Charges
- Defining Click Charges
- Managing the Stock Library
- Importing and Exporting Stock
- Searching the Stock Library
- Setting Paper Sizes
- Defining Shipping
Defining Production Parameters

You can define the level at which Web Services issues a warning for problems with image resolution and size of uploaded files, and define the default gutter settings for automatic imposition.

Setting Image Resolution Warning

The default image resolution DPI value is the minimum image resolution a Print Buyer is required to use, when uploading a file to the system. When an uploaded file contains images with a resolution lower than the value set in the system, Web Services issues a warning message.

To set the minimum acceptable DPI:

1. Select Print Settings > Production > Parameters; the Production Properties window appears.
2. In the File Upload panel, type the minimum acceptable DPI threshold in the Warn User when image resolution is below: field.
3. Click Save.

Setting Size Difference

You can set the maximum possible size difference between a job type's properties and the properties of an uploaded file. When a Print Buyer orders a job, the job type, subtype, and job size are defined. If an uploaded file's dimensions differ from those defined in the system's job subtype (by exceeding the percentage value set in the system), the job subtype changes from Defined to Custom, and Web Services issues a warning message.

To set size difference:

1. Select Print Settings > Production > Parameters; the Production Properties window appears.
2. In the File Upload panel, type the maximum acceptable size difference between job type properties and the properties of uploaded files.
3. Click Save.
Setting Default Gutters

You can define the default gutter settings for automatic imposition. You use the Gutters setting to define the default vertical and horizontal space between the single jobs in an imposition matrix. The system default setting is 0.156" (3 mm), which is the standard setting. This setting is applied to jobs by the Web Services imposition algorithm unless a different setting is specified for the job type or template on which the job is based. You can change the default setting here, and provide a different setting for specific job types and templates, or you can change the imposition settings just before sending a job to be printed.

Figure 8: Default Gutter

To set the default gutters

1. Select Print Settings > Production > Parameters; the Production Properties window appears.
2. In the Imposition Defaults panel, type the default horizontal and vertical gutter values in the Horizontal and Vertical fields, respectively.
3. Click OK.
Defining Print Settings

Managing Output Devices

The **Output Devices** list shows all of the output devices currently defined in your system. In the **Output Devices** list, you can perform the following actions:

- Add devices
- Remove devices
- Rename devices

Adding Output Devices

You can add output devices to the system.

**To add an output device:**

1. In the **Output Devices** window, click **Add**; the **Add Device** dialog box appears.
2. Type a name and select the device group to which the device will be added.
3. In the **Device Group** dropdown list, select **Copier**, **Digital**, or **Offset**.
   - If you select **Digital**, in the **Machine Type** dropdown list, select one of the preset device options, or **Custom**.
4. Click **OK**.

Defining General Output Device Parameters

You can define the output devices that are used in the system. Assign names for the output devices logically, either relating the device(s) to a folder to which jobs are transferred and stored (for later processing), or relating to an output device especially configured to receive and print jobs automatically.

Accessing the Output Device list

You define output devices by first accessing the **Output Devices** window.

To access the **Output Devices** window, select **Print Settings > Production > Output Devices**; the output devices are listed, the **General** tab is active.

**To define general output device parameters:**

1. In the **Output Devices** window, select a device in the **Output Devices** list.
2. In the General view, in the **Device Description** field, type a name for the device.
3. In the **Quality** dropdown list, choose either **Cost Effective** or **Highest Quality**.
(Optional) Select **Automatically approve all Jobs for Printing** to approve all jobs for automated printing. When selected, jobs sent to production arrive at the **Production Queue** and are automatically approved and sent to the **Printing Queue**.

5 In the **Press Sheet Sizes** sub-panel, select the sheet sizes supported by the output device.

6 In the **Colors** sub-panel, select which color options the output device supports. The options are:
   - **B/W** – black and white
   - **Process** – cyan, magenta, yellow and black
   - **Spot** – special colors (such as PMS colors)

7 In the **Color Units** dropdown list, select the maximum number of color units supported by the output device.

8 In the **Convert RGB to CMYK via ICC Profile** dropdown list, select an ICC profile for converting RGB to CMYK. Alternatively, select **None**.

9 Click **OK**.

**Adding ICC Profiles to the System**

You can add ICC profiles to your Site Customization system. For more information about Site Customization, refer to **Editing Skin Elements** on page 205.

**To add ICC profiles:**

1 In the **Output Devices** window, select a device in the **Output Devices** list.

2 In the **General** view, click the **Convert RGB to CMYK via ICC Profile** link; the **Messages** dialog box appears.

3 Select the ICC profile and click **Select File**; the file name appears in the **Convert RGB to CMYK via ICC Profile** field.

4 Click **OK**.
Defining Print Settings

Defining Output Device Channels

You can define the format and the transmission protocol of data transferred by FreeFlow Web Services. You can direct print job files to an output device or to a 'storage' folder for later processing.

The system output device channel options include:

- **PDF Spool** – specifies the output is a PostScript file
- **Folder Balance** – specifies the output is a PDF file
- **VIPP Emitter** – specifies the output is variable data format for HP devices
- **PPML** (Personalized Print Markup Language) – specifies the output is XML-based printer language for variable data printing (defined by PODi)
- **VDX** – specifies the output is variable data format for KODAK devices
- **VPS** – specifies the output is variable data format for Creo devices
- **JMF over HTTP** – specifies the output is a PDF document sent using HTTP protocol

To transfer a job in PostScript format:

1. In the **Output Devices** window, click the **Output Channels** tab.
2. Select an output device, and in the right panel, select **PDF Spool (using Acrobat Reader)**.
3. In the **Device Name** dropdown list, select a device.
4. In the **Print Method** dropdown list, select a PostScript level.
5. Select one of the following parameter options:
   - **Use Printer Halftone Screens** – halftone screening occurs, using the printer's screening mechanism.
   - **Download Asian Fonts** – Asian fonts are embedded in the resulting file.
   - **Attach Copies Parameter** – attaches the number of copies automatically (one copy is attached if the option is cleared).
   - **Attach Duplex Mode Parameter** – includes all Duplex Mode parameters with the job. Clear this option if the output device does not support duplex mode, or when the parameter is to be set manually.
6. (Optional) Click **Print Test Page** to send a test page to print.
7. Click **OK**.

To transfer a job in PDF format:

1. In the **Output Devices** window, click the **Output Channels** tab.
2. Select an output device, and in the right panel, select **Folder Balance**.
3. (Optional) In the **Produce JDF Output** dropdown list, select a job definition format option. Select the **Send Production file with JDF** option and in the **Local Folder Path** field, and define the path.
4. Select or clear the **Device supports multi-queue system** option.
To transfer jobs to Macintosh computer platforms, select the Macintosh Target option; the system compresses the job name to less than 30 characters.

In the Folder Type dropdown list, select one of the following methods to store jobs:

- **Local** – specifies an absolute folder path within the local server.
- **FTP** – specifies the full ftp path for transferring jobs via the Internet to any remote computer (i.e. format: ftp://www.print-service-provider.com).
- **Network** – specifies the transfer of jobs to any computer within the local network (the network server directory must be specified as the following: \\ ...).

In the Folder Path field, define a full folder path (according to the folder type method chosen).

Click Send a Test File and confirm the subsequent confirmation messages.

Click OK.

To transfer a variable data format job:

1. In the Output Devices window, click the Output Channels tab.
2. Select an output device, and in the right panel, select one of the following variable data formats:
   - VIPP Emitter
   - PPML
   - VDX
   - VPS
3. To transfer jobs to Macintosh computer platforms, select the Macintosh Target option; the system compresses the job name to less than 30 characters.
4. In the Folder Type dropdown list, select one of the following methods to store jobs:
   - **Local** – specifies an absolute folder path within the local server.
   - **FTP** – specifies the full ftp path for transferring jobs via the Internet to any remote computer (i.e. format: ftp://www.print-service-provider.com).
   - **Network** – specifies the transfer of jobs to any computer within the local network (the network server directory must be specified as the following: \\ ...).
Defining Print Settings

You can define computer IP address, User name, and password values for the FTP or Network option, when either is selected.

5 In the Folder Path field, define a full folder path (according to the folder type method chosen).
   - For VIPP Emitter:
     - i In the Imposition dropdown list, define job imposition parameters.
     - ii In the VIPP Emitter Submission Folder field, define the full folder path.
   - For PPML: In the Resources Path field, define the full resources path.
   - For VPS:
     - i In the Resources Path field, define the full resources path.
     - ii In the Imposition dropdown list, define the imposition parameters.

6 (Optional) Click Send a Test File.

7 Click OK.

To transfer a job in PDF format over the HTTP protocol:

1 In the Output Devices window, click the Output Channels tab.

2 Select an output device, and in the right panel, select JMF over HTTP.

3 Select or clear the Device supports multi-queue system option.

You can add, edit, and delete queues by clicking the Device supports multi-queue system link.

4 Define IP Address and Port field values.

5 In the Produce JDF Output dropdown list, select an output device.

6 Click OK.

Removing Output Devices

You can remove output devices using the following:

1 In the Output Devices window, select the output device to remove.

2 Click Delete and Yes; the device is removed from the list.
Defining Print Imposition

You can define print imposition orientation and optimization, depending on the selected output device. The system automatically imposes job pages into signatures (a unit of job arrangement within the imposition). You can impose jobs manually if the job is not defined to be automatically imposed by the system. Choose whether to use a color bar, determine both margin and color bar positioning, and the dimensions for each sheet size.

To define print imposition:

1. In the Output Device window, click Imposition.
2. In the Imposition Preferences dropdown list, choose Impose all Jobs.
   If you want the jobs arriving at this device to be un-imposed, choose Do not impose.
3. Click Imposition Settings; the Edit Imposition dialog box appears showing the selected output device, the press sheet size, and the following imposition option fields:
   - **Imposition Method** – sets if the job is printed Same-Up or Multiple-Up
   - **Work Style** – defines if the job is printed on one side of the press sheet, or both sides, and how the front of the press sheet relates to the back
   - **Page Order** – the page order in which the job is imposed
   - **Page Rotation** – the rotation of pages on the print sheet
   - **Alignment** – the alignment of the printed area to the center or edges of the press sheet
   - **Fill Policy** – the option of using entire sheet or the exact amount of items to print per sheet

   A graphic representation of a print sheet appears next to each imposition option field in the Edit Imposition dialog box. When you select an imposition option, the graphic representation updates, displaying how the imposition option impacts on the printing. For a breakdown of imposition options, see Figure 9 on page 43.

4. In the Imposition Method dropdown list, choose one of the following methods:
   - **Same-Up** – the printing of data on the same side of a sheet.
   - **Multiple-Up** – the printing of two or more pages of data on the same side of a sheet, for example, 2-up, 3-up or 4 up.

   The print sheet graphic representation updates to reflect the chosen imposition method option.

5. In the Work Style dropdown list, select one of the following styles:
   - **Simplex** – printing on one side of the sheet only.
   - **Perfecting** – printing both sides of a sheet of paper in the same pass through the press.
   - **Work and Tumble** – different pages are assembled so that they are on one plate. One side is printed and the sheet is turned from front to rear so that you are using the opposite edge as the gripper edge and then the second side is printed. The product is then cut apart to make two finished items.
   - **Work and Back** – printing one side of a sheet with one set of plates, then the other side of the sheet with a set of different plates.
Defining Print Settings

- **Work and Turn** – different pages are assembled so that they are on one plate. One side is printed and then the sheet is turned over so that you are using the same gripper edge and then the second side is printed. The product is then cut apart to make two finished items.

The print sheet graphic representation updates to the selected work style option.

6 In the **Page Order** dropdown list, select one of the following options:

- **Not Specified** – no specification to page order.
- **Cut & Stack** – sheets are cut to specification, then stacked one on top of the other.
- **Saddle-stitched** – binds the pages of a section where the folded pages are stitched through the fold from the outside, using a wire staple.
- **Perfect Bound** – sheets ground or trimmed at the spine and are held to the cover by glue. This creates a squared off back.

The print sheet graphic representation updates to reflect the selected page order option.

7 In the **Page Rotation** dropdown list, select one of the following options:

- **Do Not Rotate**
- **Rotate 90°**
- **Best Fit**

The print sheet graphic representation updates to reflect the selected page rotation option.

8 In the **Alignment** dropdown list, select a print alignment option.

9 In the **Fill Policy** dropdown list, choose one of the following options:

- **Full** – fills the entire print sheet.
- **Exact** – prints the sheet with the exact of specified print, saving printer-usage costs and ink.

The print sheet graphic representation updates to reflect the chosen fill policy option.
Figure 9: Print Imposition Option Graphic Representations

<table>
<thead>
<tr>
<th>Imposition Method</th>
<th>Work Style</th>
<th>Page Order</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Unmerged</td>
</tr>
<tr>
<td>Same Up</td>
<td>Perfecting (2 plates by X)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>Work &amp; Sack (2 plates by Y)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>Work &amp; Thumble (1 plate by X)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>Work &amp; Turn (1 plate by Y)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>Simplex (One side)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td>Multiple-Up</td>
<td>Simplex (One side)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>Work &amp; Thumble (1 plate by X)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>Work &amp; Turn (1 plate by Y)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>Perfecting (2 plates by X)</td>
<td>![Diagram]</td>
</tr>
<tr>
<td></td>
<td>Work &amp; Sack (2 plates by Y)</td>
<td>![Diagram]</td>
</tr>
</tbody>
</table>

To set the press sheet margins:

In the **Margins** tab, type values in the **Margin** fields.
Defining Print Settings

To set the press sheet gutters and bleeds:

1. In the Gutters and Bleeds tab, type values in the Horizontal Gutters and Vertical Gutters fields.

   ![Note]
   You can override the values which appear on the Gutters and Bleeds tab, inherited from the system default (set in the Production Properties window).

2. Type values in the four Bleed fields.

3. Select one of the following radio button bleed options:

   - **Regular Bleeds** – the default option, suitable where a Print Buyer uploads a PDF with the bleed already properly defined.
   
   It is generally recommended that you use this option, as you create a default setting. You select other options only when fixing a specific job in the Production Queue.
   
   Example: business card of 3.5x2.
   
   i. Your Print Buyer uploads the business card PDF with bleeds. Therefore, the size of an uploaded PDF equals 3.75 x 2.25.
   
   ii. After uploading the PDF, your Print Buyer defines the bleeds in the four Bleed fields on the Gutters and Bleeds tab, and continues with the job order.
   
   iii. The job arrives at production showing the correct Print Buyer-defined bleeds.

   When an uploaded job requires bleeds, but no bleeds were created in the uploaded file, you can fix the problem in one of the following ways:

   - **Re-scale Jobs** – enlarges the size of the job to the size with bleeds and enables to specify bleeds. The size of the job remains as specified, but the design is distorted so it can be cropped to its original page size. The difference between the job and the enlarged job equals the bleeds configurations. Refer to Figure 10 and Figure 11.
   
   - **Reduce Job Size** – crops off the edges of the original file, reducing the job size. Refer to Figure 10 and Figure 12.

   ![Note]
   Use the Reduce Job Size option with caution, as some parts of the image may be cut. Use it only when you are sure the result maintains the entire image.
Figure 10: Original Business Card with no Bleed

Figure 11: Re-scaled Business Card

Figure 12: Reduced Size Business Card
Defining Print Settings

To add labels and marks to the press sheet:

On the **Labels and Marks** tab, select one or more of the following options:

- **Job Info** – displays the job number, Print Buyer name, date of production, and other valid job data.
- **Crop Marks and Folding Info** – displays crop marks, indicated by solid lines, fold marks, indicated by a dashed line at the location of each fold. 'In' or 'Out' above the dashed line refers to the fold direction and a number under the line reflects the fold order.
- **Registration Marks** – by default, displays four registration marks located on each edge of the press sheet.
- **Gutters, Job Width and Height** – displays the gutters, job width, and height values.
- **Color Bar and Separation Names** – displays CMYK and gray scale color bars and separation names that appear according to the separation color.

To set custom color bar elements:

1. On the **Custom Color Bar** tab, in the **Color Bar File** dropdown list, select a color bar option.
   
   To add additional color bar files to the dropdown list:
   
   a. Click the **Color Bar File** link; the **Color Bar Files** dialog box appears.
   
   b. Upload files to your Web Services system.
   
   For more information about uploading files, refer to **Uploading Files** on page 9.

2. Type color bar position and dimensions values (in inches) in the **Position** and **Dimensions** fields.

To set an ICC profile:

On the **ICC Profile** tab, in the **Convert RGB to CMYK via ICC Profile** dropdown list, select an ICC profile for converting RGB to CMYK. Alternatively, select **None**. For information about adding ICC profiles, refer to **Adding ICC Profiles to the System** on page 37.

You can upload ICC Profile files by clicking the **Convert RGB to CMYK via ICC Profile** link.

Click **OK** to save the print imposition settings and close the **Edit Imposition** dialog box.
Defining Third-party Imposition Jobs

You can define jobs to be imposed by a third-party application.

To define a job to be imposed by a third-party device:

1. In the Output Devices list, select Manual_Impose; the Manual Impose panel appears.
2. (Optional) In the Convert RGB to CMYK via ICC Profile dropdown list, select an ICC profile for converting RGB to CMYK. Alternatively, select None.
3. Click the Output Channels tab.
4. (Optional) In the Produce JDF Output dropdown list, select a job definition format option; the Send Production file with JDF checkbox is active; select the Send Production file with JDF option and in the Local Folder Path field, define the path.
5. Select or clear the Device supports multi-queue system option.
6. To transfer jobs to Macintosh computer platforms, select the Macintosh Target option; the system compresses the job name to less than 30 characters.
7. In the Folder Type dropdown list, select one of the following methods to store jobs:
   - Local – specifies an absolute folder path within the local server.
   - FTP – specifies the full ftp path for transferring jobs via the Internet to any remote computer (i.e. format: ftp://www.print-provider.com).
   - Network – specifies the transfer of jobs to any computer within the local network (the network server directory must be specified as the following: \ …).
8. In the Folder Path field, define a full folder path (according to the folder type method chosen).
9. Click Send a Test File and confirm the subsequent confirmation messages.
10. Click OK.
Defining Print Settings

Defining Press Setup Parameters for Pricing Calculation

You can define Setup Time, Pass Setup Time, and Print Head Setup Time configurations.

These settings are required for calculating pricing based on production costs. If you plan to calculate pricing based on price lists, these settings are not required.

To define press setup

1. In the Output Device window, click Press Setup.
2. In the Setup Time field, define the minutes needed for the initial output device setup.
3. In the Pass Setup Time field, define the minutes needed for setting up one pass through the device.
4. For offset devices, define the minutes needed to set up each print head per pass in the Print Head Setup Time box, and click OK.

Setting Speed and Waste

You can configure speed and waste definitions according to whether the device is offset, digital, or copier.

To set speed and waste parameters for offset devices:

1. In the Output Device window, click Speed and Waste.
2. In the Output Device list, select the offset output device.
3. In the Run Length field, define the number of copies required.
4. In the Speed field, define the amount of sheets to run per hour.
5. In the Waste field, define the approximate percentage of run sheet waste (derived from output device adjustments, run sheet examination, or other waste factors).
6. Click Add for additional job runs; define the parameters in the resulting fields.
   (Optional) Click Add for additional weights to be added to the job; define the parameters in the resulting fields.
8. Click OK.
**Defining Labor Charges**

You can define labor and mark-up charges used to calculate the production cost of a job.

**To define a digital labor charge:**

1. In the **Output Devices** window, click **Labor Charge**.
2. In the **Output Device** list, select the digital output device.
3. In the panel fields, define the following values:
   - **Mark-up percentage**
   - **Labor expenses per hour**
   - **Minimum labor charge per minute**
4. Click **OK**.

**To define an offset labor charge:**

1. In the **Output Devices** window, click **Labor Charge**.
2. In the **Output Device** list, select the offset output device.
3. In the panel fields, define the following values:
   - **Mark-up percentage**
   - **Plate fee**
   - **Labor expenses per hour**
   - **Minimum labor charge per minutes**
   - **Process wash-up cost (in monetary terms)**
   - **Spot wash-up costs (in monetary terms)**
4. Click **OK**.


Defining Click Charges

You can use external devices for digital print jobs, and calculate the cost per click in the production costs.

To define a click charge:

1. In the Output Devices window, select a digital output device in the Output Devices list.
2. Click the Click Charge tab.
3. In the panel fields, define the following values:
   - Mark-up percentage
   - Color page ‘click’ costs
   - Black and white page ‘click’ costs
4. Click OK.

Managing the Stock Library

You can list here the paper stock used for printing and non-paper products that you sell, such as mugs or pens. Use the Stock Library to do the following:

- Import and export stock
- Search for Stock Library items
- Add, duplicate, edit, or delete Stock Library items

You define stock by first accessing the Stock Library window.

To access the Stock Library window, select Print Settings > Production > Stock Library; the Stock Library window appears listing the available stock items.
Importing and Exporting Stock

You can import your stock list from a text or comma separated value (CSV) file. In addition, you can export your stock list to a file.

To import a file of stock item:

1. In the Stock Library window, click Import Stock.
2. In the Stock Import dialog box, define the file path, or browse to the file to be imported.
3. Select the file type and encoding, and click Start Uploading; the Import Database window appears.
   - To erase the current information and use only the data from the imported file, select Overwrite database.
   - To keep the current information and add the data from the imported file, select Add to existing database.
4. Map the stock item names to the provided fields, and click Next and OK.

To export a file of stock item:

1. In the Stock Library window, click Export Stock.
2. In the Export Stock dialog box, select the file type and encoding.
3. Click Export; in the Download File dialog box, click the link to be exported.
4. Save the file in the required location.
Searching the Stock Library

You can define search filters to populate the Stock Library list. The Stock Library is organized in columns according to categories.

Table 5: Stock Library Categories

<table>
<thead>
<tr>
<th>Categories</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog ID</td>
<td>Catalog identification number.</td>
</tr>
<tr>
<td>Stock Item Name</td>
<td>Name of the stock item.</td>
</tr>
<tr>
<td>Type</td>
<td>General material type.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor name.</td>
</tr>
<tr>
<td>Front Coating</td>
<td>Front coating method.</td>
</tr>
<tr>
<td>Back Coating</td>
<td>Back coating method.</td>
</tr>
<tr>
<td>Texture</td>
<td>Finishing texture.</td>
</tr>
<tr>
<td>Color</td>
<td>Stock color.</td>
</tr>
<tr>
<td>Weight (gsm)</td>
<td>Stock weight in grams per square meter.</td>
</tr>
<tr>
<td>Size</td>
<td>Stock size.</td>
</tr>
<tr>
<td>In Stock</td>
<td>Stock availability.</td>
</tr>
<tr>
<td>Type Details</td>
<td>Specific stock material definition.</td>
</tr>
<tr>
<td>Media Set Count</td>
<td>Information on the number of sheets in a set. For example for tabs.</td>
</tr>
<tr>
<td>Cost</td>
<td>Print Service Provider’s expenses per pre-defined range.</td>
</tr>
<tr>
<td>Price</td>
<td>Print Buyer’s expenses per pre-defined range.</td>
</tr>
<tr>
<td>Price Units</td>
<td>Price of a single unit of measurement type for providing pricing calculation basis. For example, a unit of weight, such as a kilogram.</td>
</tr>
<tr>
<td>Multi Price</td>
<td>Indicates whether there is more than one range of pricing per stock item.</td>
</tr>
</tbody>
</table>

To search a Stock Library item:

1. In the Stock Library window, select the stock type in the Search list; the value definition filter box (located to the right of the Search list) updates, listing the relevant filters.

2. In the value definition filter dropdown list, select a value definition filter. For information about the value definition filter, refer to Table 1 on page 7.

3. In the text field, define the relevant search information.

4. Click Search; the search results are displayed.
To add a new Stock Library item:

1. In the Stock Library window, click **New**.
2. In the **New Paper** dialog box, define the new stock properties, and click **OK**.

You can use the **Edit List** link to edit properties from the drop-down list.

To duplicate a Stock Library item:

1. In the Stock Library window, select the library stock item to duplicate.
2. Click **Duplicate**; the selected item is duplicated and added to the bottom of the list.

To edit a Stock Library item:

1. In the Stock Library window, select the item to edit.
2. Click **Edit**, edit the stock properties in the **Edit Item** dialog box, and click **OK**.

To delete a Stock Library item:

1. In the Stock Library window, select the item to delete.
2. Click **Delete** and **Yes**; the selected item is deleted.
Defining Print Settings

Setting Paper Sizes

You can define parent and run sheet sizes, sizes for job stock, and create custom sheet sizes or modify existing sizes. You define paper sizes by first accessing the Paper Size window.

To access the Paper Size window, select Print Settings > Production > Paper Sizes; the Paper Size window appears listing the available stock items.

To modify paper size:

1. In the Paper Size window, select the paper size; the size name, width, and height appear in the Custom Paper Size fields.

   Paper size width and height are in metric or imperial standard measurements, depending on the user language selected.

2. In the Width and Height fields, define new size parameters.
3. Click OK.

To define a custom size:

1. In the Paper Size window, click New Size;
2. In the Custom Paper Size fields, define a name and the size parameters, and click OK.

To delete paper size:

1. In the Paper Size window, select the paper size to delete.
2. Click Delete; after confirming the paper is not being used in any job, click Yes.

Avoid deleting paper sizes used in output devices, Stock Library definitions, and the Job Ticket Library. When used paper sizes in these locations have been deleted, an error message indicating the paper size no longer exists appears upon attempted use. Existing paper stock of the deleted size is not utilized and remains in stock.
Defining Shipping

You can coordinate transport and delivery of goods to Print Buyers as you complete print jobs.

Defining Carriers

Upon completion of a job’s production process, you can configure whether the job is to be collected by the Print Buyer or his agent, or you can select an international or local carrier to ship the job.

To define carriers

1. Select Print Settings > Shipping; the Carriers window appears.
2. Select the carrier(s) available in your system, and click OK.

Defining Shipping Methods

You can integrate with local and international carriers, set your shipping prices, and enable the reception of online shipping costs.

To define a new shipping method:

1. Select Print Settings > Shipping > Shipping Methods; the Shipping Methods window appears.
2. Click Add; a new New Shipping Method name entry appears in the left panel.
3. In the Shipping Method Description field, type the shipping method name.
4. In the Carrier dropdown list, select a carrier, or choose one of the following options:
   - Pick-up by Customer – no carrier is assigned; you can choose to enable or disable pricing.
   - Custom – a previously assigned carrier will ship the job.
5. In the Pricing Module dropdown list, select a pricing module; the panel below the list updates with fields or tabs.
   - Weight/Volume – shipment pricing is based on weight or volume.
   - Online – shipment pricing is based on an online quotation from the carrier. (Only available for the participating carriers.)
   - Direct Mail – shipment pricing is based on the number of copies being shipped.
Defining Print Settings

Setting the Weight/Volume pricing module:

For pricing set by weight:

a On the **By Weight** tab, select the **Enabled** check box; define the **Description** field value, and in the **Unit** dropdown list, select the units of weight.

b (Optional):
   i To add a location zone, click the **Add Zone From Library** link; the **Zone Library** appears. Select the zone and define the **Details** field values. Click **Add**.
   ii To add extra location fields, click .

c To define specific shipping locations, type field values in the **From** and **To** fields.

To cover all locations, select **Everywhere**.

d Click the **Tax** tab; the **Select Tax Package** dropdown list appears.

e Assign a tax package suited to the carrier and the shipping region, as defined in **Print Setting > Pricing > Tax Library**. For information about defining tax packages in the **Tax Library**, refer to **Tax Package** on page 178.

For pricing set by volume:

a On the **By Volume** tab, select the **Enabled** check box; edit the **Description** field as required.

b (Optional):
   i To add a location zone, click the **Add Zone From Library** link; the **Zone Library** appears. Select the zone and define the **Details** field values. Click **Add**.
   ii To add extra location fields, click .

c To define specific shipping locations, type field values in the **From** and **To** fields.

To cover all locations, select **Everywhere**.

d Click the **Tax** tab; the **Select Tax Package** dropdown list appears.

e Assign to the shipping method a tax package suited to the carrier and the shipping region, as defined in **Print Setting > Pricing > Tax Library**. For information about defining tax packages in the **Tax Library**, refer to **Tax Package** on page 178.

When you set (enable) pricing by both weight and volume, the system always defaults to the method with the highest fee.
Managing the Stock Library

Setting the Online pricing module:

a  Select the **Enabled** check box; define the **Description** field value, and in the **Delivery Method** dropdown list, select delivery method.

b  (Optional) Type a markup percentage and a handling fee value in the fields provided.

c  Verify the user parameters for the following fields:
   - **Account** and **Meter Number** (FedEx)
   - **Username** and **Password** (UPS)

d  In the **Select Tax Package** dropdown list, assign a package suited to the carrier and the shipping region, as defined in **Print Setting > Pricing > Tax Library**. For information about defining tax packages in the **Tax Library**, refer to **Tax Package** on page 178.

Setting the Direct Mail pricing module:

a  Select the **Enabled** check box; edit the **Description** field as required.

b  To add a markup, select the **Use Mark-up** check box; type a markup percentage and define the fields.

c  (Optional) To add a new range, click ; define the fields in the new range.

d  In the **Select Tax Package** dropdown list, assign to the shipping method a tax package suited to the carrier and the shipping region, as defined in **Print Setting > Pricing > Tax Library**. For information about defining tax packages in the **Tax Library**, refer to **Tax Package** on page 178.

6  Click **Save**.
Defining Carrier Pricing

This section is for customers choosing to use the Online Shipping option.

You can select one of the following four carrier pricing models:

- **UPS** – Fixed, Excel, Online. The UPS Access Attributes section describes how to obtain the UPS Online Pricing Access Attributes.
- **USPS** – Fixed, Excel, Online. Access Attributes has been predefined for use in United States Postal Service (USPS) Online Pricing.
- **FedEx** – Fixed, Excel, Online. Use FedEx excel tables (FedEx.xls) to calculate shipping prices.
- **Any other carrier** – pricing models are Fixed, Excel.

## UPS

### UPS Access Attributes

UPS Online Tools is a Web based shipping application which is customizable for your company’s business needs. Whether for creating greater efficiencies in the mail room or for lowering overall costs due to better controls over shipping activities, the UPS OnLine® Tool streamlines shipping without the addition of expensive hardware or software. The UPS Shipping tool is available in the latest XML technology and provides access to all UPS services. The UPS Shipping tool is ideal to network the shipping of activities within different retail locations, dealers or branch offices. It is also a good solution for mail rooms in large corporations or campus environments (from UPS Web site).

You must have a valid UPS account to obtain UPS Online Pricing Secure Attributes.

### Registering with UPS

To use the UPS Online Pricing Model, you must register with ups.com and request a XML access key (Access Key). Access to this service is free. This is required to send and receive information from the UPS rate database.

To register, go to the UPS registration page (www.ups.com/myups/registration?loc=en_US) and fill out the form. You must also request a XML access key and agree to the terms of the access license. A valid XML access key will then be provided via e-Mail.

After completing the UPS registration, you will receive the following two Online Pricing Secure Attributes: Username and Password.

### Receiving the Access Key

After you have registered, use your user name and password to login. Keep your user name and password close to hand, as you will need it, as well as your XML access key, to query the database.
To get access key:

1. After logging in, click the **Get Access Key** option on the navigation menu; the **Get Access Key** window appears, prompting you to select which type of key you are requesting.

2. Select **XML Access Key**.

To receive your XML access key, you need to have the Developer's Key from the email sent to you after registering. Submit the form and examine your email for the XML Access Key.

After completing this procedure, you will have the Online Pricing Secure Attribute: Access Key (XML Access Key) as requested.

To download the Rates and Service Guide from UPS, surf to **www.ups.com/content/us/en/resources/service**.

**USPS - United States Postal Service**

**USPS Access Attributes**

USPS Web Tools provides easy access to shipping information and services for your customers. Integrating these APIs into your web site, enables your customers to utilize the functions provided by the USPS without ever leaving your web site. USPS Web Tools is integrated into your Web Services system; the USPS Shipping API Server communicates over HTTP using XML (Extensible Markup Language).

**Registering with USPS**

To communicate between Web Services and USPS.com, Web Services customers must have their own user ID and password. The user ID and password that you have received is for your organization to use in accordance with the Terms and Conditions of Use agreed to during your registration process. This user ID and password is not to be shared with others outside your organization, nor is it to be packaged, distributed, or sold to any other person or entity.

To register, your customers must surf to the USPS Web Tools web site (**/www.uspswebtools.com/**) and agree to the Terms and Conditions of Use agreement, and then receive their own unique password and user ID.

When the company using the USPS Web Tool commences it's use, it is necessary to update the information held at the ICCC (USPS Internet Customer Care Center) to reflect the true name of the company using the Web Tools.
FedEx Online

FedEx Online allows Web Services users to ship Jobs to any destination throughout the world, after receiving and agreeing to the FedEx Online shipping price.

Registering with FedEx

To open a FedEx Online account:

2. Click Sign up for an account without a discount.
3. Click Sign Up Now! (Ignore the User ID and Password request).
4. Complete the requested information; create a personal ID (i.e. first name and last name together, such as FIRSTLAST).
5. Click I Accept; the Contact Information form appears.
6. Type the contact information values in the fields provided.
7. Click Continue; the Credit Card Information form appears.
8. Type the Credit Card values in the fields provided; FedEx will email a message to you containing your new account number.
9. Record and store the new Account Number, together with your User ID and Password.
Receiving a Meter Number

The Meter Number is required to integrate FedEx into Web Services's Shipping Methods.

The following procedure is only required for acquiring the Meter Number.

To acquire the Meter Number:

2. Click the Download Software link for FedEx Ship Manager software; the Install Shield Wizard appears.
3. Click Next; the Installation Country Selection window appears.
4. Select a country and click Next; the License Agreement window appears.
5. Accept the terms and click Next; the Destination Folder window appears.
6. Click Next; the Custom Setup window appears.
7. Click Next; the Ready to Install the Program window appears.
8. Click Install, and then Finish in the Install Shield Wizard Completed window; the FedEx Ship Manager icon appears on the Desktop.
9. Double-click the FedEx Ship Manager icon; the FedEx Ship Manager wizard appears.
10. Complete the Wizard steps. Your Meter Number is provided in the final step.
Defining Shipping Method Groups

Define specific shipping method groups for locality and convenience, to be made available for your Print Buyers during the job ordering procedure. After shipping method groups are defined, the options chosen appear in the Accounts > Account Setup > General Info > Default Shipping Method dropdown list, available for selection. For information on shipping methods on the Account level, refer to Selecting Shipping Method Groups for the Account on page 80.

To define a new Shipping Method Group:

1. Select Print Settings > Shipping > Shipping Method Groups; the Shipping Methods Groups window appears.
2. Click Add; a list of shipping methods and associated carriers appears in the center pane.
3. Select a shipping method and carrier, and click Add; the shipping method and carrier is moved to the Group Shipping Methods pane.
4. Repeat the previous Step for each additional shipping method and carrier.
5. Click OK.
When you start working with a Print Buyer, one of your first tasks is setting up an account for this buyer. You can also modify the account for an existing Print Buyer. Various account settings affect the look and feel of the FreeFlow Web Services Graphic User Interface (GUI). In addition, some Print Buyer’s work environments and ordering workflows require certain account settings.

The Account Setup chapter is composed of the following sections:

- Account Setup Overview.
- Creating a New Account.
- Managing Accounts.
Account Setup Overview

This section describes the Account Setup window and how to use it.

To access and use the Account Setup Window:

1. On the Web Services menu, select Accounts > Account Setup. By default, General Info is selected on the Account Setup ribbon, and the Account Setup - General Info window is displayed.

Figure 13: Account Setup - General Info window

The window includes the Accounts pane (left side of the window), and the General Info window (right side of the window).

2. You create new accounts from window. For more information, see Creating a New Account on page 66.

3. You manage accounts from this window. To do so, select the Account Setup ribbon option that is appropriate to the action that you want to perform, and from the Accounts pane, select the relevant account. For more information on managing accounts, see Managing Accounts on page 71.

The order in which you perform the two tasks in Step 3 is insignificant. That is, you can first select an account or you can first select a ribbon option.
Using the Accounts Pane

In the Accounts pane, you can perform the following activities:

- **Search for accounts:**
  a. Type the name of the account that you want to search for in the Name field and click **Search**. The Accounts Setup - General Info window displays the requested account information. The title of the Account pane changes to **Accounts (Filtered)**.
  b. Click **Reset** to restore the Accounts pane to list all accounts.

- **Import accounts:** You can import accounts into the Account Setup window. Click , and in the Import dialog box that appears, select the file that contains the accounts that you want to import. For more information on uploading files, see Uploading Files on page 9.

- **Export accounts:** You can export the accounts listed in the Accounts pane to a database file.
  a. Click ; the Export Account dialog box appears.
  b. Select the **Users** check box to include information on the account users in the exported file.
  c. To define the file format: select the **File Type** and the **Encoding** from the respective dropdown lists.
  d. Click **Export**; the system creates the account according to your settings. A zip file is also created.
  e. In the Download File window, save the account files.

- **Delete an account:** Select the account that you want to delete and click . A confirmation message appears and you are requested to confirm the delete.

- **Select an account to view additional account details, and/or modify account settings.** You can view general account settings in the Account Setup - General Info window, and you can view and modify additional...
account settings by selecting one of the Account Setup ribbon options. For more information, see Managing Accounts on page 71.

- Create a new account by clicking Add. For more information, see Creating a New Account on page 66.

Creating a New Account

Before you start working with a new Print Buyer, you need to create an account for this buyer, and define basic settings:

- Defining General Settings for a New Account.
- Defining Users for a New Account.
- Defining the Account Checkout Process.

Additional account settings are either optional or required for certain ordering workflows and work environments. For information of these options, see Managing Accounts on page 71.

Defining General Settings for a New Account

To define general information for a new account:

1. Select Accounts > Account Setup > General Info; the Account Setup - General Info window is displayed. See Figure 13. The window includes the Accounts pane (left side of the window), and the General Info window (right side of the window).

2. In the Accounts pane, click Add; New Customer # is added to the Accounts pane, where # is the account ID number that is automatically assigned by the system.

3. In the General Info window, fill in mandatory Print Buyer information:
   a. Type a customer name in the Customer Name field (mandatory step); this name replaces the default system name New Customer # that was automatically entered by the system.
   b. If relevant, from the Parent Customer dropdown list, select one of the following options:
      - None—(default) if the Parent Customer feature is not necessary.
      - This Customer is Parent—assign this account as a parent of other accounts.
      - Parents—list of existing parent options that can be assigned to the account.

4. To allow account access to the system, make sure the Disable Account check box is clear. (By default, all new accounts are enabled.)

5. Define general contact information on the Contact Information tab:
   a. Fill in the mandatory first name, last name and email fields.
   b. Fill in the other contact fields.
   c. To add the account address:
i Click Edit Address; the Edit Address dialog box appears.

ii Fill in the address fields and click OK; the address appears beneath the Edit Address link and in the Address Book.

6 Click the Account Information tab, and fill in the following account information fields—Address, City, Telephone number.

7 On the Shipping and Billing tab, define the default shipping and billing information for this account.

If you entered an address in the Contact Information tab (Step 5 in this procedure), the account name and address are automatically entered into the Shipping and Billing tab. However, you can define another name and address that will be used as the shipping and/or billing information for this account.

If you did not enter an address in the Contact Information tab, or if you want to define other shipping and billing addresses, perform the following steps:

a To define the shipping address, click Shipping Address; the Address Book appears. Fill in the shipping contact and address details, and click Save.

b To define the billing address, click Billing Address; the Address Book appears. Fill in the billing contact and address details, and click Save.

8 On the Shipping and Billing tab, select the default shipping method.

9 Click OK to save the settings.

Defining Users for a New Account

To define users for a new account:

1 In the Accounts > Account Setup ribbon, select Users.

2 On the Users pane, click Add to create a user.
3 Define an Admin user for the account:
   a Fill in the Login Name, User Type (Admin) and Password.
   b Fill in the Contact Information.

4 Click Save.

5 To define additional users:

   You can use Figure 16 to help you decide the appropriate user type. This figure indicates the default privileges available to each type of user. (Select System Setup > Advanced > User Types to display these user types and their privileges.)
Creating a New Account

Figure 16: User Types and their privileges

When you define additional users, it is important that you consider the following factors:

- By default, only those users defined as Administrator, Supervisor or Designer user types have Upload File privileges.
- It is highly recommended that you not change the default privileges for each user type; making such changes will impact those user types for all Print Buyer accounts.
- A Supervisor is a Print Buyer with privileges to order and approve jobs and create new templates. The only thing that a Supervisor cannot do is manage users.

6 To add users more efficiently, you can import a CSV file containing the users’ details, as follows:

   a Click (Export Users) under the User’s area to export a CSV file to your desktop. Select the CSV file type and click Export. Using this file will ensure that you provide correctly structured information.

   b Edit the file and fill in the details of the users. Mandatory fields are customer, login, password and privilege. It can also contain other information such as cost center and department. You can copy and paste information into this CSV file from an existing Excel sheet of users, if one exists.

   c Click (Import Users) to import the final CSV file and view the user’s details. When importing the file, be sure to select the Select File Format radio button in the Import Users dialog box.

7 You can define additional user information. For information, see Managing Users on page 81.

Defining the Account Checkout Process

Defining the checkout process is one of the basic steps that you need to perform when you create a Print Buyer account. The checkout process consists of the steps that the Print Buyer follows after clicking Checkout in the Shopping Cart and until the end of the ordering process. The process covers information that will be presented to the Print Buyer concerning shipping, billing, payment and confirmation requirements.
To define the checkout process:

1. In the Accounts > Account Setup ribbon, click Checkout. The Accounts Checkout window appears.

Figure 17: Account Setup - Checkout window

2. By default, all the items in the Checkout window are selected. Clear the check boxes of items that should not be presented to the Print Buyer in the Shipping Details, Order Details, and Confirmation checkout steps.

3. Click Save when done.
Managing Accounts

You can start working with the account after defining the basic account settings. (For details on basic account settings, see Creating a New Account on page 66). However, there are additional account settings that you can modify. These include accounts preferences, which have default settings that are used if you do not change them, and additional account settings that you might have to change, depending on your work environment, and the ordering workflows that you use.

This section includes the following procedures:

- Managing Account Access.
- Modifying Account Preferences.
- Selecting Shipping Method Groups for the Account.
- Managing Users.
- Defining User Groups Settings.
- Managing the Account Departments.
- Defining the Account Cost Centers.
- Defining Email Notification Settings.
- Customizing Order Fields at the Account Level.

Managing Account Access

To manage account access to the system:

Select Accounts > Account Setup. The General Info ribbon option is selected by default and the Account Setup - General Info window appears.

- To allow access to the system, make sure the Disable Account check box is clear. (By default, all new accounts are enabled.)
- To temporarily deny access to the system, select the Disable Account check box. To restore access, clear the Disable Account check box.
- To delete an account from the system, select the account and click (Delete icon). A customer delete confirmation message appears, requesting that you confirm that you want to delete this Print Buyer from the system.

Modifying Account Preferences

You can use the predefined system account preferences, or you can modify preferences to meet your specific account and workflow needs. Some preferences are account-related, and some preferences are workflow-related. If you want to use a specific ordering workflow, you may be instructed to make necessary preference adjustments.

You can define the following account preferences:

- Defining Account Utilities
Account Setup

- Defining the PDF Preview.
- Defining Self Registration Details.
- Defining Pricing Settings.
- Setting the Account Job-ordering Windows.
- Defining Account Branding.

To modify the account preferences:

1. In the Accounts > Account Setup ribbon, click Preferences. The Account Setup - Preferences window appears.

2. Modify the preferences as needed. The following sections explain the various preference options that you can modify.

Defining Account Utilities

This section describes the Utilities panel of the Preferences window, where you define workflow-related parameters, as shown in the following figure.

Figure 18: Account Setup - Preferences window, Utilities panel

To enable the account with the Print Driver and Selective Upload:

In the Utilities panel of the Account Setup - Preferences window, do the following:

1. To allow the Print Buyer to create variable (personalized and/or VDP database) templates, select Enable Selective Upload in the Utilities panel.

Selective Upload allows you to define text strings and images as personalized information, to be displayed with a different value every time a job is ordered. If you do not select this option, the Print Buyer can still order personalized or variable database jobs; however, the Print Buyer will be prevented from creating these templates.

2. To allow the Print Buyer to print jobs using a local print driver, select Enable Print Driver in the Utilities panel.

3. To determine from which job types the Print Buyer can select when the Print Buyer clicks Print Document from My Computer in the launch pad and from the print driver, select a group of job types in the Job Type Group field in the Utilities panel.
To define the account userflow:

In the Utilities panel of the Account Setup - Preferences window, do the following:

1. Select **Force Terms and Conditions confirmation before ordering** if you want account users to select the confirm terms and conditions check box before the ordering process can be completed.

2. Select **Enable sharing of typed data in identical template field** to allow account users to modify multiple items in VI templates, using the same data that was entered for the first template.

3. Select **Allow Ordering Jobs Without Content** to allow account users to order jobs without attaching a content file.

4. Select **Allow file attachment** to allow account users to attach missing files or additional files to a job before the job is sent to production.

When the **Allow file attachment** check box is selected, a content file can be attached to the job:

- From the **Job Properties** window, before the job is sent by the account user to the **Shopping Cart**.
- From the **Job Properties** window that you and the account user can access from the **Track Jobs** window.

If a content file was not included with the order, the account user can forward the file separately, and you can attach the file during the production stage.

5. From the **Flow of Print documents from your computer** dropdown list, choose one of the options.

6. From the **Default Shipping/Billing Address** dropdown list, choose one of the following options:
   - **Use Customer Default**—the default address is used, as defined in the **Accounts > Account Setup > General Info > Shipping and Billing** tab.
   - **As entered by the User**—the address is defined by the account user during the job-ordering procedure.

To set authentication parameters:

In the Utilities panel of the Account Setup - Preferences window, do the following:

1. To require accounts to change their passwords on a regular basis, select the **Maximum Password Age: Days** option button and fill in the **Days** field. (Default is that password never expires.)

2. To require accounts to use a complex password, select the **Force Complex Password Security** check box; your account must create a password that complies with the following rules:
   - The password must be at least seven characters long.
   - The password must contain characters from three of the following four categories:
     - English uppercase characters (A through Z).
     - English lowercase characters (a through z).
     - Digits (0 through 9).
     - Special characters (e.g., !, $, #, %).
   - The account user password is stored in encrypted form in the database.
Account Setup

Defining the PDF Preview

The PDF preview feature allows you and your account users to view the job before it is produced. This is useful for verifying the accuracy of the job.

To define the PDF preview:

1. In the PDF Preview panel of the Account Setup - Preferences window, select one of the following options from the Footer File dropdown list:
   - None—no footer is applied to the PDF preview.
   - Use System Default—the system default PDF preview is defined in the PDF Preview panel of the System Properties window, which is accessed in System Setup > Basic > General.
   - Select one of the listed PDF preview footers that was added to the list. For details, see Step 2.

2. To add footer file options to the dropdown menu, click the Footer File link and download footer image(s).

3. Open the Watermark dropdown list and select one of the following options:
   - None—no watermark is required.
   - Use System Default—use the system default watermark, as defined in the PDF Preview panel of the System Properties window, which is accessed in System Setup > Basic > General.
   - Custom—create the account watermark. When you select Custom, you can type into the Watermark Text field, and select options from the two dropdown lists of the Font field.

Defining Self Registration Details

The Self Registration feature is useful for new and occasional user situations. This feature allows users that access your home page to enter the site without a user name and password, and perform activities that you have defined for such users. This “guest” is required to register during the checkout process, and complete the order through the Credit Card service.

To enable a workflow for a guest user (occasional user):

1. In the Self Registration panel of the Account Setup - Preferences window, select Enable Guest Workflow to allow a guest user to access the system; the Guest Access Path field appears.

2. Type the URL that directs the guest user to the system home page.

3. When you want supervisor approval each time a guest enters the system, select the Approval Required checkbox.

*Send an email message each time a user has registered* is automatically selected if you select Approval Required in step 3.
Creating a New Account

- Click the **Contacts** link; the **Approval Email Contact** dialog box appears.

- Type the email address of the person in your organization who oversees guest usage of the system; an email message is sent to this address, and the approver can approve or decline each new guest user that registers into the system.

4. When you do not require supervisor approval but want to receive an email each time a user registers, select the **Send an email message each time a user has registered** check box, and clear the **Approval Required** check box.

- Click the **Contacts** link; the **Approval Email Contact** dialog box appears.

- Type the email address of the person in your organization who oversees guest usage of the system; an email message is sent to this address informing that a guest user has registered into the system.

Defining Pricing Settings

In the **Pricing** panel of the **Account Setup - Preferences** window, you define various pricing settings for each account.

**Figure 19: Account Setup - Preferences window, Pricing panel**

To define the account pricing mode:

You can define pricing for a specific account.

- From the **Customer Pricing Model** dropdown list, select one of the following options:

  - **Not defined at this level**—you do not want to activate the pricing model, and want the system to scan to the next pricing model in the pricing hierarchy for activation.

  - **Excel**—to activate the customer pricing model, and base the pricing on an Excel-based data sheet. To work with the Excel option, see **work with the Excel pricing option**: on page 76.

  - **External**—to activate the customer pricing model and transfer the job data to an external MIS system that is integrated with your system. For more information on transferring information to external systems, see **Integrating Web Services with Other Systems** on page 32.
To work with the Excel pricing option:

1. From the Customer Pricing Model dropdown list, select Excel; the Excel File link and dropdown box appear.

2. From the Excel File dropdown list, select an Excel file from the list.

3. To add Excel files to the Excel File dropdown list:
   a. Click the Excel File link; the Pricing Excel Files dialog box appears.
   b. Upload one or more valid XLS files and click Continue; the new files appear in the Pricing Excel Files dialog box.
   c. Select the new files and click Select File; the new files appear in the Excel File dropdown list.

4. Click Save.

To define pricing options:

You can set the pricing options that the account user encounters during the job-ordering process:

- **Hide Price from Customer**—prevent the user that is ordering jobs from seeing the price after requesting a quote.
- **Disable Shipping Date**—prevent the user that is ordering jobs from setting a shipping date.
- **Allow Ordering Unpriced Jobs**—enable job-ordering, even when there is a problem with the system-generated pricing.
- **Disable Shipping Price**—you and the account users will not see the shipping price. The system ignores the shipping price; the shipping price and taxes are not added to the total price, and are not included when the cost is exported to an Excel file.
- **Force Cost Center**—require the user that is ordering jobs to include a cost center name during the job-ordering procedure.
- **Force Reference Code**—require the user that is ordering jobs to include a reference code during the job-ordering procedure.

To define shipping and account taxes:

Taxes are defined at the system level. When your account users have specific tax-definition needs, you can select a tax for each account, at the account level. For more information about defining taxes, refer to the Pricing Process Overview on page 178.

Select an option from the Customer Tax dropdown list.

To define payment methods:

You can provide your account users with one or all of the following payment methods:

- **Purchase Order (PO)** is the standard payment method:
Creating a New Account

a Select PO (Purchase Order); the Force PO Number option is activated, and PO (Purchase Order) is added to the Default Payment Method dropdown list.

b To require account users to type the job’s PO number during the ordering process, select Force PO Number.

Credit Card (CC) allows account users to pay for your services through a Credit Card service. For further information on using credit card payments, refer to Adding Web Services Credit Card Service Vendors on page 279.

Select CC (Credit Card); CC (Credit Card) is added to the Default Payment Method dropdown list, and is available according to licensing authorization.

Electronic Direct Debit (EDD) allows account users to pay for your services through a Credit Card service that supports Electronic Direct Debit (EDD).

Select EDD (Electronic Direct Debit); EDD (Electronic Direct Debit) is added to the Default Payment Method dropdown list, and is available according to licensing authorization. For more information on licensing authorization, see Defining Credit Card Integration on page 31.

In the ordering process, account users select the payment method that is most suitable to their business from among the payments systems that you support.

The CC and EDD payment methods are only available after you install the Business Links module. For more information, refer to Defining Data Export on page 31.

To define the default payment method:

You can define a default payment method that will be used for all the account’s ordering processes, unless the another method is selected. The various ordering processes include Shopping Cart, Catalog, MailToPrint, and Print Driver.

- When only one option is listed in the Default Payment Method dropdown, this option is automatically the default payment method.
- When there is more than one option in the Default Payment Method dropdown list, you need to select a the default payment method.

To define an account discount:

You can define a permanent discount for this account that will automatically be applied when calculating quotes.

In the Discount field, type the discount value.
Setting the Account Job-ordering Windows

In the GUI panel of the Account Setup - Preferences window you define the windows that appear when the account users order jobs.

To define the windows that the account accesses when creating a job:

1. From the Default Order Jobs Page dropdown list, choose the job page option that will appear when the account user enters the system.
   - Launch Pad — provide the account user with direct access to the job-ordering and job tracking functions.
   - Template View — provide the account user with a list of template options for job-ordering.

2. From the Default Template View dropdown list, select one of the default template views. This view will appear when an account user wants to initiate a job based on a template. For more on templates refer Catalog Overview on page 90.
   - Root Folder — set the top folder in the template library as the folder that the account user accesses when creating a job from a template.
   - Specific Folder — the Folder link appears, allowing you to access the Choose Folder dialog box. Select the folder that the account user accesses when creating a job based on a template.
   - Catalog — select a specific catalog in the template library as the catalog that the account user accesses when creating a job from a template. Select a catalog from the Catalog dropdown list.
Defining Account Branding

In the Branding panel of the Account Setup - Preferences window you define the appearance of the account pages.

To define branding options:

1. In the Branding panel, select an option from the Customer Logos dropdown list:
   - Use System Default—use the Print Provider Logo as defined in System Setup > Basic > Home Page Customization. For more information on customization, see Customizing the Home Page on page 19.
   - Select one of the listed logos.

Customer Logos allow you to add a unique account logo to the top left corner of the account window. This is advantageous when a specific account decides that the standard Web Services look-and-feel is adequate, and the addition of the account's logo is sufficient.

To add logos to the Customer Logos dropdown list, click the Customer Logos link and download additional images.

2. From the Browser Title dropdown list, choose one of the following options:
   - Print Service Provider Name
   - Customer Name

   The value that you set in Browser Title determines the name that appears in the following locations:

   - The tooltip that appears over the Application icon in the notification area located on the bottom-right of the screen.
   - Browser name that appears in the title bar.

3. From the Skin dropdown list, select one of the Skin options:
   - Default—the system default skin as defined in Store Assets > Skins. For more information, refer to Editing the Final Design on page 207.
   - System Standard—the Web Services skin.
   - Skin—select a personalized skin for the account application.

4. Type a URL for the branded Home Page.
Selecting Shipping Method Groups for the Account

You can select groups of shipping methods from among the available shipping method groups that are defined in the system. These groups are then available to the account users during the job ordering process, and the account user can select the shipping method to be used for a specific job order. For more information on shipping method groups, refer to Defining Carriers on page 55.

To enable shipping methods selection:

1. Select Accounts > Account Setup > General Info, and click Shipping Method Groups; the Shipping Method Groups panel appears.

2. Do one of the following:
   - To select all shipping methods:
     i. Select the All Shipping Methods check box; all the shipping methods are available to account users.
     ii. From the Default Shipping Method dropdown list, select a default shipping method. This method will be used whenever a shipping method is not selected for a particular job order.

   if you do not select a default shipping method, the system uses the system default method.

   - To select a shipping group:
     i. Clear the All Shipping Methods check box.
     ii. In the Default Shipping Method field, select a shipping method.
     iii. The available shipping groups become active. Select the shipping method groups that you want to make available to the account.
     iv. From the Default Shipping Method dropdown list, select a default shipping method.

3. Click OK to save the settings.
Managing Users

This section describes additional settings that you can define for your account users, in addition to the basic user settings that you defined when you created the account. For information on defining users for a new account, see Defining Users for a New Account on page 67.

Managing users includes the following activities:

- Adding, disabling and deleting users.
- Modifying basic user settings.
- Assigning users to account cost centers.
- Assigning users to account departments.
- Customizing the user's job-ordering windows.

To manage users:

1. Select Accounts > Account Setup > Users; the Users window appears. See Figure 15 on page 68.

2. To add a new user, click Add on the Users pane. For information on defining new users, see Defining Users for a New Account on page 67.

3. To modify basic user settings for an existing user, select the user from the Users pane, and make the necessary changes.

4. Select the Disable User Account check box to temporarily disable this user from accessing the account.

5. To delete a user from the account, select the user and click the Delete icon.

6. Click Save to changes, or define additional user information. For information, see define additional user information: on page 81.

To define additional user information:

1. By default, when you define the account users, the user address is defined as the account address. However, you can modify the user's address:
   a. Click the Edit Address link in the Contact Information panel; the Edit Address window appears.
   b. Modify the fields, as needed.
   c. Click Save.

2. Click the Cost Center Assign link to assign the user to a cost center; the Cost Center Assignment dialog box appears.

   Cost centers are defined in Accounts > Account Setup > Cost Centers. For more information on cost centers, see Defining the Account Cost Centers on page 84. You can assign an account user to one or more cost centers. During the ordering process, the price order is deducted from the assigned cost center. If the
user has more than one cost center, the user selects the cost center to be used for this order. The selected Cost Center budget is updated accordingly.

To assign cost center(s):

a In the Account’s Cost Centers list, select a cost center or several cost centers from among the cost centers that are defined for this account. To assign all cost centers, select the All cost Centers check box.

b Use the Add or Add All button to assign selected cost center(s); the cost center(s) appear in the User Assigned Cost Centers list.

c Use the Remove or Remove All button to remove selected cost center(s) from the User Assigned Cost Centers list.

d Click Close to save the settings and close the dialog box.

3 Type an IP address in the IP Filter field to allow the user to access the system only from a specific computer.

4 From the Order Jobs Page dropdown list, select one of the following options:

- Use Customer Default—the account user accesses the default Order Jobs page, as defined in account Preferences. For more information, see Setting the Account Job-ordering Windows on page 78.
- Launch Pad—the account user accesses the Launch Pad when logging into the system.
- Template—the account user accesses the template view when logging into the system.

5 From the Template View dropdown list, select one of the following options:

- Use Customer Default—the account user accesses the default Template view, as defined in Preferences, when logging into the system.
- Root Folder—the top folder in the Template list is the folder that the account user accesses when initiating a job from the template library.
- Specific Folder—select a specific folder in the Template list as the folder that the account user accesses when initiating a job from the template library. When Specific Folder is selected, a Folder link appears, enabling you to access the Choose Folder dialog box.
- Catalog—select a specific catalog from the Template list as the catalog that the account user accesses when initiating a job from the template library. When Catalog is selected, the User Catalog dropdown list appears and you can select a catalog.

6 To assign the user to account department(s), select an options from the Department dropdown list:

- None—if you do not want to assign the user to a department.
- Choose one of the listed departments. You can add departments to the Department dropdown list. For more information on departments, see Managing the Account Departments on page 84.

7 Click Save to save modified user settings, or Revert to cancel your changes.
Defining User Groups Settings

You can create groups of users within the account organization. A user can belong to more than one user group.

To manage user groups:
1. Select Accounts > Account Setup > User Groups; the Account Setup - User Groups window appears.
2. To add a user group:
   a. In the User Groups pane, click Add; New Group # appears in the User Groups list and in the Group Name field on the General tab.
   b. On the General tab, type a name in the Group Name field.
   c. If necessary, type a description.
3. To remove a user group:
   a. Select a user group.
   b. Click Delete; the user group is removed from the list.

To manage the users of a user group:
1. Select a user group.
2. Click the Users tab; the Users view appears and is populated with all the users in the account.
3. To add a user from the users list to the Group Users list, double-click the user name, or select a user name and click Add; the user name is transferred to the Group Users list.
4. To remove a user from the Group Users list, double-click the user name, or select the user name and click Remove; the user name is removed from the Group Users list.
5. Click OK to save the settings.
Managing the Account Departments

You can define departments in your account organization, and assign users to each department. Departments are intended for internal use of the account users and have no consequence in regards to your print business.

To manage departments:

1. For the account for which you want to define departments, select Accounts > Account Setup > Departments; the Departments window appears. The window lists the departments and the number of users assigned to each department.

2. To add a new department, type its name in the Department Name field, and click Add; the new department is added to the Departments Name list.

3. To delete a department, select the department and click Delete; the department is deleted from the Departments Name list.

4. To change a department name, select the department and type its new name in the Department Name field and click Update. The updated department name appears in the Department Name list.

To assign account users to departments:

1. For the account for which you want to assign users, select Accounts > Account Setup > Users; the Users window appears (refer to Figure 15 on page 68).

2. On the General tab of the Users window:
   a. On the Users pane, select the user that you want to assign.
   b. Select a department from the Department dropdown list.
   c. Click OK to save.

3. Repeat Step 2 for each account user that you want to assign to account departments.

Defining the Account Cost Centers

You can create and manage cost centers, and you can charge orders to specific cost centers by assigning a budget. When you create a cost center:

- The price of all the orders charged to the cost center is deducted from the cost center’s budget.
- An administrator is notified by email when the budget reaches a predefined minimum level.
- The application prevents users from charging orders that will exceed the cost center’s remaining budget. In such cases, the user either has to postpone the order until the budget is updated, charge the order to another cost center, or pay with a credit card.
Creating a New Account

To add a cost center to an account:

1. Select Accounts > Account Setup > Cost Centers; the Cost Centers window appears.

   Figure 20: Account Setup - Cost Centers window

2. In the Cost Centers pane, click Add; the Add Cost Center dialog box appears.

3. Type a cost center name and a cost center code; click OK. The new cost center name and code appear in the Cost Centers pane, and in the Cost Center Name and Cost Center Code fields of the Cost Centers window.

4. In the Administrator's Email field, type the email address of the Print Service Provider who receives notification concerning the specific cost center.

5. (Optional). Fill in additional information about the cost center in the Description field.

6. Additional cost center fields refer to its budget. See To enable a cost center budget: on page 85.

7. Click Update to save the cost center.

To enable a cost center budget:

1. Select the account and cost center.

2. By default the Enable Budget check box is selected. If it is not selected, select it; the Set Budget button appears.

3. Type a budget name.

4. Click Set Budget; the Set Cost Center Budget dialog box appears.

5. Type an amount in the Total Budget field and click OK; the sum appears as the Total. The Used Budget and Remaining Budget amounts are automatically updated.

6. Type an amount in the Cost Center Minimum Budget field.

7. Click Update to save the settings.
Account Setup

To manage cost centers:
1. Select an account in the Accounts pane, and then select a cost center in the Cost Centers pane.
2. To delete the cost center:
   a. Click Delete; the Delete Cost Center dialog box appears.
   b. Click Yes to confirm.
3. Modify cost center information, as needed. For information, refer to To add a cost center to an account: and enable a cost center budget: and on page 85.

Defining Email Notification Settings

You can send email notifications from a specific source in your organization to one or more sources in the account organization. This section describes how to define email notifications at the account level.

You can set the email notification settings as a default for all your accounts in System Setup > Advanced > Email.

You can send email notifications when the following application events occur:

- Order Confirmation—informing that you have received the order.
- Job Price Has Been Changed—informing that you changed the quoted price.
- Job Shipped—informing the account that you shipped the specific job.
- Inventory Below Minimum Level—informing your organization and the account organization that the number of copies of a specific item in the inventory has dropped below the minimum set level.
- Preorder Jobs Expiration—informing that the specific pre-ordered order has overstayed the allotted queue time and has been automatically deleted.
- Shipping Jobs Expiration—informing that the specific shipped order has overstayed the allotted queue time and has been automatically deleted.
- Job Arrived at the Print Buyer Approval Queue—informs the account that the job has arrived at the account Approval queue.

To define the account email notifications:
1. Select Accounts > Account Setup and click Email; the Email dialog box appears.

   Default email notifications settings are set at the system level in System Setup > Advanced > Email. To use these defaults for the selected account, select the Use System Default Email Settings check box in the Email window. When you create a new account, this check box is selected by default.

2. Select the check box of the event for which you want to send out a notification, and click its Contacts link; the Email dialog box appears.
Creating a New Account

3 In the Sender panel, select a Sender option button or click Other Email and type a valid email address.

4 In the Recipients panel, select the recipients of the email message and/or type an email address into the Other Email field.

5 Repeat Step 2 to Step 4 for each notification event.

6 Click OK to save all settings and close the Email dialog box.

7 In the Email window, click OK to save the settings.

Customizing Order Fields at the Account Level

The Web Services system allows you to customize order information fields at the account level.

You can customize fields at the account level only if you enabled this option at the system level.

At the system level, you can:

- Enable customizing fields at the account level.
- Define the default customized fields for all accounts.

To customize fields at the system level:

1 Select System Setup > Advanced > Customized Fields.

2 Select the Enable Custom Fields check box,

3 Define default account fields, and define which fields are mandatory. For more information on customizing fields at the system level, see Customizing Fields on page 29.

After you enabled customizing fields at the system level, you can customize order information fields for each of your accounts. At the account level, you can select the Use System Default Settings for Order Information check box and use the default settings that were defined at the system level, or you can customize fields for a specific account.

To customize the order information fields:

1 Select Accounts > Account Setup and click Customized Fields; the Customize Fields - Order Information window appears. If selected, clear the Use System Default Settings for Order Information check box, and perform the following tasks in the window:

If you defined order fields at the system level (System Setup > Advanced > Customized Fields), they appear in the Customize Fields - Order Information window at the account level. However, you can edit the fields.

- To edit a field caption, type the new caption in the Field Caption field.
To change the order of fields, select the field that you want to move, and click **Move Up** or **Move Down** until the field is located at the new destination.

To hide a field from the account user’s view, clear the field’s **Visible** check box. To add a field to the user’s view, select the check box.

To make a field a mandatory field, select the field’s **Mandatory** check box. To make the field a non-mandatory field, clear the check box.

To define a field as a dropdown list field:

i. From the **Field Type** dropdown list, choose **Dropdown Menu**; the **Edit List** button appears.

   ii. To add options to the menu: click **Edit List**. The **Custom Field Options** window appears.

   iii. Click **Add New Custom Field Option**, and add an option name into the field.

   iv. Click **Add**; the option name is added to the **Custom Field Options** list.

   v. Continue adding options, as needed.

   vi. Click **Done** to save the menu options and return to the **Customize Fields - Order Information** window.

To define a field as a free text field, from the **Field Type** dropdown list, choose **Free Text**.

2. Click **Save** to save all settings.

3. To reset the settings, click **Revert**.

4. To restore the default settings, click **Revert**.

Defining the Account Checkout Process on page 69.
FreeFlow Web Services provides you with the capability to set-up an online store front for your customers to browse and use for ordering print products. This chapter describes how to set-up store fronts for your Print Buyers.

- **Catalog Overview** – an overview of the types of catalogs supported by Web Services and their characteristics.
- **Creating and Managing Superstore Catalogs** – define Superstore catalogs.
- **Creating and Managing HTML Catalogs** – define and manage HTML catalogs.
- **Managing the Cross Sales Library** - promote the sales volume by connecting offers of related products to product categories.
- **Managing the Image Library** - manage a library of image assets for variable information jobs.
- **Managing the Database Library** - manage a library of variable information database files.

For information regarding managing the template library, refer to Job Business Flow on page 117.
Catalog Overview

One of the main objectives of FreeFlow Web Services is to enable Print Buyers to place orders online. For this purpose you create catalogs. A catalog is an organized collection of products that is used by the print buyer to locate and order print.

Web Services includes two types of catalogs:

- **Superstore** - displayed to the Print Buyer after logging into the application. The Superstore catalog can be organized into hierarchical categories and enables ordering jobs from templates or by uploading the Print Buyers’ designs. The Superstore provides powerful navigation tools and customizable look and feel. When ordering from a Superstore the print buyer places the products in a shopping cart and then checks out the contents of the shopping cart to place the order.

- **HTML** - a flat collection of templates that can be displayed to the Print Buyer after logging into the application, sent in an email, or embedded in a web site. When ordering through an HTML catalog, the print buyer orders one job at a time without using the shopping cart.

You can define different catalogs for different Print Buyer accounts and for different users.

When you add a template to a catalog, the application creates a link to the template and places it in the catalog. Therefore, the same template can be used several times in different catalogs, without duplicating it.

Superstore Catalogs

The Superstore catalog provides the capability to create a large variety of store fronts with different look and feel, hierarchy and functionality.

The Superstore catalog has the following features:

- Enables ordering from templates and by uploading files.
- Customizable look and feel, including the catalog grid, backgrounds and text display.
- Hierarchical category structure – you have full control over the structure of a Superstore. You can place the templates into a flat list or you can organize the catalog into categories that will assist the print buyer navigation and enhance the ordering experience. Think of the Superstore as a supermarket and the categories as aisles and shelves on which the products are organized.
- Enhanced navigation tools – a display of “bread crumbs” showing the Print Buyer through which hierarchy he arrived at the current category, and an optional navigation pane that can be used either for direct links to categories, or for filtering long lists of products.
- Capability to display messages that can be used for marketing promotion, seasons greetings, or instructional information.
- Capability to display and manage a list of items on hold prior to placing them in the shopping cart.
- Capability to promote sale of products related to the category that the Print Buyer is browsing.
Superstore Look and Feel

The look and feel of a Superstore or its categories is defined by using a layout theme. The application contains a library of layout themes that you can use or modify, or you can create a layout theme from scratch. The same theme can be applied to all the categories of a Superstore, or you can have a different theme for each and every category. When a new Superstore is created a default layout theme is applied to the Superstore and all of its categories.

A layout theme controls the following aspects of a Superstore design:

- Panel layout – the items that the panel contains and the relationships between them.
- List structure – the grid structure of the categories, products and cross sale items.
- Background – the background of the categories, products and cross sale items.
- Item display formats – the format of the individual categories, products and cross sale items boxes.

Panel Layout

The application arrives with a number of predefined panel layouts. The layouts are color coded and a legend is provided.

Figure 21: Panel Layouts

The panel layout comprises a combination of the items listed below. Only the items area is mandatory and appears in all the layouts.

- Navigation pane – this section will be used by the Print Buyer to navigate within the catalog you are preparing.
- Message – you can use this area to add marketing messages and announcements to promote a specific campaign.
- Shopping Cart – a summary of the shopping cart that accompanies the Print Buyer when ordering a printed job.
Store Setup

- Items Area – this section displays the products your offer to the Print Buyer. You can divide it to few sub-categories to accommodate different users’ requirements or different templates and job types that you offer the Print Buyer.
- Cross Sale – you can use this section to promote products related to the category that the Print Buyer is browsing.

The grid structure of the Items area and the Cross Sale area in the thumbnail images, is only an indication of possibilities. This structure can be modified in the wizard.

List Structure

You can define the grid structure (number of rows and columns) of:

- Categories
- Products
- Cross Sale

For each of the areas, you can control the following attributes:

- The number of items in a row (number of columns).
- Item Height – the item height is pre-determined, according to one of three predefined sizes: small, medium, and large. Select the Custom option, if you want to type a customized height value.
- The number of rows.

You have to define the structure for the categories, and apply this structure to the products and cross sale areas.

When defining the number of rows of categories and number of rows of products, consider the following points to ensure that you allow enough rows:

- The number of category and product rows actually displayed in the Superstore might be automatically adjusted to keep the total balanced.

  For example, if two rows are defined for categories and two rows for products, but the Superstore display requires only one subcategory row instead of two, an extra (third) product row will be displayed.

- If a catalog has many sub-categories in some of its categories, and if the number of categories and products exceeds the number of allocated cells in the layout, the Superstore will generate an additional page to display the categories and products that did not appear on the first page. These will be seen by the Print Buyer only if the Print Buyer advances to the next page.

To reduce the chances of subcategories moving to a second page, allocate a larger number of rows to the subcategories. This way, if a category requires more subcategory rows, they will be available; and if not, the rows will be used by products.
Item Background

You can assign different backgrounds to the categories, products and cross sale items. The application arrives with a number of backgrounds and you can upload your own background images.

If you are preparing backgrounds with no specific layout in mind, we recommend image width of 500 pixels and image height of 200 pixels. This is a generic size that would provide good results.

If you are preparing backgrounds for a specific layout, it is best to create backgrounds in the exact required size. The height of the background image should be 60, 120, or 240, unless you plan a custom height. The width of the background is variable and depends on the number of items in one row.

The item area width is 610 pixels and the gap between the items is 10 pixels, if N is the number of items in a row:

\[
\text{Item width} = \frac{(610 - 10 \times (N-1))}{N}
\]

Therefore:

Table 6: Background Image Width

<table>
<thead>
<tr>
<th>Number of Items</th>
<th>Background width</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>300 pixels</td>
</tr>
<tr>
<td>3</td>
<td>197 pixels</td>
</tr>
<tr>
<td>4</td>
<td>145 pixels</td>
</tr>
<tr>
<td>5</td>
<td>114 pixels</td>
</tr>
<tr>
<td>6</td>
<td>94 pixels</td>
</tr>
</tbody>
</table>

Items Layout and Details

You can define the layout of each category, product and cross sale item. The layout controls the position of the following items:

- Item title – a title style text string that can display an attribute of the category or product according to your selection.
- Item description – a description style text string that can display one or two attributes of the category or product according to your selection.
- Thumbnail – the category or product thumbnail.
- Upload File and Select buttons.
For each of the item types you can also define the following parameters:

- Thumbnail size – selected out of a list of three predefined sizes or defined as a custom size.
- Title – the attribute that is displayed in the Title field.
- Text field 1 – the first attribute that is displayed in the Description field.
- Text field 2 – the second attribute that is displayed in the Description field.
- Links to sub-categories – a parameter that appears for the category items and controls whether and how many links to sub-categories are displayed in the category item.

### HTML Catalogs

An HTML catalog is a collection of templates that can be saved in HTML format. HTML catalogs are flat (have no hierarchy) and enable ordering jobs one at a time, without using a shopping cart.

HTML catalogs can be created and managed by you or by the Print Buyer.

HTML catalogs can be used in the following ways:

- You can define that a Print Buyer will see the HTML catalog as the ordering page, after logging into the application.
- You can embed an HTML catalog into another website, such as the corporate website of the Print Buyer.
- You can send an HTML catalog in an email message.

The main benefits of using HTML catalogs are:

- The ability to initiate an order from outside the application, with or without the need to log-in.
- The simple ordering flow (without using the shopping cart) makes it especially suitable for occasional users, who don't need to order more than one job at a time.
- The HTML catalog, when used outside the application without a login, provides a fully anonymous ordering flow. I.e., a Print Buyer can order a job from the HTML catalog and pay with a credit card, without registration or logging in.
Creating and Managing Superstore Catalogs

The following sections describe how to create and define a Superstore catalog:

- Managing Superstores
- Creating a Superstore
- Adding Products to a Superstore
- Applying a Layout Theme to a Superstore

Managing Superstores

You can rename, delete, copy, and move Superstores and categories. To simplify the explanation the tasks below address categories, but they can be applied to a Superstore as well, unless indicated otherwise.

If you are copying or moving a Superstore or category between accounts, the only thing that will be moved is the structure and the layout, without the products or queries.

Moving a Category

1. Select a category.
2. Click (Cut).
3. Find the Superstore or category into which you want to move the selected category and click (Paste); the category is moved from the original location to the new one.

Copying a Category

1. Select a category.
2. Click (Copy).
3. Find the Superstore or category into which you want to copy the selected category and click (Paste); a copy of the original category is created in the new location.

Renaming a Category

1. Select a category.
2. Click (Rename); the Rename Catalog dialog box appears.
3. Type the new name.
4. Click OK; the dialog box closes and the category is renamed.
Deleting a Category

1. Select a category.
2. Click (Delete); a confirmation dialog box appears.
3. Click Yes; the dialog box closes and the category is deleted.

Creating a Superstore

You start by creating a new Superstore. In most cases you would then create categories, and then populate the Superstore and its categories with products - templates and job types. When the Superstore structure is complete you can define its layout, look and feel. This sequence is not mandatory - you can start with the layout and then move to create and populate categories.

1. Select Accounts > Store Setup; the Catalogs view is displayed.
2. In the accounts list on the right side of the title bar, select an account.

Figure 22: Account Selection List

3. In the Catalogs pane, click New Catalog; the Add Catalog dialog box appears.
4. Type a catalog name and in the Catalog Layout list, make sure that Superstore is selected.
5. Click OK; the new Superstore appears in the Catalogs list and the General Information dialog box appears.
6. Complete the General Information fields and click OK. The Internal Title appears as the Superstore name to the Print Buyer.
7. Create a category:
   a. Select the catalog or category to which you want to add categories and click (New Category); the General Information dialog box appears.
   b. Type the category name, internal title and description.
   c. Click Change to add a category thumbnail; the Categories image bank appears.
   d. Select an image or upload a new one. For more information about uploading images, refer to Uploading Images on page 114.
   e. Click Add; the category is added to the Superstore.
8. Add more categories as required.
Adding Products to a Superstore

You add job types and templates to the Superstore and its categories. The Print Buyers can order print jobs based on the templates, or upload their own designs when ordering from job types.

You have the following two options for adding job types and templates to Superstores:

- **Add Products** - manually select the job types and templates that you want to place into a specific Superstore or category.
- **Add Query** - automatically populate a Superstore or category with templates. The query can either add to a Superstore all the templates located in a specific folder, or find all the templates that fulfill certain criteria and add them to a Superstore.

Defining Superstore Content Using the Add Products Option

To populate the Superstore with job types or templates:

1. Select a Superstore or category in the Catalogs list.
2. Click the Content tab; the Content view appears.
3. Click Add Products; the Add Products dialog box appears.
4. Add job types:
   a. Select the Job Type radio button; all the enabled job types appear in the products list.
   b. Select one or more job types and click >; the job types appear in the Products In list.
5. Add templates:
   a. Select the Templates radio button; all the templates of the account appear in the products list.
   b. Select one or more templates and click >; the templates appear in the Products In list.
6. Click OK to save the settings and close the dialog box; the job type and templates appear in the Content list.

Defining Superstore Content Using the Add Queries Option

When Print Buyers navigate a Superstore, the system can automatically populate the Superstore with templates. To dynamically populate a Superstore with templates:

1. Select a Superstore or category in the Catalogs list; the Content view appears.
2. Click Add Query; the Query Details dialog box appears.
3 Create a folder content query:
   a Type a query label into the Label field.
   b Leave My Account selected in the Account list.

   Use the Parent Account option if you want the query to use templates of all the accounts in the same parent account.

   c Select an option in the Folder list.
      i All - when selected indicates that the query will be defined by criteria.
      ii Root Folder - the templates are collected from the root folder and all the folders in it.
      iii Any of the customer's template folders.

   d Click OK; the query appears in the Content list.

4 Define a search by criteria query:
   a Type a query label into the Label field.
   b Leave My Account selected in the Account list.
   c Leave All selected in the Folder list.
   d Create an explicit search criteria:
      i Select a field name in the Field list. The values of this field will be compared to the search criteria.
      ii Select an operator in the That list. This operator defines which values will be fulfil the criteria.
      iii Select Explicit in the Type list. This indicates that the criteria is based on an explicit value.
      iv Type the value in the Value field. This is the value to which the field values are compared.

   Example:
   To find all the templates which have “marketing” as a keyword, the following search should be defined:
   - Field: Keywords
   - That: Like
   - Type: Explicit
   - Value: marketing

   e Create a user driven search criteria:
      i Select a field name in the Field list.
      ii Select an operator in the That list.
iii Select **User Driven** in the **Type** list; the Value text box becomes a list with the attributes of a user. This indicates that the criteria is based on the data of the Print Buyer user that navigates the Superstore.

iv Select one of the attributes in the **Value** list.

---

Example:

To find all the templates which were authored by the logged-in Print Buyer user, the following search should be defined:

- Field: Author
- That: Like
- Type: User Driven
- Value: Last Name

---

f Click **OK**; the query appears in the **Content** list.

---

**Removing Items from the Content List**

Select an item in the **Content** list and click **Remove**; the item is removed from the list.

---

**Applying a Layout Theme to a Superstore**

A Superstore can have a single layout theme applied to it and all of its categories, or a different layout theme applied to each category. The layout themes can be selected from a number of predefined layout themes, modified or created according to need.

**Applying a Pre-defined Layout Theme to a Superstore**

1. Select a Superstore or category in the **Catalog** list.
2. Click the **Layout** tab; the **Layout** view appears with an image of the default layout.
3. Click **Select**; the **Select Layout Theme** dialog box appears.
4. Select a layout theme and click **Select**; the layout theme image appears in the **Layout** view.

---

**Managing Layouts**

1. Select a Superstore or category in the **Catalog** list.
2. Click the **Layout** tab; the **Layout** view appears with an image of the default layout.
3. To edit a layout:
   a. Select the theme to edit and click **Edit**; the **Layout Wizard** appears.
   b. To work with the **Layout Wizard**, see Using the Edit Layout Theme Wizard on page 100.
When editing layouts, note the following:

- You cannot edit the default layout.
- The layout you are editing may be assigned to several Superstores, editing it will affect all these Superstores. If you are not sure about the effect of the change, it might be better to create another layout based on this layout and change the new layout.

4 To create a layout based on an existing layout:
   a Select the layout to serve as a base and click Copy and Edit; the Layout Wizard appears.
   b To work with the Layout Wizard, see Using the Edit Layout Theme Wizard on page 100.

5 To delete a layout, select a layout and click Delete; the layout is deleted.

Using the Edit Layout Theme Wizard

You can use the Layout Wizard to design the layout for a Superstore. The wizard has five steps and concludes with the Theme Summary. If any of the steps are not completed, the wizard returns you to the incomplete step before you exit the wizard.

1 Access the Layout management screen:
   a Select a Superstore or category in the Catalog list.
   b Click the Layout tab; the Layout view appears with an image of the default layout.
   c Click Select; the Select Layout dialog box appears.

2 Click New; the Create New Layout dialog box appears in the Step 1: Select Panel Layout view.

3 Select a panel layout:
   a Select a layout.
   b Click Next; Step 2: Define List Structure view appears.

4 Define the list structure:
   a For the categories area structure, define the number of items in row, item size and number of rows.
   b For the products area structure, select the Use Categories area structure check box, or define the number of items in row, item size and number of rows.
   c For the cross sale area structure, select the Use Categories area structure check box, or define the number of items in row, item size and number of rows.
   d Click Next; Step 3: Select Items Background view appears.

5 Select the items background:
   a Upload more images, if required. For more information about uploading images, refer to Uploading Images on page 114.
   b Select a background image and click > adjacent to Category Items; the image appears in the Category Items pane.
c Select a background image and click ➤ adjacent to **Product Items**; the image appears in the **Product Items** pane.

d Select a background image and click ➤ adjacent to **Cross Sale Items**; the image appears in the **Cross Sale Items** pane.

e Click Next; **Step 4: Select Item Layout** view appears.

6 Select a layout for the items:

a Select an **Item Layout** image and click the ➤ button adjacent to **Category Items**; the image appears in the **Category Items** pane.

b Select an **Item Layout** image and click the ➤ button adjacent to **Product Items**; the image appears in the **Product Items** pane.

c Select an **Item Layout** image and click the ➤ button adjacent to **Cross Sale Items**; the image appears in the **Cross Sale Items** pane.

d Click Next; **Step 5: Define Items Details** view appears.

7 Define the detailed contents of the items:

a Define the category items:

i Make sure that the check box of the image is selected, if you want it displayed. Select the image size, and type the height and width if you selected a custom size.

ii Make sure that the check box of the title is selected, if you want it displayed. Choose the field to display in the title, usually it would be the category **Name**.

iii Make sure that the check box of the first text field is selected, if you want it displayed. Choose the field to display in the title.

iv Select the check box of the second text field, if you want it displayed. Choose the field to display in the title.

v Select the **Include links to sub categories** check box. Select the number of links to display.

b Repeat the process for product items, with the exception of the **Include links**.

c Repeat the process for cross sale items (if relevant for this layout), with the exception of the **Include links**.

d Click Next; **Layout Summary** view appears.

8 Define layout summary:

a Click **Change... Panel Layout** to upload a thumbnail image of the newly created layout theme. This image will help you identify this layout in the future. For more information about uploading images, refer to **Uploading Images** on page 114.

b Type a name for the new layout theme.

c Type a description for the new layout theme.

d Type the keywords that identify the new layout theme.
Defining the Items Area

You can define the titles that introduce each item list area, including the category, template, and job type lists. A category can inherit the settings of its parent category or Superstore, in which case you have to select the Use Parent category setting check box.

1. Click the Items Area tab; the Items Area view appears.
2. Clear the Use parent category setting check box.
3. Type a title for the categories section of the items area.
4. Type a title for the templates section of the items area.
5. Type a title for the job types section of the items area.

Defining the Cross Sale Area

You can define the content of the category cross sale area, and add cross sale items to a category. Cross Sale items are stored in folders located in the Cross Sale library. For more information on the Cross Sales Library, see Managing the Cross Sales Library on page 110.

1. Click the Cross Sale tab; the Cross Sale view appears.
2. Clear the Use parent category settings check box.
3. Type a cross sale title.
4. Click Select; the Cross Sale Library dialog box appears displaying the cross sale folders of this account.

You can access the Cross Sales Library, and create additional cross sale folders. You can also edit cross sale folders or create new ones, directly from this dialog box. For more information on managing cross sales, see Managing the Cross Sales Library on page 110.
5 Select a cross sale folder containing suitable items; on the right hand side of the dialog box you can see the contents of the selected cross sale.

6 Verify that the correct cross sale is selected and click Select; the dialog box closes and the cross sale appears in the Cross Sale view.

7 Click Save.

To remove the cross sale items from the Cross Sale list, click Remove.

**Defining the Navigation Pane**

You can define the format and content of the navigation pane.

1 Click the Navigation tab; the Navigation view appears.

2 Clear the Use parent category settings check box.

3 Select one of the following options:

   - Select **Hide Pane**, if you don’t want to display the Navigation pane to the Print Buyer.
   - Select **Category Panel**, if you want to display the Navigation pane with direct links to categories.
   - Select ‘Narrow By’ Panel, if you want to display the Navigation pane with filters that enable narrowing down the list of displayed products.

4 If you selected **Category Panel**, select the links to be displayed out of the following options:

   - Select **Root level categories**, if you want to display links to the first level of categories in the Superstore.
   - Select **Current level categories**, if you want to display links to all the categories that are at the same level as the category that the Print Buyer is viewing.
   - Select **All categories and sub categories**, if you want to display links to all the categories in the Superstore.

5 If you selected ‘**Narrow By**’ Panel, select the options that you want to provide to your customer for filtering. The possible options are filtering by:

   - Author
   - Keywords
   - Reference Code
   - Subject
Adding Messages

You can select a single message to be displayed to the Print Buyers, or a number of messages that are displayed in rotation. The messages can be in image (JPEG, GIF, animated GIF, PNG) or HTML format.

1. Click the **Message** tab; the **Message** view appears.
2. Clear the **Use parent category setting** check box.
3. Click **Select**; the **Select Message** dialog box appears and displays a message list.
4. To add messages to the list, if not required, continue to Step 5:
   a. Click **Add Message**; the **New Message** dialog box appears.
   b. To add an image:
      i. Select the **Image** option and click **OK**; the **Marketing** dialog box appears.
      ii. Upload message images to the **Marketing** dialog box. For more information about uploading images, refer to Uploading Images on page 114.
      iii. Click **Select Image**; the image is added to the **Select Message** message list.
   c. To add an html message:
      i. Select the **URL** option and click **OK**; the **New URL** dialog box appears.
      ii. Type a message **Name** and **URL**.
      iii. Click **OK**; the dialog box closes and an HTML message is added to the list.
5. To select from the existing list of messages:
   a. Select one or more **Select** check boxes of messages that you want to appear in the message pane.
   b. Click **Select**; the dialog box is closed and the messages selected.

Previewing the Superstore or Category

You can preview the created catalog, to check its structure, layout and contents.

1. Click the **Preview** link; the **Preview** dialog box appears.
2. Check the Superstore by navigating the categories.
3. Click **Close** to close the window.

The width of messages that appear in the items area should be 610 pixels.
The width of messages that appear on the right, below the shopping cart panel, should be 190 pixels.
There is no height limitation, but the recommended height is 100-200 pixels, both for messages that appear in the items area and those that appear on the right.
Creating and Managing HTML Catalogs

The following sections describe how to create and define a Superstore catalog:

- Managing HTML Catalogs
- Creating an HTML Catalog
- Exporting an HTML Catalog
- Sending an HTML Catalog by Email

The instructions in this section presume that you are creating an HTML catalog, adding templates, setting-up its properties, and exporting it, in a sequence. If you are performing one of the stages on a previously created HTML catalog, make sure to select the appropriate catalog before referring to the instructions in the stage.

Managing HTML Catalogs

You can rename or delete an HTML catalog.

Renaming a Catalog

1. Select an HTML catalog.
2. Click (Rename); the Rename Catalog dialog box appears.
3. Type the new name.
4. Click OK; the dialog box closes and the catalog is renamed.

Deleting a Catalog

1. Select an HTML catalog.
2. Click (Delete); a confirmation dialog box appears.
3. Click Yes; the dialog box closes and the catalog is deleted.

Creating an HTML Catalog

1. Select Accounts > Store Setup; the Catalogs view is displayed.
2. In the accounts list on the right side of the title bar, select an account.
Figure 23: Account Selection List

3 Click New Catalog; the Add Catalog dialog box appears.

4 Type a catalog name and in the Catalog Layout list, select HTML Catalog.

5 Click OK; the new catalog appears in the catalogs list.

Adding Templates to an HTML Catalog

1 Click Add Templates; the Choose Template dialog box appears, displaying the templates of the selected account.

2 Navigate to a template and click Select; the template appears in the Catalog Name panel.

3 Repeat Step 2 for each additional template and click Close.

To delete a template from an HTML catalog, select the template and click Remove Template.

Setting HTML Catalog Template Parameters

The panel on the right hand side of the catalog list displays the HTML catalog preview. This panel displays the templates contained in the catalog and their properties, as they will be displayed in the exported HTML catalog. The preview does not display the price as will be displayed in the HTML catalog, if defined.

1 Click the Edit link that appears under each HTML catalog template; the template setup dialog box appears.

2 Select the Max number of copies allowed per order, to limit the number of copies that a user can order from this template when using the catalog.

The selection of maximum number of copies in the HTML catalog does not affect the number of copies that can be ordered from the template outside the HTML catalog.

3 To display the template price for a fixed number of copies:
   a Select the Price check box.
   b Select the number of copies from the list.
   c Click the Calculate button; the price is calculated and appears in the template setup dialog box.
4 To display the Format field, select the Format check box. The default information that appears in this field is the name of the job type on which the template is based.
   a To change the text that appears in the Format field, type a different text string.
   b To revert back to the default text, click the format Default button.

5 To display the template size that appear in the Size field, select the Size check box.
   a To change the text that appears in the Size field, type a different text string.

b To revert back to the default size details, click the size Default button.

6 The template description field displays, by default, the template name. To change the default text that appears in the Description field, type a different text string.

7 Click OK to save the changes; the new parameters appear in the catalog template details.

**Defining a Catalog’s Properties**

You can control the job-ordering workflow of the HTML catalog by defining the catalog’s properties:

1 Click Properties; the Catalog Properties window appears.

2 Define the Display Parameters.
   a Define the thumbnail size and the number of items in one row.
   b Type a message that will appear at the top of the HTML catalog.
3 Define the Workflow Parameters:

a Select an Approval option:

i To have the job sent to be approved before an order is placed, select The job requires supervisor approval... radio button.

Each template can have Supervisor Approval By-pass rules specified in the Workflow Policy settings. If these rules have been set, they will override the supervisor approval setting of the HTML catalog. For more information about setting Workflow Policy, refer to Managing the Workflow Policy of a Template on page 146.

ii Type the approver's email address or click the Address Book link, and select an address from the Address Book.

b Define the login settings:

i To require users of this HML catalog to log-in when using the HTML catalog outside the application, select the Ask for User Login check box.

When the Ask for User Login check box is clear, any user with access to the HTML catalog can order a job. The application, however, requires every job to be connected to a specific user, therefore, you must select a default login profile, which will be connected to all the jobs ordered from this HTML catalog.

ii If you want the users to order from this catalog without log-in (anonymously), clear the Ask for User Login check box, and select a default login profile from the Default Login Profile list.

The Default Login Profile list features all of the account users, displaying their user type, login name, and first and last names.

c Define the variable information settings:

This option defines the default data populating the templates, and is intended to save the user time in filling the data, reducing the chances to make mistakes. Select the appropriate option in the Form Editor default values list:

- The last entry – the variable data templates will be automatically populated by the variable data that was entered when the variable data templates were last used.
- The recent entries – the application collects the variable data entered into each template, when it was ordered from the HTML catalog. When ordering the Print Buyer can select out of these records, or type other data.
- The original design – the default text in the variable data fields will be the same text that was entered into the templates in the design stage.

d Define the order parameters:

i To allow the Print Buyer to change the system-generated name of a job, select the Allow Job Name Modification check box.

ii To display the Reference Code input field during the job-ordering procedure, select the Show the Reference Code Input Field check box.

iii Type a Default Reference Code, if required.
iv To display the Cost Center input field during the job-ordering procedure, select the Show Cost Center check box.

v To allow the Print Buyer to attach files to the order, select the Allow File Attachments check box.

**In Order Parameters**, you can select to display the reference code and cost center input fields. However, you enforce the use of these fields in Accounts > Accounts Setup > Preferences > Pricing. For more information, refer to Defining Pricing Settings on page 75.

e Define the Delivery parameters:

i To allow the Print Buyer request a shipping date other than the default, select the Allow Shipping Date Modification check box.

ii Select the default number of days from order confirmation to order shipping.

iii To allow the Print Buyer to change the default shipping address, select the Allow Shipping Address Modification check box.

When the Allow Shipping Address Modification option is selected, two more options are enabled for selection:

- **Always approve Shipping Address** — select this option if you want the Print Buyer to verify and confirm the shipping address.
- **Disable Address Book Access** — select this option to prevent the Print Buyer from choosing the shipping address from the address book.

It is strongly recommended to disable address book access when using the HTML catalog for B2C (business to consumer) applications.

f To enable template Print Buyers to view a job price during the ordering procedure, select the Show Price to the User check box.

g To send the catalogs to Print Buyers by email, type the email addresses or select the addresses from the address book. For more information, refer to Sending an HTML Catalog by Email on page 110.

h Click OK to save the settings.
Exporting an HTML Catalog

1. Select an HTML catalog in the catalogs list.
2. Click Export HTML; the Export HTML Properties dialog box appears.
3. Define the properties, if required. For more information about HTML catalog properties, refer to Defining a Catalog's Properties on page 107.
4. Click Export HTML; the Export Catalog HTML dialog box appears.
   a. Right-click the catalog link; a pop-up menu appears.
   b. Select Save Target As... option; the Save As dialog box appears.
   c. Browse to the location to save the catalog and type a catalog name.
   d. Click Save; the catalog is saved to the required location and the dialog box closes.
5. Click Close in the Export Catalog HTML dialog box.

You can use the HTML catalog for embedding in the Print Buyer’s or other website.

Sending an HTML Catalog by Email

1. Select a catalog in the catalog list.
2. Click Send MailToPrint; the Send MailToPrint Properties window appears.
3. Define the properties, if required. For more information about HTML catalog properties, refer to Defining a Catalog's Properties on page 107.
4. Type the email addresses into the Recipient Email field, or select from address book.
5. Click Send MailToPrint; the catalog is mailed to all of the email recipients.

To initiate the order from the email message, the recipients select a template and click the Start Order link located beneath the template.

Managing the Cross Sales Library

You can add a Cross Sale panel to your customer's catalog. The Cross Sale panel displays products that you want to promote and have a relationship to products that appear in the Item Templates panel.

To access the image library, select Accounts > Store Setup, select the required account and click Cross Sales.
Managing Cross Sales

You can delete and duplicate cross sales.

Duplicating a Cross Sale

1. Select a cross sale.
2. Click **Duplicate**; the cross sale is duplicated with an automatically generated name, and a dialog box confirming the duplication appears.
3. Click **OK**; the dialog box closes.
4. To rename the duplicated cross sale:
   a. Click the **General** tab.
   b. Type a new name in the **Cross Sale Name** box.
   c. Click **Save**.

Deleting a Cross Sale

1. Select a cross sale.
2. Click **Delete**; a confirmation dialog box appears.
3. Click **Yes**; the dialog box closes and the cross sale is deleted.

Creating and Populating Cross Sales

1. Click **New...**; the **Edit Cross Sale** dialog box appears.
2. Click the **General** tab; the **General** view appears.
3. Type a cross sale name, description and additional information as required.
4. Click the **Content** tab; the **Content** view appears.
5. Populate the cross sale with products, using Add Products and Add Query options.
   For more information about adding products, refer to **Defining Superstore Content Using the Add Products Option** on page 97.
   For more information about adding queries, refer to **Defining Superstore Content Using the Add Queries Option** on page 97.
6. Click **OK** to save the settings and close the dialog box; the products appear in the **Cross Sale** content list.
Removing a Product from a Cross Sale

1. Select a cross sale; the cross sale Content view is displayed.
2. Select a product in the products list and click Remove; the item is removed from the list.

Managing the Image Library

The image library is used for storing image files to be used in variable data templates and jobs. In addition, the image library can be used for providing images to be used as folder icons.

The supported image formats are: JPG, JPEG, PDF, TIF, TIFF, EPS, and PS.

To access the image library, select Accounts > Store Setup, select the required account and click Image Library.

Managing Folders

When you create a new account, the system automatically generates a General folder in the account. You can create more folders in the image library to keep the images organized. There is only one level of folders in the image library.

Creating a New Folder

1. Click (New Folder); the New Folder dialog box appears.
2. Type the folder name.
3. Click OK; the dialog box closes and a new folder is created and added to the list of folders.

Renaming a Folder

1. Select a folder.
2. Click (Rename); the Rename Folder dialog box appears.
3. Type the new name.
4. Click OK; the dialog box closes and the folder is renamed.

Deleting a Folder

1. Select a folder.
2. Click (Delete); a confirmation dialog box appears.
3. Click Yes; the dialog box closes and the folder is deleted.
Managing Images
You can copy, move, delete and rename images. Most of the operations in the image library can be performed on several images at once. To select several images use the Shift or Ctrl keys on your keyboard.

Changing the Image Display Mode
You can display the images as a list or as thumbnails.

1. To display a thumbnail view, click (View thumbnails); the view is changed to thumbnails.
2. To display a list view, click (View list); the view is changed to list.

Moving One or More Images Between Folders
1. Select one or more images.
2. Click (Cut); the (Paste) button is enabled.
3. Find the folder into which you want to move the image and click (Paste); the images are moved from the original location to the new one.

Creating a Copy of One or More Images in Another Folder
1. Select one or more images.
2. Click (Copy); the (Paste) button is enabled.
3. Find the folder into which you want to copy the image and click (Paste); a copy of the original images is created in the new location.

Renaming an Image
1. Select an image.
2. Click (Rename); the Rename Image dialog box appears.
3. Type the new name.
4. Click OK; the dialog box closes and the image is renamed.

Deleting One or More Images
1. Select one or more images.
2. Click (Delete); a confirmation dialog box appears.
3. Click Yes; the dialog box closes and the images are deleted.
Downloading One or More Images

1. Select one or more images.

2. Click (Download image(s)); a **Download File** dialog box appears.

3. Right-click on the appropriate link; a pop-up menu appears.

4. Click **Save Target As**; a **Save As** dialog box appears.

5. Browse to the location where you want to save the images and click **Save**; the image (or the ZIP file) is saved to the disk.

6. Click **Close** to close the **Download File** dialog box.

Uploading Images

1. Select the folder to which you want to upload the images.

2. Click **Upload Images**; the **Upload File** dialog box opens.

3. To upload a single file:
   - a. Click **Browse** and select the image to upload.
   - b. Click **Continue**; the image is uploaded.
   - c. Click **Close**, to close the upload dialog box; the image is added to the image library.

4. To upload multiple files:
   - a. Select the Upload multiple files option.
   - b. Click Continue; the FTP Upload dialog box opens.
   - c. Click Page and select Open FTP Site in Windows Explorer; the Windows Explorer opens.
   - d. Drag and drop the images to be uploaded to the FTP window.
   - e. Close the Windows Explorer and the FTP Upload dialog boxes.
Managing the Database Library

You can store variable data files of CSV and TXT format in the database library. You can connect these uploaded files to several variable data templates as an archive. When you update a database, the archive of all the connected templates is automatically updated.

For more information about using a stored database in a template, refer to Job Business Flow on page 117.

To access the image library, select Accounts > Store Setup, select the required account and click Databases.

Adding a Database to the Library

1. Click New; the Upload Asset dialog box appears.
2. Browse to a valid file, select the file format, and click OK; the file appears in the list.
3. Change the database name, if required.
4. Type a description.
5. Modify the database scheme, if required:
   a. If the first row of the database contains the field names, select First Row Contains Field Names check box. This indicates to the application not to treat the first row as a record in the database.
   b. If you need to change the title of any of the fields, type a new name for the field in the Caption column.
6. Click Save; the changes are saved.

Checking a Database

You can check which templates are linked to a database.
1. Select a database.
2. Click Linked Templates; the list of linked templates appears.
3. Select one of the templates; the attributes of the template appear on the right.

Deleting a Database

1. Select a database.
2. Click Delete; a confirmation dialog box appears.
3. Click Yes; the dialog box closes and the database is deleted.
Updating a Database

To update a database you upload a new database to replace it. It is important to make sure that you upload a database with the same number and format of fields.

1. Select a database.
2. Click Edit; the Upload Asset dialog box appears.
3. Browse to a valid file, select the file format, and click OK; a message confirming the successful upload appears.
4. Click OK; the database is replaced and updated in all the connected templates.
This chapter describes the Job Business Flow infrastructure of FreeFlow Web Services. This infrastructure enables you to define joblets, job types, job type groups, and templates.

This chapter is composed of the following sections:

- **General Overview** – provides an overview of the Job Business Flow concept and entities.
- **Joblets** – provides an overview of joblets and detailed instructions on joblet management.
- **Job Types** – provides an overview of job types and job type groups, detailed instructions on job type management and creation, and instructions on job type groups management.
- **Templates** – provides an overview of templates and detailed instructions on template creation and management.
- **Creating Variable Data Templates** – provides an overview and detailed instructions on creation of variable data templates, use of the Selective Upload tool and the Form Editor.
Job Business Flow

General Overview

Your Print Buyers use Web Services to order print jobs. To help them order jobs in an effective and convenient way, you have to define:

- The types of jobs that you, as a Print Service Provider, can produce.
- The possible printing and finishing options for these jobs.
- The time frame for producing these jobs.
- The allowed ordering quantities.
- The job pricing.

You begin by defining which joblets and joblet options you support, either in your printing facility or by outsourcing to other facilities. A joblet is an entity that specifies the options related to a specific printing or finishing feature. For example, print colors, page size or folding. Using the joblets, you control which options are made available to the Print Buyer when ordering a specific job type.

Once the joblets are set-up, you can define job types. A job type defines a set of characteristics for a job type that your facility provides, such as business cards, brochures, or postcards. Job types help the Print Buyer to define what he needs to order, without having to make too many decisions. They also enable you to define response times, quantities, and pricing, and most importantly the production flow on the back-end.

Print Buyers supply content (upload files) and use the job types to define the properties of the job to be printed with this content.

A template is created by uploading content (a file) and attaching a job type to it. Templates are useful when repeated orders of the same content are expected. By creating a template, you can limit the printing option selections to what is required for this specific template, further simplifying the ordering process for the Print Buyer. For example, if Print Buyers need to repeatedly order a the same brochure, they can use one of the following options:

- Every time they need to order the brochure, they would upload the brochure and select all the appropriate printing options.
- Order the brochure once, and then every time they need it again, track the previously ordered job and re-order it.
- Create a template of the brochure. The template can be added to the catalog of items for ordering and every time they need it, they can order it from the catalog without having to upload the content again or to specify printing options.

You use the Job Type Groups if you wish to limit the Print Buyer’s access to specific job types. For further information on job type groups, refer to Job Type Groups on page 141.
Joblets

The system arrives with a number of predefined joblets, on top of which you can define more joblets as required. Each joblet is responsible for a specific printing attribute or finishing process, and for each you can define specific options and customize names and icons.

You need to disable (or remove) joblets that are not pertinent for your business, add missing joblets, and for each joblet specify all the possible options. For example, if you print only black & white and process color jobs, make sure you have only black & white and process color options specified. If, in addition, you print jobs using black with one spot color, add this option as well.

You can customize the name and icon of the joblet options as it is displayed to the Print Buyer. Furthermore, you can decide to have the same option twice with different names and icons. For example, you can have two options for process color, one called “CMYK” and used in job types intended for professional audiences, and another called “Full color” and used in business cards.

It is possible to customize the description of each joblet - this description becomes the default option explanation to be displayed to the Print Buyer during ordering.

When you define the job types, you will select which joblets and joblet options are appropriate for each job type.

<table>
<thead>
<tr>
<th>Joblet Name</th>
<th>Description</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lamination</td>
<td>Defines the sides and lamination type options. For more information, refer to Lamination on page 123.</td>
<td>No</td>
</tr>
<tr>
<td>Number of Pages</td>
<td>Determines the minimum and maximum number of pages in a job. For more information, refer to Number of Pages on page 123.</td>
<td>Yes</td>
</tr>
<tr>
<td>Paper</td>
<td>Determines the paper types that are available to a job type. For more information, refer to Paper on page 123.</td>
<td>Yes</td>
</tr>
<tr>
<td>Folding</td>
<td>Determines the folding options. For more information, refer to Folding on page 124.</td>
<td>No</td>
</tr>
<tr>
<td>Binding</td>
<td>Determines the type of binding and binding options. For more information, refer to Binding on page 124.</td>
<td>No</td>
</tr>
<tr>
<td>Page size</td>
<td>Determines the job page size. For more information, refer to Page Size on page 125.</td>
<td>Yes</td>
</tr>
<tr>
<td>Colors</td>
<td>Determines whether a job is single or double sided and the printing colors. For more information, refer to Colors on page 125.</td>
<td>Yes</td>
</tr>
<tr>
<td>Collating</td>
<td>Determines whether collating is active or not active. For more information, refer to Collating on page 125.</td>
<td>No</td>
</tr>
</tbody>
</table>
Managing Joblets

To access the Joblets library, select Print Settings > Job Business Flow > Joblets; the Joblets library appears. Use this library to manage joblets.

Figure 24: Joblet Library

<table>
<thead>
<tr>
<th>Joblet Name</th>
<th>Description</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drilling</td>
<td>Determines the drilling parameters, such as the number, position, and size of the holes. For more information, refer to Drilling on page 126.</td>
<td>No</td>
</tr>
<tr>
<td>Numbering</td>
<td>Determines numbering parameters such as the type of numbering and where the numbers appear. For more information, refer to Numbering on page 126.</td>
<td>No</td>
</tr>
</tbody>
</table>

Renaming a Joblet

1. In the Joblet library, select a joblet.
2. Click Rename; a Rename Joblet dialog box opens.
3. Type the new name and click OK; the joblet is renamed.
Deleting a Joblet

You can delete only joblets that you have added (marked as Generic in the Type column).

1. In the Joblet library, select a generic joblet.
2. Click Delete; a Remove Joblet dialog box opens. If the joblet is in use in job types and templates, a list of job types and templates and a checkbox for permanently removing the joblet from these entities appears.
3. Select the Permanently remove check box.
4. Click Yes; the joblet is deleted and removed from all the job types and templates using it.

Disabling a Joblet

1. Clear the enable checkbox of the joblet; a Disable Joblet dialog box opens. If the joblet is in use in job types and templates, a list of job types and templates and a checkbox for temporarily disabling the joblet in these entities appears.
2. Select the Temporarily disable checkbox.
3. Click Yes; the joblet is disabled in the library and hidden in all the job types and templates using it.

Creating a New Joblet

1. In the Joblet library, click New; the Create Generic Joblet dialog box appears.
2. Type the joblet name and click OK; the dialog box closes, a new joblet is created and opened.

Editing a Joblet

1. In the Joblet library, select a joblet.
2. Click Edit; the joblet editing window is displayed with the Options tab selected.

Changing a Joblet Description

1. Click Description; the Description tab is displayed.
2. Type a description text.
3. Click Save to save the changes.
Adding a Joblet Option

1. Click Options; the Options tab is displayed.
2. Click Add; a new option is added to the bottom of the list.
3. Type a name for the option.
4. Type or select the appropriate values.
5. Click Change Thumbnail to add an icon to the option; the Thumbnails dialog box opens.
6. Select an image or upload a new image.
7. Click Save to save the changes.

Enabling a Joblet Option

1. Select the check box of the option; the option is enabled in all the job types and templates using it.
2. Click Save to save the changes.

Disabling a Joblet Option

1. Clear the check box of the option; a confirmation dialog box opens.
2. Click Yes to confirm; the option is disabled and hidden in all the job types and templates using it.
3. Click Save to save the changes.

Deleting a Joblet Option

1. Select an option.
2. Click Delete; a confirmation dialog box opens.
3. Click Yes to confirm; the option is removed from the joblet and from all the job types and templates using it.

Changing the Sequence of Joblet Options

1. Select an option.
2. Click Move Up or Move Down; the option is moved up or down in the list.
3. Click Save to save the changes.
Joblet Types

The following section lists the joblets in the system and their descriptions.

Lamination

The Lamination joblet determines the type of lamination and whether the lamination is applied to one or both sides of the print job. You can change the name of the option sides and type options as they are displayed to the Print Buyer.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sides</td>
<td>On what sides of the print job is the lamination applied. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>Front</td>
</tr>
<tr>
<td></td>
<td>Back</td>
</tr>
<tr>
<td></td>
<td>Both</td>
</tr>
</tbody>
</table>

Table 8: Lamination sides options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Texture</td>
<td>The texture of the applied lamination film. The system is supplied with a list of popular lamination textures, which can be edited according to</td>
</tr>
<tr>
<td>Temperature</td>
<td>The manner in which the lamination is applied to the print job. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>Hot</td>
</tr>
<tr>
<td></td>
<td>Cold</td>
</tr>
<tr>
<td>Thickness</td>
<td>The thickness of the lamination film.</td>
</tr>
</tbody>
</table>

Table 9: Lamination type options

Number of Pages

The Number of Pages joblet determines the minimum and maximum number of pages for a print job.

Number of pages is a mandatory joblet.

Paper

The Paper joblet determines the paper types that are available when defining a job type or template. The list of paper from which you can choose is derived from the paper defined in the print house settings and therefore has no options of its own. Paper is a mandatory joblet.
Folding

The Folding joblet determines the page folding options that you make available in the system. The joblet comes with a large selection of standard folds.

Binding

The Binding joblet determines the type of binding to apply to the print job, as well as the options to apply to the selected binding method. Meaning, once you select the binding method, you need to choose which options within the binding method, you want to use.

Table 10: Binding options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stapling</td>
<td>Use stapling to bind the print job. Stapling options include:</td>
</tr>
<tr>
<td></td>
<td>- Type</td>
</tr>
<tr>
<td></td>
<td>- Number</td>
</tr>
<tr>
<td></td>
<td>- Position</td>
</tr>
<tr>
<td>Comb Binding</td>
<td>Binding by inserting the teeth of a flexible plastic comb through holes</td>
</tr>
<tr>
<td></td>
<td>punched along the edge of a stack of paper. Comb Binding options include:</td>
</tr>
<tr>
<td></td>
<td>- Type</td>
</tr>
<tr>
<td></td>
<td>- Thickness</td>
</tr>
<tr>
<td></td>
<td>- Color</td>
</tr>
<tr>
<td></td>
<td>- Position</td>
</tr>
<tr>
<td>Perfect Binding</td>
<td>Binding sheets that have been ground at the spine and are held to the</td>
</tr>
<tr>
<td></td>
<td>cover by glue. Perfect Binding options include:</td>
</tr>
<tr>
<td></td>
<td>- Type</td>
</tr>
<tr>
<td></td>
<td>- Position</td>
</tr>
<tr>
<td>Binder</td>
<td>Binding papers using ring folders. Binder options include:</td>
</tr>
<tr>
<td></td>
<td>- Size</td>
</tr>
<tr>
<td></td>
<td>- Color</td>
</tr>
<tr>
<td>Thermal Binding</td>
<td>Binding papers heat-fusing a strip of tape to the spine. Binder options</td>
</tr>
<tr>
<td></td>
<td>include:</td>
</tr>
<tr>
<td></td>
<td>- Color</td>
</tr>
</tbody>
</table>
**Page Size**

The Page Size joblet determines the dimensions of the flat page size, meaning the size of the page before folding is applied. Page Size is a mandatory joblet.

**Colors**

The Colors joblet determines the colors that are available for each side of the print job. Colors is a mandatory joblet.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side</td>
<td>The side to which the color definitions apply. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>■ Front</td>
</tr>
<tr>
<td></td>
<td>■ Back</td>
</tr>
<tr>
<td></td>
<td>■ Both</td>
</tr>
<tr>
<td>Color</td>
<td>The colors that are available for each side. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>■ Black and White (B&amp;W)</td>
</tr>
<tr>
<td></td>
<td>■ Color</td>
</tr>
<tr>
<td></td>
<td>■ Spot Colors</td>
</tr>
</tbody>
</table>

**Collating**

Determines whether collating is active or not active. The Collating joblet has no other options.
Drilling
Determines whether or not drilling is supported in the job and if so, which parameters are used.

Table 12: Drilling options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of holes</td>
<td></td>
</tr>
<tr>
<td>Drill radius</td>
<td></td>
</tr>
<tr>
<td>Position</td>
<td>The location where the holes are drilled. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>- Top</td>
</tr>
<tr>
<td></td>
<td>- Left</td>
</tr>
<tr>
<td></td>
<td>- Bottom</td>
</tr>
<tr>
<td></td>
<td>- Right</td>
</tr>
</tbody>
</table>

Numbering
Determines numbering parameters such as the type of numbering and where the numbers appear.
Job Types

You create job types to define a set of characteristics for typical jobs that your facility provides and to specify the production flow of these types of jobs after they are ordered and arrive at the print house. The Print Buyers use the job types to define what they need to order, without having to make too many decisions.

In the job type library you can manage two classes of job types for simple and non-paper jobs.

- Simple job type class – intended for single component and single file jobs, such as letterheads, business cards, postcards, etc.
- Non-paper job type class – intended for items such as pens or mugs, that can be either with or without print.

There is also an add-on module (Book Assembly) for handling multi-component job types. Book Assembly is managed in a separate screen and discussed in a separate chapter. For more information about Book Assembly, refer to Set on page 293.

The main benefits of using job types are:

- A simplified and streamlined print buying experience.
- The ability to automate the business flow and provide business oriented pricing.

To summarize, job types are presets of job attributes both for the Print Buyer and for your back-end. The following examples help explain the concept of job types and their importance.

Example: Simplified Print Buying Experience

A Print Buyer user wants to order a postcard. The user uploads a file and now has to specify the job intent (define how to print and finish the job). In the absence of predefined settings, the user will have to answer dozens of questions:

- Which colors to print the job with.
- Which paper to print on out of a selection of dozens or even hundreds options.
- What type of binding to use (if at all), what type of lamination to use (if at all).
- Whether numbering is required, etc.

The user is choosing out of a large number of options, most of which are not valid for postcards. Creating a preset for postcards will enable you to eliminate all the inappropriate options and shorten the job specification process.

Example: Automation of Business Flow

In the absence of presets you cannot differentiate, in advance, between simple business cards and high quality brochures so you cannot define that the standard turnaround time for business cards is 4 hours vs. 4 days for brochures. You cannot define that business cards are printed on a standard quality digital device, whereas brochures are printed on a high quality machine. You will have a hard time finding a way to price the business cards based on the cut-throat prices of your competitor while maintaining high margins on the brochures.
How Many Job Types to Create?

At the minimum, you need to create a job type for every standard job that your business provides, such as business cards, brochures or postcards. In some cases, you might want to create two (or more) job types for the same type of job. For example, you might want to create two job types for postcards. One type would be for a marketing communications department where the Print Buyer is a professional designer. For this kind of user you would want to provide a large spectrum of options and you would use professional terminology such as CMYK or Process color, provide a list of actual paper stock items, etc. The second postcard job type would be for a B2C application where the Print Buyer has limited or no knowledge of printing terms and options. For this job type you would provide much more limited options, use simple terms like ‘full color’, and provide 2-3 paper options which you might call “thick, glossy paper” or “cream-colored recycled paper”.

Managing Job Types

To access the Job Type library, select Print Settings > Job Business Flow > Job Type Library; the Job Type library appears. Use this library to manage Job Types.

Figure 25: Job Type Library

Renaming a Job Type

1. In the Job Type library, select a job type.
2. Click Edit; the job type editing opens with the General Properties tab selected.
3. Type the new name in the Job Type Name text box and click Save; the job type is renamed.
4. Click Back to Job Type Library to return to the job type library screen.
Deleting a Job Type

1. In the Job Type library, select a job type.
2. Click Delete; a Remove Job Type dialog box opens. If the job type is in use in templates, a list of templates and a checkbox for permanently removing the job type and the templates appears.
3. Select the Permanently remove check box.
4. Click Yes; the job type and all the connected templates are deleted.

Disabling a Job Type

1. Select the disable check box of the job type; a confirmation dialog box opens.
2. Click Yes; the job type is disabled and removed from all the Superstore catalogs.

Duplicating a Job Type

Duplicating job types is useful for quickly creating job types that are similar to existing job types.

1. In the Job Type library, select a job type.
2. Click Duplicate; a duplicate of the job type is created and added to the bottom of the list.

⚠️ The name of the new job type is based on the original job type with a number extension.

Editing a Job Type

1. In the Job Type library, select a job type.
2. Click Edit; the job type editing window opens.

Refer to the Creating a Simple Job Type on page 129 for detailed information.

Creating a Simple Job Type

1. In the Job Type library, click New; the Create Job Type dialog box appears.
2. Type the job type name.
3. Select the Simple (single component Job Type) and click OK; the dialog box closes, a new job type is created and opened in the editing window.
Adding General Information to a Job Type

Use the General Properties tab to add general information to the job type.

1. Click the General Properties tab.
2. Click Change Thumbnail to add an icon to the job type; the Thumbnails dialog box opens.
3. Select an image or upload a new image.
4. Type a description (helps identify the job type during job ordering and template creation).
5. Type a subject and a reference code, if required.
6. Type keywords.
7. Type the notes (the production and finishing notes will appear in the job ticket of jobs based on this job type).

Intent

This section defines the intent options for the print job - i.e. which colors it is printed with, on which paper, what the page size is, and how many pages it contains. In addition, it describes folding, lamination, binding, numbering, etc. All these intent options are specified using the joblets.

A standard print job must always have a color, paper, page size and number of pages specification. Therefore, the intent of a simple job type is automatically populated by these joblets. Other joblets are optional and have to be selected manually. For each of the joblets you must specify the default option and you can add other options for the Print Buyer to choose from.

The joblets in the intent section appear to the Print Buyer during ordering as a wizard stage called Job Specification. Job Specification comprises steps with options to choose from, hence the joblets are called here “steps”. The Job Specification stage can be customized by controlling the intent section in the following way:

- The name and instruction text of each step can be modified.
- The sequence of the steps can be changed.
- The steps can be broken into several wizard pages by adding tabs (the name of each tab can be modified as well).
- The individual steps can be made invisible to the Print Buyer. A step can be made invisible only if it has a default option. When a step is invisible, the Print Buyer cannot change the default selection.

For creating non-paper job types follow the same process. The only difference is that non-paper job types have no mandatory joblets, and the only joblets available for adding to the intent are colors – in case printing is required, paper – for selecting a stock item, and any of the joblets that you created.
To define intent

Click the Intent tab or click Continue in the General Properties tab.

Figure 26: Job Type Intent Tab

Adding Joblets

If more joblets are required perform the following:

1. Click Add Joblet; the Add Joblets dialog box opens.

The Add Joblets dialog box displays a list of all the joblets in the system. Joblets that are already in the intent list of the job type appear grayed out.

2. Select the check boxes of the joblets that you want to enable for this job type.

3. Click OK; the dialog box closes and the joblets are added to the intent list.

Choosing the Printing Sides and Colors

Use this joblet to define whether the job will be printed on one side of the paper or both, and which colors it will be printed with.

1. Select the Colors joblet and click Edit; the Edit Joblet Property dialog box opens.

2. Type a step name and description if you want them to differ from the joblet default.

3. Select the check boxes of those printing side options that are appropriate for your product.
4. Select the option that you consider standard for the product and click **Set as Default**.
5. Select the check boxes of those printing color options that are appropriate for your product.
6. Select the option that you consider standard for the product and click **Set as Default**.
7. Click **Save**; the dialog box closes. The default and additional options appear in the intent list.

### Choosing the Printing Paper

Use this joblet to define a list of papers for the Print Buyer to choose from. The first paper in the list is the default.

1. Select the **Paper** joblet and click **Edit**; the **Edit Joblet Property** dialog box opens.
2. Type a step name and description if you want them to differ from the joblet default.
3. Click **Add Paper**; the **Paper** dialog box opens.
4. Select the paper that you consider standard for the product and click **OK**; the dialog box closes and the paper is added to the list.
5. Repeat step 4 for more papers as needed.
6. Click **Save**; the dialog box closes. The default and additional options appear in the intent list.

### Choosing the Page Sizes

Use this joblet to define which page sizes are appropriate for the job.

1. Select the **Page Size** joblet and click **Edit**; the **Edit Joblet Property** dialog box opens.
2. Type a step name and description if you want them to differ from the joblet default.
3. Select the check boxes of the page size options that are appropriate for your product.
4. Select the option that you consider standard for the product and click **Set as Default**.
5. Click **Save**; the dialog box closes. The default and additional options appear in the intent list.

### Choosing the Number of Pages

Use this joblet to define the number of pages that is appropriate for the job. This property can be defined as a range.

1. Select the **Number of Pages** joblet and click **Edit**; the **Edit Joblet Property** dialog box opens.
2. Type a step name and description if you want them to differ from the joblet default.
3. Type the number of minimum and maximum pages allowed for this job type.
4. Click **Save**; the dialog box closes.
Choosing the Options in Additional Joblets

If you have added more joblets to the intent, perform the following procedure for each.

1. Select the joblet and click **Edit**; the **Edit Joblet Property** dialog box opens.
2. Type a step name and description if you want them to differ from the joblet default.
3. Select the check boxes of the options that are appropriate for your product.
4. Select the option that you consider standard for the product and click **Set as Default**.
5. Click **Save**; the dialog box closes.

Adding Tabs

If you want to break the **Job Specification** stage into several wizard pages perform the following:

1. Select the joblet above which you want the tab added.
2. Click **Add Tab**; the **Create Intent Tab** dialog box opens.
3. Type a tab name and description.
4. Click **OK**; the dialog box closes and the tab is added to the intent list.

Changing the Sequence of Intent Steps

1. Select a joblet or a tab.
2. Click **Move Up** or **Move Down**; the joblet or tab is moved up or down in the list.

Making Intent Steps Invisible

You can decide not to show a certain joblet to the Print Buyer during ordering. This is useful when the user doesn’t have to choose out of several options. For example, if you print posters on one paper type only, you can make the paper joblet invisible. You cannot make a joblet invisible if it has no default option selected for it.

1. Select a joblet.
2. Clear the visibility check box; if the joblet has more than one option selected, a confirmation message will appear.
3. Click **OK**.

Removing Intent Steps

You can remove only tabs or non-mandatory joblets.

1. Select a joblet or a tab.
2. Click **Remove**; the joblet or tab is removed from the list.
Ordering Sequence

This section of the job type specification defines the sequence and properties of the Print Buyer ordering wizard. The system has 6 wizard stages, 3 of which are mandatory and 3 optional. The stages are:

Table 13: Ordering Sequence Properties

<table>
<thead>
<tr>
<th>Stage</th>
<th>Additional Options</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upload File</td>
<td>Mandatory</td>
<td>Summary</td>
</tr>
<tr>
<td>Job Specification</td>
<td>Mandatory</td>
<td>Preview and summary</td>
</tr>
<tr>
<td>File Report</td>
<td>Mandatory</td>
<td>Preview and summary</td>
</tr>
<tr>
<td>Preview</td>
<td>Optional</td>
<td>Summary</td>
</tr>
<tr>
<td>Summary</td>
<td>Optional</td>
<td>Preview</td>
</tr>
<tr>
<td>Job Details</td>
<td>Optional</td>
<td>Preview and summary</td>
</tr>
</tbody>
</table>

The ordering sequence section provides you with the tools to control the Print Buyer's experience and to create highly customized applications for special markets or Print Buyers. You have the following customization options:

- The name of each stage can be modified.
- The optional stages can be enabled.
- Some of the stage properties can be modified.
- A preview and/or a summary can be displayed in-line with some of the stages.
- The sequence of the stages can be modified with the following limitation - the Upload File and Job Specification must precede the File Report stage.

While it is possible to place a Preview before a file has been uploaded, it is not recommended, since the Print Buyer will see an empty rectangle where a preview is supposed to have been.

File Report

The File Report stage cannot be disabled, but it can be modified and even hidden from the Print Buyer. It provides you with the following options:

- Specify the resolution threshold. If the job contains images with resolution lower than the specified threshold, a warning will be issued.
- Specify whether RGB images will trigger a warning.
- Specify whether missing fonts will trigger a warning.
Specify whether the File Report will be displayed.
Specify whether the user will be allowed to continue if problems are encountered, and if yes, the phrasing of the warning message that the user will have to confirm in order to continue.

Preview
The Preview stage enables you to specify whether the displayed preview will be in JPG or PDF format and whether the user will be required to confirm the preview in order to continue.

Job Details
The Job Details stage enables you to specify if the user will have the option to modify the job name, whether to display the cost center and reference code fields and whether these fields are mandatory.

Quote before Upload Scenario
You can utilize the Ordering Sequence to create different scenarios. The following example for a quote before upload scenario is provided to give you some understanding of how to harness this feature to the needs of your Print Buyers.

To create a Quote then Upload scenario do the following:

<table>
<thead>
<tr>
<th>Stage</th>
<th>Enable</th>
<th>Additional Options</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Specification</td>
<td>Yes</td>
<td>Summary</td>
<td></td>
</tr>
<tr>
<td>Upload File</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Report</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preview</td>
<td>Optional</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Summary</td>
<td>Optional</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job Details</td>
<td>Optional</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Print Buyer will be able to define the intent and immediately check the price. If the price is satisfactory the Print Buyer can upload the file and continue the ordering process.

To define the ordering sequence
1. Click the Ordering Sequence tab or click Continue in the Intent tab.
2 Select the check boxes of the stages you want to enable.

3 Change the sequence of the stages by using the Move Up and Move Down buttons.

4 Select the Preview and Summary check boxes for each stage where they are required.

Make sure that the Preview, as a separate stage or as a part of one of the stages, does not appear before the Upload File stage.

Adjusting the File Report Parameters

1 Select the File Report stage and click Edit; the File Report dialog box opens.

2 Type a stage name if you want it to differ from the default.

3 Define the minimum acceptable image resolution.

4 Define whether to warn the user when the file contains RGB images.

5 Define whether to warn the user when fonts are missing.

6 Define whether to display the File Report to the Print Buyer.

7 Define whether to enable the Print Buyer to continue ordering when problems are encountered.
8 Modify the phrasing of the message that the user has to confirm if allowed to continue ordering a job with problems.
9 Click OK; the dialog box closes.

**Adjusting the Preview Parameters**

Perform the following procedure if a preview stage is required.

1 Select the Preview stage and click Edit; the Preview dialog box opens.
2 Type a stage name and description if you want them to differ from the default.
3 Select the type of preview to display, JPG or PDF.
4 Define whether to force the Print Buyer to confirm the preview before continuing to order.
5 Modify the phrasing of the confirmation message.
6 Click OK; the dialog box closes.

**Adjusting the Job Details Parameters**

Perform the following procedure if the Job Details stage is required.

1 Select the Job Details stage and click Edit; the Job Details dialog box opens.
2 Type a stage name and description if you want them to differ from the default.
3 Select the display Job Name check box if you want to let the Print Buyer modify the automatically generated job name.
4 Select the display Cost Center check box if the Print Buyer has to select a cost center and select the mandatory checkbox if necessary.
5 Select the display Reference Code check box if the Print Buyer has to provide a reference code and select the mandatory checkbox if necessary.
6 Click OK; the dialog box closes.

**Settings**

The Setting section deals with the back-end aspects of the job type:

- Quantity
- Pricing
- Tax
- Urgency
Ordering Quantity

The system enables you to control the quantities ordered by the Print Buyer. There are two options to specify quantity:

- Provide the Print Buyer with an option to enter any number within a range (text box).
- Have the Print Buyer select the quantity from a predefined list of options (drop-down list).

In both cases you can define the default quantity.

**To define ordering quantity**

1. Click the **Quantity** tab or click **Continue** in the **Ordering Sequence** tab.

   ![Figure 28: Job Type - Settings - Quantity](image)

2. Select the type of control that will be presented to the Print Buyer, text box or drop-down list.

   If you selected text box perform the following steps:
   
   3. Type the minimum and maximum quantities for ordering.
   4. Type the default quantity.

   If you selected drop-down perform the following steps:
   
   5. Type the **From**, **To** and **Step** values to define a range of quantities.
   6. Click **Add** and repeat step 4 if more ranges are required.
7 Click the (refresh) button; the Default Quantity and Verification areas are updated. The Default Quantity is automatically set to the lowest value.

8 Select another default quantity if required.

9 Click Save.

Example for drop-down list setting:

You want to enable the Print Buyer to order postcards in the following quantities:

- Not less than 250.
- Multiples of 250 up to 1000.
- Multiples of 1000 after that.
- Not more than 10,000.

To achieve this you will create the following:

Table 15: Quantity Example

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>250</td>
<td>1000</td>
<td>250</td>
</tr>
<tr>
<td>1000</td>
<td>10000</td>
<td>1000</td>
</tr>
</tbody>
</table>

The resulting list will be: 250, 500, 750, 1000, 2000, 3000, 4000, 5000, 6000, 7000, 8000, 9000, 10000.

Figure 29: Quantity Example
Pricing

The system enables you to define how the job will be priced and on which device it will be printed. There are two pricing models that can be used on a job type level:

- Intent pricing – calculates the job price based on intent related price lists, according to the specific intent selections made by the Print Buyer during ordering. This method enables you to price according to market prices or according to value as you estimate it.
- Manual – does not calculate the price. When ordering the Print Buyer will see N/A (not available).

For more information about pricing, refer to Pricing on page 175.

Print Time Settings

Web Services provides an option to define standard production times for different job types. Jobs that are ordered to be printed in the standard time frame are priced as defined in the pricing section. There is also an option for the Print Buyer to request a job to be printed earlier in which case you can charge premium prices. You can define two levels of urgency - Express and Urgent, define the time frame for each urgency level and the surcharge percentage. You can also decide to inherit the default system level settings.

For more information about urgency, refer to Defining Print Settings on page 33.

To define print time settings

1. To access the print time settings click the Tax and Urgency tab or click Continue in the Pricing tab.
2. To define specific settings, select Define print time settings radio button.
3. Select up to how many days and hours is the urgent printing time and type the surcharge in percent.
4. Select up to how many days and hours is the express printing time and type the surcharge in percent.
5. Select up to how many days and hours is the regular printing time.
6. Click Save.

Example:

You have 12 hour work days, from 8 a.m. to 8 p.m. You have set-up the following print times for printing restaurant menus:

- Urgent - 5 hours, surcharge 50%
- Express - 1 day, surcharge 25%
- Regular - 2 days

Let’s see what happens to the pricing of 1000 menus ordered on Monday 6p.m. The regular printing price for this job is 100$.

- The user requested the order to be ready for Wednesday 8 a.m. Since the requested printing time is more than 1 day (which is the specification for urgent) it is a regular job and will be charged 100$.
- The user requested the order to be ready for Tuesday 4 p.m. This is more than 5 hours (urgent) and less than 1 day (express), therefore it is considered an express job and will be charged 125$(100$+ 25% surcharge).
The user requested the order to be ready for Tuesday 10 a.m. This is less than 5 hours (urgent) and will be charged 150$ (100$ + 50% surcharge).

**Define Tax Settings**

The system enables you to define a tax per job type. The requirement to define a job type specific tax is particular to some countries. In most countries you would want to use the default system tax settings.

For more information about taxes, refer to Set-up Tax Packages on page 181.

The job type can inherit the system level tax settings or you can define a specific tax for this job type.

1. To access the tax settings click the **Tax and Urgency** tab or click **Continue** in the **Pricing** tab.
2. To define specific settings, select **Define tax settings** radio button.
3. Select the appropriate tax package.
4. Click **Save**.
5. Click Back to Job Type Library.

When the job type is ready to be used, don’t forget to clear the disable check box of the job type in the job type library.

**Job Type Groups**

In some cases, you might want to limit the users of a Print Buyer account to the use of some job types (especially if you are creating account-specific applications). This is accomplished by creating groups of job types and assigning these groups to Print Buyer accounts.

If you don't use the Job Type Groups option, the Print Buyers of an account will be able to see and use all of the job types in the system.

**To create job type groups**

1. Select **Print Settings > Job Business Flow > Job Type Groups**; the **Job Type Groups** window opens.
2. Click **New Group**; the **New Group** dialog box opens.
3. Type a group name and click **OK**; the dialog box is closed and the group is added to the list. The new group is automatically selected.
4 Add job types to the group:
   a Select one or more job types from the **Job Types** list.
   b Click **Add**; the selected job types are added to the selected group and displayed in the list on the right.

5 Remove job types from the group:
   a Select one or more job types from the **Job Types** list.
   b Click **Remove**; the selected job types are removed from the selected group.

**Figure 30: Job Type Groups**
Templates

The most common use of Web Services is for ordering repeat work and variable information work. This is achieved by using job templates. The template is similar to a job that is kept in a repository for the Print Buyer to order from. Unlike a job, a template has no quantity attached to it and no shipping information.

Templates are account related, so each Print Buyer account has its own template repository.

Template Types

Templates generally fall into one of the following templates types:

- Static templates—these are templates that have non-changing print information. They produce documents that look the same every time. For example, letterhead stationery and brochure templates are generally static type template.

- Personalized templates—these templates are generally used where a single set of variable values is needed. For example, this template is useful when individuals order their own business cards. In the business card example, the file that is provided by the Print Buyer to build the template would include the business card design, and the fields (name, title, contact info, and so on). The Print Buyer user would provide the individual values when placing an order.

- VDP (variable data printing) templates—in contrast to personalized templates that use a single set of variable data, VDP templates utilize multiple sets of variable data that is provided in a variable data file during ordering. For example, such a template would enable a user to place a single job order for business cards for an entire department.

- Archive templates—are VDP templates with a variable data file permanently connected to them. When the Print Buyer orders such a template, the list of variable data records is displayed and the user can choose which of the records to print.

- Book Assembly Templates – templates based on composite Book Assembly job types. For more information about Book Assembly, refer to Set on page 293.

- Inventory Templates – static templates that have been marked as inventory. For more information about inventory templates, refer to Enabling a Template for Inventory on page 148.

Template Creation

You, as the Print Service Provider, can create templates for your Print Buyers. You can also allow your Print Buyers to create templates.

When the Print Buyer is creating a template, the options to define ordering sequence, quantity, pricing and tax are hidden.

For templates created by the Print Buyer to be added to Superstore catalogs, the Superstore must use dynamic category population by queries, and the Print Buyer should place the templates into predefined folders.
There are two ways to create templates:

- Create a new template in the template repository.
- Save an existing job as template.

**Template Structure**

A template has similar properties to a job type - you can define intent, ordering sequence, quantity, pricing, tax and urgency for a template in much the same way as a job. A template has several sections that do not exist in a job type - content, file report and variable information.

**Content**

To create a template you must upload a content file.

**Intent**

When creating a template you start from the intent options of the job type and limit the printing option selections to what is required for this specific template, further simplifying the ordering process for the Print Buyer.

The intent of a template is always a subset of the intent of the job type it is based on. A template cannot contain a joblet or a joblet option that does not exist in the job type.

**File Report**

The application runs a preflight process on the content file and compares it to the intent. It provides a report of the problems found in the file and any mismatch between the file and job type.

**Managing Templates**

1. To access the Template repository of an account, select Accounts › Store Setup › Templates; the Templates library appears.
2. Select the required account.

**Renaming a Template**

1. In the Template repository, select a template.
2. Click (rename); the Rename dialog box opens.
3  Type the new name and click OK; the dialog box closes and the template is renamed.

Deleting a Template

1  In the Template repository, select a template.
2  Click (delete); a confirmation dialog box appears.
3  Click Yes; the template is deleted.

Copying a Template

Templates can be duplicated in the same account or copied to another account. When the template is copied to the same account its name must be changed.

1  Select one or more templates (using the Shift and Ctrl keys on your keyboard).
2  Click (copy); the templates are copied to the clipboard and the (paste) button is enabled.
3  Navigate to the account or folder in which you want to place the copy the templates and click (paste); a duplicate copy of the templates is created in the new location.

If the template was copied to the same account, the name of the new template is based on the original template with a number extension.

Moving a Template

Templates can be moved to another folder in the same account or to another account.

1  Select one or more templates (using the Shift and Ctrl keys on your keyboard).
2  Click (cut) the templates are copied to the clipboard and the (paste) button is enabled.
3  Navigate to the account or folder in which you want to place the copy the templates and click (paste); the templates are moved to the new location.

Editing a Template

1  In the Template repository, select a template.
2  Click Edit Properties; the template editing window opens.

For detailed information refer to the Creating a New Template on page 149.


Adding an Archive to a Template

1. In the Template repository, select a template.
2. Click Manage Archive; the Manage Template Archive dialog box opens.
3. To manually create a database:
   a. Click New; a record is added.
   b. Type the text data in the text fields and select or upload images in the image fields.
   c. Repeat for all the records.
4. To import a database:
   a. Click Import Database; the Upload Variable Data Database dialog box appears.
   b. Find the database (CSV format) on your disk and click Open.
   c. Click Next.
   d. If the database contains a first row with the fields names, select the check box indicating so.
   e. Map the fields of the database to the fields of the template.
   f. Click Next; the database is imported and the records appear in the Manage Template Archive dialog box.
5. Click Save; the dialog box closes, the database archive is attached to the template.

Managing the Workflow Policy of a Template

Use this area to control whether supervisor approval will be required based on the data typed into the variable fields during ordering:

1. In the template repository, select a template.
2. Click Workflow Policy; the Workflow Policy dialog box opens.
3. Select the Apply Supervisor Approval By-pass Fields check box; a list of template fields is displayed.
4. For each of the fields select the Modification and/or Overflow/Empty check boxes as required.

If you selected Modification for a field, and the field default data was changed during ordering, the template will require supervisor approval. If you selected Overflow/Empty for a field, and the field was left empty or the string length is longer than the allocated field width, the template will require supervisor approval.

Managing the Access Rights of a Template

1. In the Template repository, select a template.
2. Click User Access; the User Access dialog box opens with the Groups tab selected.
3 To manage the access rights per group:
   a Select the Groups tab (if it is not selected).
   b Select a group name in the list on the left.
   c Click Assign (No Access) if the users of this group are not to be allowed to order this template from the template repository view or to manage it in the repository.
   d Click Assign (Order only) if the users of this group will be allowed to order this template from the template repository view but not to manage it in the repository.

4 To manage the access rights per user:
   a Select the Users tab.
   b Select a user name in the list on the left.
   c Click Assign (No Access) if the users of this group are not to be allowed to order this template from the template repository view or to manage it in the repository.
   d Click Assign (Order only) if the users of this group will be allowed to order this template from the template repository view but not to manage it in the repository.

Sending a Template as MailToPrint

1 In the Template repository, select a template.
2 Click MailToPrint; the Send MailToPrint Properties dialog box opens.
3 Define the MailToPrint properties:
   a Define whether the job needs to be approved by a supervisor.
   b Select whether to show the reference code input field.
   c Select whether to require the user to login.
   d Define how many times the email message can be used for ordering.
   e Select the maximum number of copies to be ordered via the email message.
   f Type the message subject.
   g Type the recipient email, or choose from address book.
   h Type the default reference code.
   i Type the message header.
4 Click Send MailToPrint; a confirmation message is displayed and an email is sent to the specified user.
5 Click OK to close the confirmation message.
6 Click Close to close the Send MailToPrint Properties dialog box.
**Enabling a Template for Inventory**

By enabling a template for inventory, you enable a Print Buyer to print jobs for storage rather than immediately delivery. By working with the inventory templates, you can produce larger numbers of job copies than are immediately needed and therefore reduce production costs while maintaining the ability to ship jobs immediately, when the need arises.

To create an inventory template:

1. In the **Template** repository, select a template.
2. Select the **Enable Inventory for this template** check box; the **Inventory Information** link appears (note that at this stage there are 0 copies in the inventory).
3. Click the **Inventory Information** link; the **Inventory Information** dialog box appears.
4. Complete the fields with valid data.
5. Click **OK** to save the settings and to close the dialog box.

**Managing Inventory Information**

In the Inventory Information dialog box you can define:

- Number of copies in **Customer Inventory** – this field keeps track of the current number of copies in the inventory, based on the ordering to and from inventory by the Print Buyer. This number is updated automatically, but you can initialize it to reflect the starting situation of your inventory.
- Number of copies in **Risk Inventory** – you have the flexibility to print more copies to inventory than ordered by the Print Buyer and collect the money for printing these copies when the Print Buyer orders prints for inventory and you move these copies from the risk inventory to the Print Buyer's inventory without printing. The Print Buyer does not see this quantity in the inventory.
- The total number of copies – provides you with the real inventory information. This data is not displayed to the Print Buyer.
- The **inventory location**.
- The minimum number of copies in inventory – when the customer inventory level reaches this number an automatic notification message is issued to the Print Buyer.
Creating a New Template

1. In the Template repository, click Create a new Template; the Choose Job Type dialog box appears.
2. Select the job type on which the template will be based and click Select; the dialog box closes, a new template is created and opened in the editing window.

Adding General Information to a Template

Use the General Properties tab to add general information to the template.

1. Click the General Properties tab.
2. Click Change Thumbnail to add an icon to the template; the Thumbnails dialog box opens.
3. Select an image or upload a new image.
4. Type a description (helps identify the template in the Superstore catalog).
5. Type a subject, ISBN number, author name and reference code, if required.
6. Type keywords (can be used for Superstore queries).
7. Type the notes (the production and finishing notes will appear in the job ticket of jobs based on this job type).
8. Click Save & Continue.

Upload File

At this point you have to upload the content of the template.

1. Click the Browse... button; the Choose File dialog box opens.
2. Navigate to the file to be uploaded, select it and click Open.
3. Click Save & Continue; if the file format required it (e.g. if you uploaded a Word, PowerPoint or a file format other than PDF), the Printing Options tab might be displayed.

If you encounter problems while upload Microsoft Word or PowerPoint files, refer to the Troubleshooting guide for additional information.
4  If necessary, choose the appropriate printing options for your file.
5  Click **Save & Continue**; the **Intent** tab is displayed.

**Specifying the Intent**

Use the **Intent** tab to specify the job intent options of the template and the additional options for the Print Buyer to choose from.

Note the following points:

- The intent tab is based on the intent of the job type on which the template is based. You cannot add to the template joblets or options that do not exist in the job type.
- All the template intent joblets are automatically invisible - this means that the default options are selected for the Print Buyer automatically and cannot be changed. If you want to open specific options for the Print Buyer to choose from - make these joblets visible.
- The colors, page size and number of pages are usually based on the template content. Verify that the correct options are selected as default. It is recommended to leave these joblets invisible.

For additional information regarding the intent tab refer to Specifying the Intent in the Job Type section.

When you finish specifying the template intent click **Save & Continue**; the **File Report** tab appears.

**Using the File Report**

If the system encounters preflight or mismatch problems the **File Report** screen will be displayed. If the **File Report** is not displayed continue to the next section **Variable Information**.

1  Click the **Click here to review these problems** link; the detailed file report appears.
Figure 31: Detailed File Report

2 View the file report and look for the warning icons.

3 Handle the warnings as described below.

4 When you are done click Save & Continue.

Size Mismatch

If you encountered a size mismatch, the reason could be:

- For some reason the size was not identified by the system: go back to the intent and choose the correct size as default.
- You chose the wrong job type: create the template again using the correct job type.
- You uploaded the wrong file: upload another file.
- The uploaded file has the correct information but the external dimensions are wrong due to orientation, crop or bleed problems: use the Crop & Bleed button to indicate the correct data.
- A size is missing in the job type definition: fix the job type and start again.

You also have the options to keep the file properties and ignore the job type intent specification or to keep the job intent and ignore the file properties. Both options are not recommended when building templates.

Color Mismatch

If you encountered a color mismatch the reason could be:

- For some reason the color was not identified by the system: go back to the intent and choose the correct color as default.
- You chose the wrong job type: create the template again using the correct job type.
- You uploaded the wrong file: upload another file.
- A color is missing in the job type definition: fix the job type and start again.
You have the option to keep the file properties and ignore the job type intent specification, this is not recommended when building templates.

There is also a case where you might want to keep the job intent and ignore the file properties. For example, if you uploaded a process color file and the template color intent is black only. You might decide to create a black only template out of a color file. Practically it is a valid option, but it might be confusing to your Print Buyers, since the preview shows the actual file content and not the intent, so the Print Buyers will always see a color preview while printing a black only job.

Number of Pages Mismatch
If you encountered a number of pages mismatch, the reason could be:

- You chose the wrong job type: create the template again using the correct job type.
- You uploaded the wrong file: upload another file.
- The number of pages in the job type definition was not defined correctly: fix the job type and start again.

Non-embedded Fonts
If the fonts are not embedded in the file, it is best to create the file again with embedded fonts and upload it again.

If you proceed with non-embedded fonts, the system will try to find the appropriate fonts on the server and if it doesn’t find them it will substitute with the most appropriate font.

Low Resolution Images
If you continue with low resolution images, the printed job will have quality problems. The only way to address this is to fix the file and upload again.

RGB Images
If you continue with RGB images, the system will convert the RGB images to CMYK according to its built-in algorithm and ICC profile. The printed job might have quality problems compared to the expectations of the Print Buyer. The only way to address this is to fix the file and upload again.

Variable Information
You can define whether the template is static, personalized or VDP.

For personalized and VDP templates you will create the variable data fields by using the Selective Upload feature and then define the properties of these fields and the relationship between them by using the Form Editor.

1. If you are creating a static template, select Static (if it isn’t selected).
2. Click Save & Continue to continue to the Ordering Sequence stage.

If you want to create a variable data template refer to Creating Variable Data Templates on page 155.
Defining the Ordering Sequence

The ordering sequence of a template is not displayed to the Print Buyer during template creation. This section is similar to the job type with the following changes:

- There is no File Upload stage.
- There is a Variable Information stage.
- No stages are mandatory.
- The File Report stage exists, but it is always disabled.

The stages are:

Table 16: Template Ordering Sequence Properties

<table>
<thead>
<tr>
<th>Stage</th>
<th>Additional Options</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Specification</td>
<td>Optional</td>
<td>Preview and summary</td>
</tr>
<tr>
<td>File Report</td>
<td>Always disabled</td>
<td></td>
</tr>
<tr>
<td>Variable Information</td>
<td>Optional</td>
<td>Preview and summary</td>
</tr>
<tr>
<td>Preview</td>
<td>Optional</td>
<td>Summary</td>
</tr>
<tr>
<td>Summary</td>
<td>Optional</td>
<td>Provides a summary of the job’s intent and a price calculation</td>
</tr>
<tr>
<td>Job Details</td>
<td>Optional</td>
<td>Preview and summary</td>
</tr>
</tbody>
</table>

To define the ordering sequence

1. To access the Ordering Sequence tab click the Ordering Sequence tab or click Save & Continue in the Variable Information tab.

2. For additional information refer to Ordering Sequence on page 134.

Defining the Settings

The settings (quantity, pricing, tax and urgency) are the same as in the job type and inherit the settings of the job type. The Settings section is not displayed to the Print Buyers during template creation.

For additional information refer to Ordering Sequence in the Job Type section.
Creating a New Template from an Existing Job

The simplest way to create a new template, is by saving an existing job as template. This feature is especially useful for your Print Buyers.

1. Click Tasks > Track Jobs; the Search window appears.
2. Find the required job using the search or open one of the status specific queues.
3. Click Save as Template; the Save as Template dialog box opens.
4. Type the template attributes.
5. Select the folder in which you want the template to be saved, you can create a folder at this point, if required.
6. Click OK; a template is created and saved in the selected location.

You can now open this template and modify any of its parameters. For detailed information refer to the Creating a New Template on page 149.

The created template belongs to the same Print Buyer account which was used to order the job.
Creating Variable Data Templates

1. Select an existing static template or create a new one.
2. Select the Variable Information tab.
3. Select Personalize or VDP template type; the Selective Upload and Form Editor buttons are enabled.

Select Variable Data Fields

To create a variable data template in Web Services, you start with a high quality file which is uploaded to the application and converted into PDF format. You use the Selective Upload feature to identify all of the text strings and images that are to be converted into variable data fields.

1. Click Selective Upload; a warning message is displayed.
2. Click Yes; a Modify PDF dialog box opens.
3. Select the variable fields.
   a. For creating text fields follow the procedure Selecting Variable Text Fields below.
   b. For creating image fields follow the procedure Selecting Variable Image Fields below.
4. Click OK in the Modify PDF window; the Selective Upload Font Report window is displayed.
5. Ensure the correct fonts are chosen.
6. Click OK in the Selective Upload window; the Selective Upload window closes and the Form Editor opens.

Each time you use Selective Upload in a template, the specifications you previously defined for the template in the Form Editor are lost. Therefore, when you use Form Editor on a relatively small file, it is recommended that you define every single field, so that later on, you do not need to use Selective Upload again to make changes.

Selecting Variable Text Fields

1. In the Modify PDF dialog, select the (Select Text area) from the field selection list.
2. In the PDF display, select the text string that will become a single variable data field. It is important to decide in advance how to break down the fields (for example, whether to define a single, full name field, or to define two separate fields for first name and last name).
3. In the Selected Fields dialog box, specify the field name.
   For example, in the PDF select John Smith, and in the Selected Fields window, specify Full Name as the name of the field.

Figure 32: Selective Upload
Selecting Variable Image Fields

1. In the Modify PDF window, select (Select Graphic/Image area) from the text selection tool.
2. In the PDF display, select the image that will become a variable data field.
3. In the Selected Fields dialog box, specify the field name.

Defining Variable Data Field Properties

Use the Form Editor to specify:

- Text alignment and boundaries properties.
- Font properties.
- Properties that govern the behavior of fields during ordering.
- Properties that control the display of fields in the printed job.

To define the basic field properties

1. In the Define Fields tab of the Variable Information window, click the Form Editor button (if it didn’t open automatically); the Form Editor window opens, along with a Layout Preview dialog box.
2. For each field adjust the settings as necessary. Refer to the detailed tasks below.
3. If necessary access the Advance Options area. Refer to the detailed tasks below.
4. Click OK in the Form Editor; the Form Editor is closed and the Define Fields tab in the Variable Information is displayed again.

Text Fields

Form Editor enables to define text fields’ input rules and behavior, alignment and boundaries, and font properties.

Defining Input Restrictions on Fields

You can define several input restrictions on fields:

- No restrictions.
- A field is mandatory.
- A field is mandatory and its value must differ from the default value.
- A field’s value must be changed or be left empty.

To mark a field as mandatory

1. Select the field.
2. Select Input Field text cannot be Blank in the Field Input list.
To mark a field as mandatory and different from the default

1. Select the field.
2. Select Input Field text must be changed and cannot be Blank in the Field Input list.

To mark a field as must be changed or left empty

1. Select the field.
2. Select Input Field text must be changed or empty in the Field Input list.

Defining Non-Editable Fields

Non-editable fields are used for captions. The caption has to be made variable in order to be able to move it on the template according to values of other fields, but requires no input from the user during ordering.

1. Select the field.
2. Select the Non-Editable check box.

Defining Non-Printable Fields

Non-printable fields are used for data collection.

1. Select the field.
2. Select the Do not print this field check box.

Defining User Moveable Fields

User moveable fields can be interactively moved by the Print Buyer during ordering.

1. Select the field.
2. Select the User moveable check box.

Defining Pinned Fields

Pinned fields are useful in cases when a template contains some fields that are to be updated manually for a certain job, and other fields that will be uploaded from a database. You need to mark the manually updated fields as Pinned, the application will enable the Print Buyer to type the values of Pinned fields and will then enable to upload a variable database to the other fields.

1. Select the field.
2. Select the Pinned check box.
Defining the Target Audience of a Field

The target audience of a field enables to make a field visible or invisible according to the user type viewing the Variable Data Form.

1. Select the field.
2. Select the appropriate option in the View By list.

Defining Field Format

Field format rules warn the user when the data entered is not formatted correctly, and in some cases corrects the typed data. The formats are:

- Special formats for phone numbers and zip codes.
- Special formats for emails.
- ALL UPPER CASE, all lower case, Sentence case or Initial Caps.
- Limit the acceptable characters.
- Other, custom, formats.

The field format correction and warning is applied only to manual entry of data using the Variable Data Form (job personalization).

1. Select the field.
2. Select the required format from the Field Format list.
3. Or click Field Format link for more options.
Defining Drop-down Menu Fields

- Drop-down lists are used to simplify the user's interaction with the application, to improve accuracy of data input and to reduce costly mistakes.

There are two types of drop-down lists – simple and complex.

It is important to remember that while the drop-down lists have many benefits, changing them (adding, editing or removing values) requires editing the template. Therefore, it is preferable not to create drop-down lists for fields which values might need to be changed by users.

Simple drop-down lists are used to limit the number of options for a specific variable field, and at the same time to facilitate fast and accurate entry of data when creating the print Job. A common example would be to prepare a drop-down list of titles: Mr., Mrs., Dr., etc.

Complex drop-down lists are used in cases when the values of several fields are interdependent. In such a case you can create a drop-down list on one field (the leading field), and connect each value in drop-down list to a set of values in other fields. I.e. a change in one field will cause a pre-defined change in other fields as well.
common example of such a case would be a company with offices in several locations. When ordering a business card or letterhead, an employee has only to select a location and the appropriate address, city, fax, etc. will be filled in automatically.

To define a simple drop-down menu:

1. Select the field.

2. Select Dropdown Menu in the Field Type list; to the right of the Field Type appear a drop-down icon and two new buttons: Add List and List Management.

3. Click Add List; the Add List dialog box appears.

4. Enter several values, use comma as a separator between the values.

Figure 34: Simple Drop-down Menu

5. Click OK to save the list and close the window.

To define a complex drop-down menu:

To simplify this task it will be presented through an example. For the sake of the example we will assume that you have a leading field called Office Name and two fields connected to it: Office Address and Office Fax.

The instructions below are for creating the table manually. You can also import a table that you have created in Excel.

1. Select the field.

2. Select Dropdown Menu in the Field Type list; to the right of the Field Type appear a drop-down icon and two new buttons: Add List and List Management.

3. Click List Management; the List Management dialog box appears.
4 Click **Add Table**; the New Table dialog box opens.

5 Type the table name (**Office**) and click **OK**.

6 Create the primary column:
   a Select the name of the leading field (Office Name) in the list.
   
   You will be creating several columns of values, each column connected to one field. Generally, you can create the columns in any sequence you wish, and then define which of these columns is the primary (leading) field. It is, however, more convenient to start with the leading field and then add the fields dependent on it.
   
   b Type the first value in the empty text field (**New York**).
   
   c Click **Add Row**; another row is added to this column.
   
   d Type another value (**London**), continue adding rows and values as necessary.
   
   e Select the radio button above the Office Name column to indicate that this is the **Primary Column** (leading field).

7 Create connected fields:
   
   a Click **Add Column**; another column is added to the table. The new column has the same number of rows as the primary column.
   
   b Select the name of a field to be changed based on the value of the primary column in the list (Office Address in our example), and type the values for this field for each of the values in the primary column.
   
   c Add a column for another connected field (Office Fax).
Defining Composite Fields

Composite fields are used when you have a paragraph that is not variable and inside it variable strings, the length of which affects the flow of text in the paragraph.

A good example would be a direct mail campaign for a supermarket, promoting a specific product in the supermarket according to the preferences of the recipient:

“In our fruit department you will find fresh pineapples every day!”

The sentence in this example is the “composite” field, while the name of the department and the product are its children fields. Most of the standard field properties can be applied to the children fields.

1. Select the field.

2. Select Composite from the Field Type list; the Composite properties are displayed.
3 Select the children fields:

   a Select the word or words you want to become one field and click (Word Selection); the selected string is highlighted and a field is added to the list under the composite field.

   b Repeat for additional strings.

4 Click Save.

**Image Fields**

Form Editor enables to define image fields’ input rules and behavior, and alignment and boundaries.

**Defining Input Restrictions on Fields**

You can define several input restrictions on image fields:

- No restrictions.
- A field is mandatory (an image must be selected).
- A field is mandatory and its value must differ from the default value (default image must be changed and an image must be selected).
- A field’s value must be changed (default image must be changed).

**To mark a field as mandatory**

1 Select the field.

2 Select An Image Must Be Selected in the Field Input list.

**To mark a field as mandatory and different from the default**

1 Select the field.

2 Select Default Image Must Be Changed and an Image Must Be Selected in the Field Input list.

**To mark a field as must be changed**

1 Select the field.

2 Select Default Image Must Be Changed in the Field Input list.

**Defining Non-Editable Fields**

1 Select the field.

2 Select the Non-Editable check box.

**Defining Non-Printable Fields**

Non-printable fields are used for data collection.
1 Select the field.
2 Select the Do not print this field check box.

Defining User Moveable Fields
1 Select the field.
2 Select the User moveable check box.

Defining Pinned Fields
1 Select the field.
2 Select the Pinned check box.

Defining the Target Audience of a Field
1 Select the field.
2 Select the appropriate option in the View By list.

Controlling the Image Upload Policy
You can define several image upload options:

- Do not allow image upload – will force the user to select an image from the available selection.
- Allow upload to the job folder – the user will be able to upload the image, but it will be available only for this job.
- Allow upload to the personal folder – the user will be able to upload the image to a personal folder, hence only he will be able to use this image while ordering in the future.
- Allow upload to the selected folder – the user will be able to upload the image to a predefined folder in the public library.
- Use access to the public image library – the user will be able to upload the image to any folder in the public image library.

To define the policy
1 Select the field.
2 Select the required Image Upload option.

Controlling the Image Selection GUI
You can control whether the images for selection will be displayed during ordering as a drop-down list or as a slider control.
1 Select the field.
2 Select the required Image Selection GUI option.
Enabling the Image Editor

When the Image Editor is enabled, the user after uploading an image can crop, scale or rotate it as needed using the interactive Image Editor tool.

1. Select the field.
2. Select the Use Image Editor check box.

Advanced Options

In many cases of generic designs for personalization, specific values used in the Job can affect the design. The Form Editor Advanced options are designed to deal with these situations.

Example

<table>
<thead>
<tr>
<th>Name</th>
<th>Title</th>
<th>Tel</th>
<th>Mobile</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Janice Jones</td>
<td>President</td>
<td>444-555123</td>
<td>422-555345</td>
<td><a href="mailto:janice@global.com">janice@global.com</a></td>
</tr>
<tr>
<td>John Smith</td>
<td>Vice President</td>
<td>444-555125</td>
<td>422-555348</td>
<td><a href="mailto:john@global.com">john@global.com</a></td>
</tr>
<tr>
<td>James Cook</td>
<td>Supervisor</td>
<td>444-555321</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Carol Donaldson</td>
<td>Project Manager</td>
<td>444-555327</td>
<td></td>
<td><a href="mailto:carol@global.com">carol@global.com</a></td>
</tr>
</tbody>
</table>

In this example each one of the employees for whom a business card should be printed, requires different data fields. One doesn't have a mobile phone, another doesn't have a mobile or email.

The options for dealing with this type of situation are:

- Create one design and leave gaps in it. This option is not valid in professional quality print jobs.
- Create several different designs. This is a valid and common solution but it requires maintaining different design versions and requires an extra decision by the user as to when to use each design.

The Form Editor Advanced Options address this issue by defining flexible rules that deal with these changes ad-hoc:

- Position links handle the vertical and horizontal position of fields relative to position of other fields. This can be related to the size of a fields or to absence of data in a field.
- Suffix enables you to specify a constant suffix in a field, so that the ordering user has to type only the changing information, a situation that is common to emails. This reduces unnecessary typing of data and thus possible errors.
- Group Centering is used to balance “white space” resulting from such changes as vertically or horizontally modified position links, changes in the number of lines in a multiline field, or horizontal centering of fields with varying length.
- Empty Fields is used to remove labels and captions for fields that have been left blank.
Identical Input Fields is used to specify several fields that use the same data, so that the ordering user has to enter the data only once and all the connected fields are populated automatically. This reduces unnecessary typing of data and thus possible errors.

Style Selection is used for instances where a field's style (font, font size, and font color) might require adjustment.

**To define advanced options**

1. Click **Advanced Options**; the Advanced Options dialog box opens with the Positions Links tab selected.
2. Click **OK** when you finish modifying the Advanced Options.

**Defining Position Links**

1. Select the field you would like to re-position (for example, City) and click **Add**; the field is added into the Moved Field text box and a Leading Field drop-down list appears.
2. Select the empty field (for example, Address 2) in the Leading Field and select the Vertical Link check box.
3. This ensures that the vertical location of the field being repositioned (City) will be affected by the vertical position (or the absence) of the other field (Address 2).
4. Leave the relative positioning radio button at its default selection.
5. A text message at the bottom of the window indicates the nature of the change (for example, “In case ‘Address 2’ is empty ‘City’ will be placed in ‘Address 2’ position”).
Repeat the process for each field that needs repositioning.

Click Apply.

Defining a Suffix

1 In the Advanced Options window, click the Suffix tab.

2 Select the field where the suffix does not change (for example, Agent email) and click Add. The field is added to the Fields with Suffix area.

3 Fill in the suffix (for example, royalcargo.com) in the Field Suffix field.
Figure 37: Suffix

4. Click **Apply**.

**Defining Advanced Group Centering**

1. In the **Advanced Options** window, click the **Group Centering** tab.

2. Create a block of fields to act as a group by clicking **New Group** and entering a name for the group of fields (for example, Customer).

3. Indicate whether horizontal or vertical centering should be performed for the group.
4 For each field that will be in the group, select the field and click Add.

5 Click Apply.

The application calculates the enclosing rectangle for the fields in the group and the vertical or horizontal center of the rectangle. When a job is ordered, the application checks the existing fields in the order, recalculates the enclosing rectangle and aligns the new vertical or horizontal center to the original point. It then positions the text accordingly.

Handling Empty Fields

1 In the Advanced Options window, click the Empty Fields tab.

2 For each field whose label should be removed if the field is empty, select the field and click Add. The field is added to the Empty Fields Definitions area.
Handling Identical Input Fields

1. In the **Advanced Options** window, click the **Identical Input Fields** tab.
2. Click **New Group** and enter a name for the field (for example, Customer Name).
3. For each field sharing identical information with another field, select the field and click **Add**.

When done, click **Apply**.
4 When done, click on Apply.

**Defining Advanced Style Selection**

1 In the **Advanced Options** window, click the **Style Selection** tab.

2 To adjust a style item for a group of fields
   
   a Click **Add Group**. The **Add Group** dialog box appears.

   b Specify the **Group Name** (for example, Customer).

   c Select the type of item (Font, Font Size, or Color) in the **Group Type** drop down box and click **OK** in the **Add Group** dialog box.

   d Add fields to the group by selecting each field and clicking **Add**.

   e Select the allowable style item values (for example, select the allowable fonts if you selected Font from the drop down list) for the fields in the group.
Repeat this for each group and style combination.

**Arrange Fields**

You have the option to change the sequence of the variable data fields and to break the **Variable Data Form** that is filled by the Print Buyer during ordering (when dealing with personalized templates) into several wizard pages. The ability to break the form into several pages is important in the following circumstances:

- The form contains a large number of variable data fields.
- The template has several pages with variable data fields on each page.
- The variable data fields have different context. For example in a real estate direct mail postcard some fields are for the real estate agent, some fields for the advertised property, and some for the recipient.

The splitting of the form to several tabs can be done manually or in case of multi-page templates—automatically.

**Changing the Sequence of Fields**

1. Select the **Arrange Fields** tab or click **Save & Continue** in the **Variable Data** tab.
2. Use the **Move Up** and **Move Down** buttons to change the sequence of the variable information fields.
3  Click Save & Continue to continue to the Ordering Sequence stage.

**Splitting Fields into Several Tabs**

If you want to split the variable information form into several tabs, decide if the split will be logical or by pages.

**To split manually:**

1  Select the field which you want moved to the next tab and click Add Tab; the Create VI Tab dialog box opens.

2  Type the tab name and description and click OK; a tab line is added.

**To split automatically:**

1  Click Split Steps by Pages; the list of variable information fields is broken into several tabs according to the number of pages in the template. The sequence of steps is changed automatically, if required.
This chapter describes the pricing and tax calculation features of Web Services. It provides an overview, explanation of concepts and step-by-step instructions for performing all the pricing related tasks.

The chapter is composed of the following sections:

- **Pricing Overview** – a comprehensive overview of pricing concepts and options.
- **Setup** – describes how to define settings that enable the system to automatically generate a price and to display it online to the Print Buyer.
- **Price Management** – describes tools to manage the pricing data and to view and modify the pricing of jobs and orders.
- **Line Item Library** – provides an overview of the line item library and general library management tasks.
Pricing Overview

Web Services provides a comprehensive feature for pricing jobs and orders. Whenever the Print Buyer is viewing the job summary or clicking Get Quote in the shopping cart, the pricing mechanism is activated to calculate the *job price*. Then, during the checkout process, after the shipping details are supplied, the pricing mechanism is activated again to calculate the *order price* which includes the urgency surcharges, discount, shipping price, and taxes.

Concepts

The pricing feature introduces some basic concepts. While understanding these concepts might not be critical for daily operation of the application, you may find them beneficial for getting the maximum benefit out of the pricing mechanism.

Calculation Model

A calculation model is an algorithm that calculates a job's pricing and production data. The calculation model contains a *planner* component, an *estimation model* and a *decision* component.

The system is supplied with the following job pricing calculation models:

- Intent
- Manual
- Excel (part of an optional module)

You select the job calculation model when defining job type and template pricing, or in case of Excel pricing, when setting up an account.

A separate calculation model is supplied for order pricing.

Intent Calculation Model

The intent calculation model plans the job's production and calculates the job's pricing based on the intent selections made by the Print Buyer.

Manual Calculation Model

The manual calculation model plans the job's production, but does not provide an automatic price. You will need to provide the price manually when a job is created.

Excel Calculation Model (Optional)

The Excel calculation model calculates the price according to an Excel spreadsheet that you provide. The Excel calculation model is part of the optional Data Export module.

For more information, refer to [Excel Pricing](#) on page 281.
Planner Component

The planner component is the first part of the job pricing calculation model. It is an algorithm that checks the job's intent and the output devices available to produce the job, filters only those devices that match the color, page size, and quality intent of the job, and generates several production plans for producing the job.

When you are defining the job type and template pricing, you can set-up parameters for the planner component. These parameters are the output devices and imposition parameters for printing the job type or template. This data will limit the planner component to check for possible production options only among predefined devices and imposition options, otherwise the planner will search all available devices and generate the production plans automatically.

Production Plan

A set of data generated by the planner component that includes imposition constraints and output device selection. In most cases several production plans are generated for each job.

Estimation Model

An algorithm that calculates the price of a job for each specific production plan, based on the calculation model used.

Result Matrix

A pricing table generated by the estimation model for each production plan. Comprises a list of result line items with their quantities, associated cost and price.

Decision Component

An algorithm that chooses the most appropriate production plan from the list of available plans. The decision is made according to the following parameters:

- Cheapest cost, if pricing by press sheets or area, otherwise...
- The first device and press sheet size in the list.

Line Item

A basic pricing unit in the system which is used to calculate all the prices in the system.

A line item includes:

- Pricing units.
- Base cost.
- Cost per number of units.
- Base price.
- Price per number of units.

The pricing units supported by the system, for intent pricing line items, are: copies, sheets, total pages, square inch, and square cm.
In addition the application manages line items for taxes, shipping, etc. These line items have other units, such as per cent (%) and weight.

**Result Line Item**

A line item is generated by the estimation model, when creating the result matrix.

**Line Item Library**

A library for managing all the line items and result line items in the system.

**Tax Package**

A component comprising one or more taxes that need to be applied to a job, an order or a shipping cost. When the tax package comprises more than one tax (for example in US or Canada), the tax package will also include information on how the individual taxes are calculated.

The individual taxes can be limited to geographical areas to accommodate local tax regulations.

**Pricing Process Overview**

The pricing process comprises the following stages:

- **Setup** – you set-up all the data and parameters required for pricing.
- **Job pricing** – the application automatically calculates the price of jobs.
- **Order pricing** – the application automatically calculates the price of orders.
- **Price management** – you view and modify the line items, job and order prices as necessary.

**Setup**

Some of the settings related to pricing are performed during the initial system setup, these items include reference to the appropriate chapter in the user guide.

**Order Pricing Setup**

The following settings have to be performed for the order pricing to function properly:

- Define the system-wide urgency surcharges in Print Settings > Pricing > Business. For additional information, refer to Managing Output Devices on page 36.
- Define all the applicable taxes in Print Settings > Pricing > Tax Library.
- Define the shipping methods’ pricing and tax (if shipping tax is required) in Print Settings > Shipping > Shipping Methods. For additional information, refer to Defining Shipping Methods on page 55.
- Define the tax and discount in Account > Account Setup > Preferences. An account can inherit the system default tax, or you can define an account level tax. For additional information, refer to Modifying Account Preferences on page 71.
Define the urgency and tax for job types that should not inherit the system settings. For additional information, refer to Job Business Flow on page 117.

Define the urgency and tax in templates that should not inherit the settings of the job type. For additional information, refer to Job Business Flow on page 117.

**Job Pricing Setup**

The following settings have to be performed for the job pricing to function properly:

- Define the job type pricing – you can use either intent-based or manual calculation model.
- Define the template pricing – a template can inherit the pricing setup of the job type, or you can define for it specific pricing. This way you can provide different price lists for different accounts, based on your contractual agreements.
- Define an Excel based pricing model for an account (optional).

**Job Pricing**

The job pricing mechanism is activated whenever the Print Buyer is viewing the job summary or clicking Get Quote in the shopping cart.

The job pricing calculation is applied by the system hierarchically, as follows:

- Use job level pricing (manual) if it has been defined, otherwise...
- Use template pricing if it has been defined, otherwise...
- Use Excel pricing if it has been defined for an account, otherwise...
- Use job type pricing if it has been defined, otherwise...
- Price Not Available is displayed.

**Order Pricing**

The order pricing mechanism is activated during the checkout process, after the shipping details are supplied. It calculates the final job price (in case urgency surcharge needs to be applied) and the order price which includes the discount, shipping price and taxes.
Order Tax Hierarchy

The tax calculation is applied hierarchically. The system checks if a tax was specified at the first level, if it was – the tax calculation is performed, if not it checks if a tax was specified at the next level, as follows:

- Use job tax, if it has been defined, otherwise...
- Use template tax, if it has been defined, otherwise...
- Use account tax, if it has been defined, otherwise...
- Use job type tax, if it has been defined, otherwise...
- Use system tax.

Price Management

Price management is performed in several places:

- In the job tracking area you can view and modify the pricing data of jobs and orders (based on job status limitations).
- In the line items library you can view and modify the line items and result line items.
- In the production queue you can view and modify the pricing data of jobs.
**Setup**

The following section provides information on how to set-up taxes and job pricing.

**Set-up Tax Packages**

In order to be able to assign taxes to specific objects such as job types, templates or accounts, you first need to create tax packages. In many cases you would need only one tax package, containing a single tax.

This section provides a tax overview and describes how to create:

- A single-tax package
- A multiple-tax package
- An area-independent tax
- An area-dependent tax

**Area-dependent Taxes**

You can define area-dependent taxes. There are two area dependency options:

- Dependent on Delivery Address is appropriate for situations when the tax is related to the shipping destination of an order.
- In some countries the tax is related to the primary business location of the Print Buyer, in which case Dependent on Billing Address should be selected.

The same area definition rules apply to both area-dependent taxes.

**Multiple Tax Calculation**

Usually when multiple taxes are applied to a product, each tax is calculated on the base product price and then added to the total.

Example:

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product selling price</td>
<td>$100.00</td>
</tr>
<tr>
<td>Tax A</td>
<td>5%</td>
</tr>
<tr>
<td>Tax B</td>
<td>10%</td>
</tr>
<tr>
<td>Total Price</td>
<td></td>
</tr>
</tbody>
</table>

Sometimes the tax regulations require to apply one tax on top of the sub-total of the product selling price plus another tax. For example in the Quebec and Prince Edward Island provinces of Canada, the PST (Provincial Sale Tax) is charged based on the total of the selling price plus GST (Goods and Services Tax).

Example:

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product selling price</td>
<td>$100.00</td>
</tr>
<tr>
<td>Tax GST</td>
<td>5%</td>
</tr>
<tr>
<td>Sub-total</td>
<td></td>
</tr>
<tr>
<td>PST</td>
<td>10%</td>
</tr>
<tr>
<td>Total Price</td>
<td></td>
</tr>
</tbody>
</table>
Managing the Tax Packages

Use the tax packages library to create, edit and delete tax packages.

Creating a Single-tax Package

1. Select Print Settings > Pricing > Tax Library; the tax packages library appears.
2. Click New in the Tax Package list on the left; a new tax package is added to the list.
3. Type the tax package name and description.
4. Click Save; the tax package name is updated in the list on the left.
5. Click Add Tax; the Tax Library dialog box appears. You can choose an existing tax from the library or create a new one:
   - To create a new tax refer to the Creating a Simple Tax task or Creating an Area-dependent Tax task.
   - To add an existing tax select a tax name from the list and click Add.
6. Click Save.

Creating a Multiple-tax Package

1. Select Print Settings > Pricing > Tax Library; the Tax Library appears.
2. Click New in the Tax Package list on the left; a new tax package is added to the list.
3. Type the tax package name and description.
4. Click Save; the tax package name is updated in the list on the left.
5. Click Add Tax; the Tax Library dialog box appears. You can choose an existing tax from the library or create a new one:
   - To create a new tax refer to the Creating a Simple Tax task or Creating an Area-dependent Tax task.
   - To add an existing tax select a tax name from the list and click Add.
6. Add more taxes.
7. If the sequence of applying the taxes is important, use the buttons (move up and move down), to change the sequence of the taxes.
8. If there is a need to include one or more of the first taxes in the subtotal on top of which the next tax is calculated, select the Include in sub total checkbox for these taxes.
9. Click Save.
Setting a Default Tax Package

Every customer account and job type automatically uses the default tax package, unless you select a different tax package.

1. Select Print Settings > Pricing > Tax Library; the tax packages library appears.
2. Select a tax package from the list on the left.
3. Click Set as Default; the selected package is marked as System Default.

Duplicating a Tax Package

Duplicating a tax package is a fast way to create a new package that is similar in some aspects to an existing one.

1. Select Print Settings > Pricing > Tax Library; the tax packages library appears.
2. Select a tax package from the list on the left.
3. Click (duplicate); a copy of the selected package is created and added to the list.

Deleting a Tax Package

Duplicating a tax package is a fast way to create a new package that is similar in some aspects to an existing one.

1. Select Print Settings > Pricing > Tax Library; the tax packages library appears.
2. Select a tax package from the list on the left.
3. Click (delete); a confirmation message is displayed.
4. Click Yes; the tax package is deleted.
Managing Taxes

Creating a Simple Tax

1. Select a tax package or create a new one and click Add Tax to open the Tax Library dialog box.
2. Click New in the Tax Library dialog box; a New Tax dialog box appears.
3. Type the tax name and description.
4. Type the tax percentage.
5. Leave the No Area Dependency radio button selected.
6. Click OK; the dialog box is closed and the tax is added to the package you created.

Creating an Area-dependent Tax

1. Select a tax package or create a new one and click Add Tax to open the Tax Library dialog box.
2. Click New in the Tax Library; a New Tax dialog box appears.
3. Type the tax name and description.
4. Type the tax percentage.
5. Select the Dependent on Delivery Address radio button.
6. Select the Effective Inside option for the created tax to be applied to all the delivery addresses inside the defined area, or Effective Outside for the created tax to be applied to all the delivery addresses outside the defined area.
   a. Select the country name.
   b. Type a list of specific zip codes identifying the area, or a range of zip codes.
7. Click OK; the dialog box is closed and the tax is added to the package you created.
Removing a Tax from a Package

1. Select a tax package.
2. Select a tax in the package.
3. Click Remove; a confirmation message appears.
4. Click Yes; the tax is removed from the list.

Editing a Tax

1. Select a tax package.
2. Select a tax in the package.
3. Click Edit Tax; a confirmation message appears.
4. Click Yes; the Edit Tax dialog box opens.
5. Modify the tax as required.
6. Click OK; the dialog box closes.

Deleting a Tax

1. Select a tax package.
2. Click Add Tax; the Tax Library dialog box opens.
3. Select a tax from the list.
4. Click Delete; a confirmation dialog box opens.
Pricing

Click Yes; the tax is deleted from the library and from all the tax packages containing it.

Click Cancel; the dialog box closes.

Duplicating a Tax
1 Select a tax package.
2 Click Add Tax; the Tax Library dialog box opens.
3 Select a tax from the list.
4 Click Duplicate; a duplicate of the tax is created.
5 Click Cancel; the dialog box closes.

Set-up Job Type Pricing
This section provides information on the following subjects:
- Setting-up intent-based pricing for a job type or template.
- Setting-up manual pricing for a job type or template.

Selecting a Job Type
1 Select Print Settings > Job Business Flow > Job Type Library; the Job Type Library appears.
2 In the Job Type Library, select a job type.
3 Click Edit; the job type editing opens with the General Properties tab selected.
4 When you are done, click Back to Job Type Library / Back to Template Library.

Selecting a Template
1 Select Accounts > Store Setup > Templates; the Templates repository appears.
2 Select an account and a template.
3 Click Edit Properties; the template editing opens with the General Properties tab selected.

Setting-up Intent Pricing
1 Select the Settings tab; the Settings tab appears with the Quantity tab selected.
2 Select the Pricing tab; the Pricing tab appears.
3 Select Intent Pricing in the Calculation Model list; the system creates an empty price list (line item) for every single intent option of the job type.
Define production parameters

a Define quantity ranges:
   i If you want to define different production parameters for different quantity ranges (for example a
digital device for short runs and an offset device for long runs), click Add Quantity; another
quantity range is added to the Planner area.
   ii Type the values in the From and To fields.

b Connect a device to a quantity range:
   i In the Planner section, click Choose Device(s); the Device and Imposition dialog box opens.
   ii Select the output device, press sheet size and imposition parameters.
   iii Click OK to save the changes and close the dialog box.
   iv Click Add Device to add more device options to this range.

Figure 44: Planner with Multiple Quantities

Create a price list for the base product:

a Select the Enabled checkbox; the line item information to its right becomes enabled.

b Select the type of units for pricing (copies is the most common option).

c Add quantity ranges:
   i If you want to define different prices for different quantity ranges (the price per unit goes down
when larger quantities are ordered), click New Range; another quantity range is added to the
Planner area.
   ii Type the values in the From and To fields.

d Define the pricing for each quantity range:
   i Type the fixed cost for the base product.
   ii Type the variable cost and the number of units to which it applies.
   iii Type the fixed price for the base product.
   iv Type the variable price for the number of units indicated above.

e Click Save; the line item is saved in the line item library and the line item number is updated.
Pricing

Figure 45: Product Base Price with Ranges

6 Define price lists for each intent option that you want to price:
   
   a Click + to expand the option.
   
   b Repeat all the sub-steps of Step 5 above.

You have finished setting-up intent-based pricing.

Intent Pricing Examples

To clarify the use of intent pricing, let’s look at some examples.

Postcards Job Type

You want to offer postcard printing:

- Page Size: 8.5”x5.5” (default); 5”x7”
- Colors: Full color (default); Black & white
- Paper: 14 pt. Gloss Cover (default); 14 pt. Matte Cover
- Number of Pages: 2
- Folding: no folding (default); simple fold

Pricing considerations:

- There is no base price for the product.
- Page size does not affect pricing, the price for both sizes of postcards is the same.
- Full color printing is the base price for color postcards.
- Black & white printing is the base price for black & white postcards.
- Paper price is included in the base price.
- No folding is included in the base price.
- Simple fold has an additional pricing.
### Table 18: Base Price

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Fixed</th>
<th>Variable</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Price – disabled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Size, 8.5” x 5.5” – disabled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Size, 7” x 5” – disabled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Colors, Full color</td>
<td></td>
<td>Copies</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1000</td>
<td>Cost: $3</td>
<td>Cost: $20</td>
<td>per 100</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price: $15</td>
<td>Price: $50</td>
<td></td>
</tr>
<tr>
<td>1001</td>
<td>10000</td>
<td>Cost: $3</td>
<td>Cost: $20</td>
<td>per 100</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price: $10</td>
<td>Price: $40</td>
<td></td>
</tr>
<tr>
<td>Colors, Black &amp; white</td>
<td></td>
<td>Copies</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1000</td>
<td>Cost: $3</td>
<td>Cost: $10</td>
<td>per 100</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price: $10</td>
<td>Price: $30</td>
<td></td>
</tr>
<tr>
<td>1001</td>
<td>10000</td>
<td>Cost: $3</td>
<td>Cost: $10</td>
<td>per 100</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price: $5</td>
<td>Price: $20</td>
<td></td>
</tr>
<tr>
<td>Paper, 14 pt. Gloss Cover – disabled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper, 14 pt. Matte Cover – disabled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Folding, no folding – disabled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Folding, Simple fold</td>
<td></td>
<td>Copies</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Infinity</td>
<td>Cost: $10</td>
<td>Cost: $5</td>
<td>per 100</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price: $20</td>
<td>Price: $8</td>
<td></td>
</tr>
</tbody>
</table>

### Document Duplication Job Type

You want to offer document duplication:

- Page Size: 8.5”x11” (default); Legal
- Colors: Black & white (default); Full color
- Paper: 100# Hi-gloss coated stock (default); 100# uncoated text stock
- Number of Pages: 1-200
- Binding: corner stapling (default); binder; spiral binding; thermal binding
Pricing considerations:

- There is no base price for the product.
- Page size does not affect pricing.
- Full color printing is the base price for color documents, the pricing unit is clicks.
- Black & white printing is the base price for black & white documents, the pricing unit is clicks.
- Paper price is calculated separately.
- Corner stapling is included in the base price.
- Binder, spiral binding, and thermal binding are calculated separately per copy.

### Table 19: Base Price

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Fixed</th>
<th>Variable</th>
<th>Unit: Copies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Price – disabled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Size, 8.5” x 5.5” – disabled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Size, 7” x 5” – disabled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Colors, Full color</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Infinity</td>
<td>Cost: $0</td>
<td>Cost: $0.05</td>
<td>per 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price: $10</td>
<td>Price: $0.15</td>
<td></td>
</tr>
<tr>
<td>Colors, Black &amp; white</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Infinity</td>
<td>Cost: $0</td>
<td>Cost: $0.015</td>
<td>per 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price: $5</td>
<td>Price: $0.10</td>
<td></td>
</tr>
<tr>
<td>Paper, 100# Hi-gloss coated stock</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Infinity</td>
<td>Cost: $1</td>
<td>Cost: $0.05</td>
<td>per 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price: $5</td>
<td>Price: $0.08</td>
<td></td>
</tr>
<tr>
<td>Paper, 100# uncoated text stock</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Infinity</td>
<td>Cost: $1</td>
<td>Cost: $0.04</td>
<td>per 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price: $5</td>
<td>Price: $0.07</td>
<td></td>
</tr>
<tr>
<td>Binding, corner stapling – disabled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Binding, spiral binding</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>100</td>
<td>Cost: $4</td>
<td>Cost: $5</td>
<td>per 10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price: $10</td>
<td>Price: $8</td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>Infinity</td>
<td>Cost: $3</td>
<td>Cost: $4</td>
<td>per 10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price: $5</td>
<td>Price: $7</td>
<td></td>
</tr>
</tbody>
</table>
Setting-up Manual Pricing

Manual pricing comprises two steps – setting-up a job type or template to be manually priced, and then the actual pricing of a job.

1. Select the **Settings** tab; the **Settings** tab appears with the **Quantity** tab selected.
2. Select the **Pricing** tab; the **Pricing** tab appears.
3. Select **Manual** in the **Calculation Model** list.
4. Define production parameters as specified in Step 4 of the intent pricing procedure.
5. Click **Save**.

When a job will be ordered based on this job type or template, the user will receive a ‘price not available’ notification.

### Table 19: Base Price

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Fixed</th>
<th>Variable</th>
<th>Unit: Copies</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Copies</td>
</tr>
<tr>
<td>Binding, binder</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>100</td>
<td>Cost: $10</td>
<td>Cost:$0.92</td>
<td>per 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price:$20</td>
<td>Price:$2</td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>Infinity</td>
<td>Cost: $7.50</td>
<td>Cost:$0.85</td>
<td>per 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Price:$15</td>
<td>Price:$1.5</td>
<td></td>
</tr>
</tbody>
</table>

| Binding, thermal binding | Copies | |
|--------------------------|--------|
| 1                        | 100    |
| Cost: $2                | Cost:$3 | per 10 |
| Price:$5                | Price:$6 |
| 101                      | Infinity |
| Cost: $2                | Cost:$2 | per 10 |
| Price:$4                | Price:$5 |
Price Management

This section provides detailed instructions on the following subjects:

- Manually Pricing a Job
- Checking and Modifying Job Pricing
- Checking and Modifying Order Pricing

Manually Pricing a Job

1. Select Tasks > Track Jobs; the Track Jobs is displayed with the Search option selected.

2. Find the required job using the Search or by selecting the appropriate queue.

3. Select the job and click Job Pricing; the Job Pricing dialog box opens.

Figure 46: Manual Job Pricing

4. Type the Cost (if required) and Price of the job.

5. You might need to add line items to the base price:
   a. Click Add Item; the Select Line Item dialog box is displayed.
   b. Find the required line item or create a new one. For more information about creating line items, refer to Creating a New Line Item, Step 2 on page 196.
   c. Click Add; the dialog box closes and the line item is added to the job pricing result matrix.
   d. Type the quantity for the added line item.
   e. Click anywhere outside the Quantity box; the price is recalculated.

6. Click Close; the dialog box closes.

You have finished manually pricing the job.
Checking and Modifying Job Pricing

1. Select Tasks > Track Jobs; the Search screen appears.
2. Find the required job using the Search or by selecting the appropriate queue.
3. Select the job and click Job Pricing; the Job Pricing dialog box opens.
4. Check the result matrix.

Figure 47: Job Pricing for Intent-priced Job

5. Changing a line item, if required:
   a. Click the number link for the line item that has to be changed; the Edit Line Item dialog box opens.
   b. Modify the line item as needed. For more information about creating line items, refer to Editing JBF Option, Design and Custom Line Items on page 196.
   c. Click Save; the dialog box closes and the line item is updated.
6. You might need to add line items to the base price. For more information about adding a line item, refer to Editing JBF Option, Design and Custom Line Items on page 196.
7. Click Close; the dialog box closes and the data is saved.

Checking and Modifying Order Pricing

1. Select Tasks > Track Jobs; the Search screen appears.
2. Find the required job using the Search or by selecting the appropriate queue.
3. Select the job and click Order Pricing; the Order Pricing dialog box opens.
4. Check the result matrix.
5 Change a line item, if required:
   a Click the number link for the line item that has to be changed; the **Edit Line Item** dialog box opens.
   b Modify the line item as needed. For more information about adding a line item, refer to **Editing JBF Option, Design and Custom Line Items** on page 196.
   c Click **Save**; the dialog box closes and the line item is updated.

6 You might need to add line items to the base price. For more information about adding a line item, refer to **Editing JBF Option, Design and Custom Line Items** on page 196.

7 Click **Close**; the dialog box closes and the data is saved.
Line Item Library

The line item library stores all of the line items in the system. Working directly in the line item library is, therefore, very efficient and convenient. It is, however, also very risky, as you might, by accident, change the wrong line item, or change the right line item, but not realize the full extent of the resulting effect. Be sure you are well familiar with the line item library and the objects it affects, before you make modifications.

Types of Line Items

There are line items of several types, each with its particular characteristics.

Setup Line Items

Some of the line items are generated as part of the system and pricing setup process.

- **JBF Option** – a JBF Option line item is created for each intent pricing option of a job type or template pricing.
- **Tax** – a tax line item is created for each tax in the application.
- **Discount** – a discount line item is created for each account in the application.
- **Urgency** – two urgency line items are created for the system level setting, and for each job type and template that have specific urgency settings.
- **Delivery** – a delivery line item is created for every shipping method in the application.
- **Custom** – line items that you create for pricing additional services that are not intent related. For example, spelling.
- **Design** – line items that you create for additional design services, such as designer time or proofs.

Result Line Items

- **Calculated Job** – a calculated job line item is created for each job in the system.
- **Set Job** – the Set job line item is created for every Set job ordered.
- **Excel Price** – an Excel line item is created for every job that is priced using Excel.
- **Manual Price** – the Manual Price line item has no pricing data - it returns a Price N/A for every manually priced job.

Managing the Line Item Library

To access the line item library select Print Settings > Pricing > Line Items menu.
Searching for a Line Item

You can search for line items by type and criteria.

1. Select line item **Type** if you want to search for line items of a specific type only.
2. Select the search criteria from the list.
3. Select the comparison operator.
4. Type the textual criterion in the text box.
5. Click **Search**; the system performs the search and shows the result in the list.
6. To reset the library to the full list:
   a. Select **All** in the **Type** list, **Line item #** and **All** in the comparison operator list.
   b. Click **Search**; the full list is displayed.

Creating a New Line Item

You can create line items of custom, design, and discount types.

1. Click **Create New Line Item**; the **Edit Line Item** dialog box opens.
2. To create a custom or design line item, select Custom or Design in the type list. For more information about editing line items, refer to Editing JBF Option, Design and Custom Line Items on page 196.
3. To create a discount line item, select **Discount** from the **Type** list; the dialog box display is refreshed and changed. For more information about editing discount line items, refer to Editing Discount Line Items on page 197.
4. Click **Save**; the line item is created and the dialog box closed.

Editing Line Items

Editing line items differs according to the type of line item. The following instructions are provided per line item type.

Editing JBF Option, Design and Custom Line Items

1. Find the line item to be changed and click **Edit**; the **Edit Line Item** dialog box opens.
2. Select the units from the **Unit** list.
3. Add quantity ranges:
   a. If you want to define different prices for different quantity ranges (the price per unit goes down when larger quantities are ordered), click **New Range**; another quantity range is added to the **Planner** area.
   b. Type the values in the **From** and **To** fields.
4 Define the pricing for each quantity range:
   a Type the fixed cost for the base product.
   b Type the variable cost and the number of units to which it applies.
   c If you want to use markup for the price calculation, select the Use markup check box and type the percent; the price is automatically updated.
   d If you didn’t use markup, type the fixed and variable price for the base product.

5 Click Save; the line item is saved and the dialog box closed.

**Figure 49: JBF Option Line Item**

**Line Item**

```
<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Fixed</th>
<th>Variable</th>
<th>Units</th>
<th>Copies</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>€50.00</td>
<td>€10.00</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Infinity</td>
<td>€60.00</td>
<td>€12.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**Editing Tax Line Items**

1 Find the line item to be changed and click Edit.
2 Modify the tax description and level, if required.
3 Click Save; the line item is saved and the dialog box closed.

**Editing Discount Line Items**

1 Find the line item to be changed and click Edit.
2 Modify the discount description and level, if required.
3 Click Save; the line item is saved and the dialog box closed.

**Editing Urgency Line Items**

1 Find the line item to be changed and click Edit.
2 Modify the line item description and level, if required.
3 Click Save; the line item is saved and the dialog box closed.
Remember that if you are changing the system level urgency line items, the change will affect all the job types and templates that inherit these settings from the system.

System level urgency settings are called ‘Express Delivery Surcharge’ and ‘Urgent Delivery Surcharge’, as opposed to specific job type or template line items that have names like ‘Express Surcharge for Poster’.

Editing Delivery Line Items
Delivery type line items are associated with Fedex, US Postal Service, UPS and direct mailing line item types.

1. Find the line item to be changed and click **Edit**.
2. Modify the line item data. For more information about editing shipping method pricing, refer to Defining Shipping Methods on page 55.
3. Click **Save**; the line item is saved and the dialog box closed.

Editing Calculated Job Line Items

1. Find the line item to be changed and click **Edit**.
2. To view the result matrix related to this job, click the **Detailed Pricing** link; the **Job Pricing** dialog box opens.
   a. For more information about this screen, refer to Checking and Modifying Job Pricing on page 193.
   b. Click **Close**.
3. Click **Save**; the line item is saved and the dialog box closed.
This chapter describes how to create and edit FreeFlow Web Services skins. You can use the Site Customization branding functionality to personalize the general web site layout, in addition to the look and feel of specific items.

Skin Structure

A branding skin comprises several components that define the look and feel of the launch pad, the login page, the site frame containing a top bar and a left bar, and banners for emails and catalogs. You have to define each component separately. In addition, Web Services supports several levels of Print Buyer user privileges. It is possible to use the same site frame for the different user types, or to create a different site frame look and feel for the different privileges.

Types of Controls

The branding feature identifies buttons and links, Print Buyer logos, and tabs. Clicking a button or a link changes the Web Services page content or opens a new dialog box. A matching control must be assigned to each of the buttons in order to keep the full functionality of the application.

This chapter includes the following sections:

- Creating Skins
- Editing Skin Elements
- Uploading Designs
- Activating Page Elements
- Managing the Skin Library

All settings described in this chapter define Site Customization settings at the default level (true for all Print Buyers in your Web Services system). However, you can adjust the settings per account. For more information about defining Site Customization settings at the Account level, refer to Defining Account Branding on page 79.
Creating Skins

You can customize and personalize the general web site layout, in addition to the look and feel of specific items with a skin. You achieve this by uploading designs and images, and adding text to the launch pad and the various frames and banners on the system site.

This section describes the following procedures:

- Accessing The Skin Editor
- Customizing the Login Page
- Customizing the Site Frame
- Customizing the Launch Pad
- Customizing the Email Banner
- Customizing the Catalog Banner
- Saving and Previewing Views

Accessing The Skin Editor

You can customize and edit Site Customization skins in the Skin Editor. To access the Skin Editor, select Store Assets > Skins; the Skin Library appears; select a skin and click Skin Editor; the Skin Editor window appears.

Customizing the Login Page

Your Print Buyers use the login page to log in to the Web Services application. You use the Site Customization Login Page window to brand a login page. Before customizing the login page, you must have a login page HTML design (*.mht format) with the following pre-requisites:

- Two text boxes (for the User name and the Password).
- An image for the login button.

It is recommended that you have HTML files initially designed by an HTML designer with an understanding of your Web Services application requirements.

To customize the login page:

1. In the Skin Editor, click Login Page; the login page appears with the Edit tab selected.
2. Click the Upload Login HTML link; a confirmation window appears.
3. Click Yes; the File Upload window appears.
4. Browse to the especially pre-designed login page .mht file to upload, and click Next; the design appears in the login page. For information on uploading designs, refer to Uploading Designs on page 208.
5. Save and preview the login page. For information about saving and previewing, refer to Saving and Previewing Views on page 204.
6. Activate the login page elements. For more information about activating elements, refer to Activating Page Elements on page 209.
Customizing the Site Frame

You can use the Site Frame tab to customize the top and left bars of the application and to define user privileges. The contents of site frame, composed of top and left frames and a main application frame, determine the look and feel of the main application window.

You must have an HTML design (*.mht format) to customize the top bar and left bar.

- The top bar HTML design must contain a top bar with a table of four cells.
- The left bar HTML design must contain a table of seven cells (aligned vertically).

It is possible to have the sub menu of seven cells moved to the top bar, but the main menu cannot be moved to the left.

To customize the Site Frame:

1. In the Skin Editor, click Site Frame; the Site Frame window appears, reflecting the Admin view.
2. Click the Upload Top Bar link.
3. Click Yes in the confirmation windows; the Top Bar: File Upload window appears.
4. Complete the File Upload instructions, browse to the target top bar file and click Next; the top bar appears in the Site Frame window.
5. Click the Upload Left Bar link.
6. Click Yes in the confirmation windows; the File Upload window appears.
7. Complete the Left Bar: File Upload instructions, browse to the target left bar file and click Next; the left bar appears in the Site Frame window.
8. Save and preview the site frame. For information about saving and previewing, refer to Saving and Previewing Views on page 204.
9. Activate elements in the site frame top and left bars. For information about activating the site frame top and left bars, refer to Activating Page Elements on page 209.

For information on defining user privileges, refer to Defining User Privilege Views on page 212.
Customizing the Launch Pad

Depending on the system preference settings, the starting point for initiating a job order can be the launch pad. You can use the Launch Pad view to apply your branding to the launch pad. Alternatively, you may prefer to have the Web Services default launch pad appear.

To use the default Web Services Launch Pad:

1. In the Skin Editor, click Launch Pad; the Launch Pad view appears with the Edit tab selected.
2. Select the Preserve the Default Launch Pad Look check box, located at the base of the Launch Pad view.
3. Click OK.

To customize the Launch Pad:

1. In the Skin Editor, click Launch Pad; the Launch Pad view appears with the Edit tab selected.
2. Click the Upload Launch Pad HTML link; the confirmation window appears.
3. Click Yes; the File Upload window appears.
4. Browse to the pre-designed launch pad .mht file to upload, and click Next; the design appears in the launch pad. For information on uploading designs, refer to Uploading Designs on page 208.
5. Save and preview the launch pad. For more information about saving and previewing, refer to Saving and Previewing Views on page 204.

You can edit the final design after saving and previewing your launch pad. For more information about design editing, refer to Editing the Final Design on page 207.

6. Activate the launch pad elements. For more information about activating elements, refer to Activating Page Elements on page 209.
Customizing the Email Banner

You can use the Email Banner window to customize the banner of email messages generated and sent through the Web Services system. For more information about email messages sent throughout the Web Services system, refer to Defining Email Notification Settings on page 86.

To customize the Email Banner:

1. In the Skin Editor, click Email Banner; the Email Banner window appears with the Edit tab selected.
2. Click the Upload EMail Banner HTML link; the confirmation window appears.
3. Click Yes; the File Upload window appears.
4. Browse to the especially pre-designed Email Banner .mht file to upload and click Next; the design appears in the Email Banner window. For information on uploading designs, refer to Uploading Designs on page 208.
5. Save and preview the Email Banner. For information about saving and previewing, refer to Saving and Previewing Views on page 204.

You can edit the final design after saving and previewing the email banner. For information about editing the design, refer to Editing the Final Design on page 207.

6. Activate the Email Banner window elements. For information about activating elements, refer to Activating Page Elements on page 209.
Customizing the Catalog Banner

You can use the Catalog Banner window to customize the banner of HTML catalogs. For information about HTML catalogs in the Web Services system, refer to Setting the Account Job-ordering Windows on page 78.

To customize the Catalog Banner:

1. In the Skin Editor, click Catalog Banner; the catalog banner page appears with the Edit tab selected.
2. Click the Upload Catalog Banner HTML link; the confirmation window appears.
3. Click Yes; the File Upload window appears.
4. Browse to the especially pre-designed catalog banner .mht file to upload and click Next; the design appears in the catalog banner page. For information on uploading designs, refer to Uploading Designs on page 208.
5. Save and preview the catalog banner. For information about saving and previewing, refer to Saving and Previewing Views.

6. Activate the catalog banner elements. For information about activating elements, refer to Activating Page Elements on page 214.

Saving and Previewing Views

The Save and Preview tab displays a preview of the current skin item without grid lines. Toggle between the two views by clicking the tabs located at the base of the Skin Editor.

To save and preview views, click the Save and Preview tab; changes are saved and a preview appears.

- Images missing from a preview are indicated by .
- Buttons are inactive on the Save and Preview tab.
Editing Skin Elements

This section describes editing skin elements, and the following procedures:

- Uploading Images
- Editing the Final Design

You can edit the following skin elements using the Style Sheet window:

- Color Palette – Edit the window colors.
- Buttons – Replace the standard application buttons with customized images.
- Fonts – Edit font type, style, size and color.

Accessing the Style Sheet Window

To access the Style Sheet window, select a skin in the Skin Library and select Skin Editor > Style Sheet; the Style Sheet window appears.

All Privilege levels use the Style Sheet.

To edit a window color:

1. In the Style Sheet window, click a color palette element; the Color Selection dialog box appears.
2. Select a color or type an RGB number; the new color appears in the Selected Color field.
3. Click OK; the new color appears on the Color Palette sub-panel.
4. Repeat Steps 1 through 3 to edit the color of other elements.

When using the RGB Editor, numbers cannot exceed 255.

To edit a button:

1. Ensure the button image to be used (other than the existing button images) is uploaded to the Images folder. For information about uploading images, refer to Uploading Images on page 206.
2. In the Style Sheet window, click a Button element; the Image Folder dialog box appears showing the button name selected in the Name list, and the current button image displayed on the Image pane.
3. Click the new image name and then click Select Image; the new image appears on the Buttons sub-panel.
Managing Site Customization Skins

To edit a font:

1. In the Style Sheet window, click a font element; the Fonts dialog box appears.
2. Click a font type and style, and type a size.
3. Click OK.

To edit font colors:

1. In the Style Sheet window, click a font element; the Fonts dialog box appears.
2. Click the Color field; the Color Selection dialog box appears.
3. Click a color or type an RGB number; the new color appears in the Selected Color field.
4. Click OK; the new color appears on the Color Palette sub-panel.
5. Click OK.

Uploading Images

After designs are uploaded, approved and activated, you can change button, link, and logo images to suit evolving branding and functional requirements.

Acceptable image file formats include:

- JPEG, JPG
- PDF
- GIF

To upload or change an image:

1. In the Skin Editor, place the cursor where you want to insert the image.
2. Click Image Library; the Image Folder appears.
3. Select the image and click Select Image; the new image appears.
Editing Skin Elements

Editing the Final Design

After skins are uploaded, approved, and activated, you can edit the final design in the **Skin Editor**.

**To reposition objects:**

1. In the **Skin Editor**, click the object to reposition.
2. Drag and drop it to the new location.

**To resize objects:**

1. In the **Skin Editor**, click the object to resize.
2. Drag the anchor points to the new location.

**To add text:**

1. In the **Skin Editor**, click the area where text is to appear.
2. Type the text.

**To edit text:**

1. In the **Skin Editor**, select the text to edit.
2. Edit the text. Text editing tools are located on the toolbar.

![Save and preview your work by clicking the Save and Preview tab.](image)
Uploading Designs

Before uploading a design, you must have a login page HTML design (*.mht format) for each of the pages to be customized.

It is recommended that you have HTML files initially designed by an HTML designer with an understanding of your Web Services application requirements.

Initial application designs first appear as gray background (default) to serve as reference data for what is being replaced, which you can select and temporarily delete. The gray background disappears permanently after you upload an HTML file (*.mht format).

The varying dimensions for uploading Site Customization skin files are outlined below in Table 20:

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Width</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Page</td>
<td>1000px</td>
<td>700px</td>
</tr>
<tr>
<td>Site Frame</td>
<td>Left bar - 200px</td>
<td>Left bar - 500px</td>
</tr>
<tr>
<td></td>
<td>Top bar - 1000px</td>
<td>Top bar - 100px</td>
</tr>
<tr>
<td>Launch Pad</td>
<td>1000px</td>
<td>700px</td>
</tr>
<tr>
<td>Email Banner</td>
<td>1000px</td>
<td>unlimited</td>
</tr>
<tr>
<td>Catalog Banner</td>
<td>1000px</td>
<td>100px</td>
</tr>
</tbody>
</table>

Converting HTML Pages to .mht Files

You must convert the HTML page to a web archive (*.mht) file when uploading designs.

**To convert an HTML page to an .mht file:**

1. Open the web page in Microsoft Internet Explorer.
2. Select **File > Save As**; the **Save As** window appears.
3. In the **Save as type** dropdown list, select **Web Archive, single file (*.mht)**.
4. Click **Save**.
Activating Page Elements

After you upload an .mht file, the associated page elements, such as links and buttons, remain inactive. In other words, they remain static and provide no functionality until they are ‘activated’, giving them functionality. Therefore, to activate those elements, you assign an action for each item.

Tabs are functionally very similar to buttons. There are tab controls in Track Jobs, Manage Templates and My Manage Account pages. You use these tabs to control the content of the window.

The main difference in behavior between the tabs and the buttons is that the tabs have two modes - a selected mode and an unselected mode. Activating tabs in the same way that buttons are activated makes skin creation very cumbersome. For this reason tabs are treated differently. A generic table is defined in the HTML page. This table can have 1 column with 4 rows, or 1 row with 4 columns. Having a total of 4 cells provides for all the possible tab controls. You then define the color of the selected and unselected tab and the font and color of the tab caption. From there the Branding feature takes the specifications for generating the various tabs in the various application environments.

Use the Activation window to activate buttons (links) and fields, such as on the login page, where you have a User and a Password field. Other pages have different items to activate.

This section describes activating page elements, and the following procedures:

- Selecting Languages
- Specifying First Page After Login
- Defining User Privilege Views

To activate page elements:

1. In the Skin Editor, click ; the Activation window appears. The window is divided into the following three panes:
   - Left pane – Lists the activated objects (images or text).
   - Center pane – Displays the Editor instructions.
   - Right pane – Lists the required and optional buttons for activation.

   When you select a left pane list object, the corresponding object in the design is automatically selected, visually linking the listed object and the design object.

2. Select an object in the Skin Editor window and click Add in the Activation window left pane (or double-click the object); a newly activated object appears in the left pane list.

3. Type the default name.

4. In the center pane, click the Element Type dropdown list, and select the required element type; the right pane automatically updates to reflect the selection made.
Managing Site Customization Skins

The right pane includes two activation lists: ‘Recommended’ and ‘Optional’. After clicking OK or Save and Preview, an alert message appears if you neglected to activate all the recommended list items.

To activate tabs in the Top and Left Bars:

1. In the Activation window, in the Element Type dropdown list, select Tab-Main Menu or Tab-Sub Menu.
2. For Unselected Mode and Selected Mode, define the fonts, text alignment, and background color.

If you select the Always show background option, the top and left bar background design elements, including any inactive buttons and images, remain visible for all users—regardless of their user privilege level—in all views.

3. In the Tabs Alignment list, select a valid tab alignment option. See the options in the table below:

<table>
<thead>
<tr>
<th>Both bars</th>
<th>Top bar</th>
<th>Left bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit To Width</td>
<td>Right</td>
<td>Top</td>
</tr>
<tr>
<td>Center</td>
<td>Left</td>
<td>Bottom</td>
</tr>
</tbody>
</table>

4. Click OK.
Selecting Languages

You can define the language selection function, which appears in the login page. Language selection enables your users a selection of languages to view your site in.

- Language Selection functionality is optional; if you leave the Language Selection undefined, the default language remains that of the Print Service Provider.
- Verify that language icons exist in the uploaded login page HTML design to enable Language Selection.

To activate Language Selection buttons:

1. In the Skin Editor, select a predefined language icon.
2. Click ; the Activation window appears.
3. Click the Add button, and in the Element Type dropdown list, select Button/Link.
4. In the Activated Function dropdown list, choose Select Language.
5. In the Language dropdown list, select the language you want.
6. Repeat Steps 2 through 4 for each additional language selection button.
7. Click OK to confirm the activation and close the Activation window.
8. Click OK to close the Skin Editor; the Language Selection buttons are activated.

Specifying First Page After Login

You can specify the default page that users arrive at after logging in, according to their user privilege level. It is recommended that such default page settings are decided on together with your Print Buyers. You can use the Default Page tool, located on the site frame, to specify the first page after login for each privilege level. The default page can be any one of the Web Services internal pages, or an external page.

To define an alternative Default page:

1. In the Skin Editor, click Default Page and in the Default Page dialog box, choose Use External URL or Use Internal Page.
   - If you choose Use External URL, type the target URL in the field.
   - If you choose Use Internal Page, select the target internal page from the dropdown list.
2. Click OK.
3. Save and preview the page. For information about saving and previewing, refer to Saving and Previewing Views on page 204.
Defining User Privilege Views

Web Services operators authorized with Administrator user type have complete operational control. The Administrator view is the primary base design upon which a designer uses to create other user views. The branding applied to the Administrator window is automatically applied to the views displayed to the other user types.

For more information about defining system users, refer to Defining Print Service Provider Users on page 26.

Defining and Editing for the Various User Types

You can use the Edit Privilege bar to define the seven different views of the Web Services application. The Edit Privilege windows are designed with the same layout, with the exception of different instructions in the instruction pane.

To define views for various user types:

1. In the Skin Editor, click Site Frame and the required Edit Privilege tab.
2. Select one of the following option buttons:
   - Inherit From Administrator – determines that the site frame is based on the user type design.
   - Customized for this Privilege Level – determines that the site frame is based on the user type design and the user has the ability to customize the design.

After the Administrator design is completed, it is advisable to edit the screens according to user abilities (as defined in System Setup > Advanced > User Types).

Example edit: Remove the button accessing software downloads for the User screen. You will need to upload the edited .mht file to the customized user privilege skin again.
Managing the Skin Library

This section describes managing the Skin Library, and the following procedures:

- Assigning Skins to Print Buyers
- Designating a Default Skin

Use the Site Customization Skin Library to manage your system skins. Designers can create, edit, or delete skins, as well as rename and define the default skin.

Accessing the Skin Library

To access the Skins Library; select Store Assets > Skins; the Skin Library appears.

To begin creating a skin:

1. In the Skin Library, click New Skin and type a unique name in the Enter New Name field.
2. Click OK; the new skin name appears in the Skins list.

You can now upload and assign design(s) and images to the skin, thus customizing it to serve as branding for your Site Customization system. For information about how to edit skins and upload designs and images, refer to Creating Skins on page 200 and Editing Skin Elements on page 205.

Duplicating Skins

You can create multiple skins with the same look, containing different content or images, by using an existing skin. Duplicating skins is a simple, time-saving method of setting up a Multisite system.

To duplicate a skin, select a skin name and click Duplicate Skin; the duplicate skin appears in the Skins list.

To rename a skin:

1. In the Skins list, select a skin.
2. Click Rename Skin and type a unique name in the Skin Name field.
3. Click OK; the skin is renamed.

To delete a skin:

1. In the Skins list, select a skin name and click Delete Skin.
2. In the confirmation dialog box, click Yes; the skin is deleted. Print Buyer accounts assigned with the deleted skin are assigned the default skin.
Assigning Skins to Print Buyers

When you select a skin in the Skin Library to be used by one or more Print Buyers, the Print Buyer name, or names of Print Buyers currently assigned to the selected skin (if any) appear in the Assigned to Customers list. You can reassign skins, or remove the skin assignment option for the Print Buyer altogether.

To assign a skin:

1. In the Skins list, select a skin name and click Assign to Customers; the Assign to Customers dialog box appears listing all Print Buyers and their respective assigned skins.
2. Select the check boxes corresponding to the respective Print Buyers and click Assign; the assigned Print Buyers are displayed in the Assigned to Customers list.

Designating a Default Skin

The System Standard skin, located in the Skins list, is automatically set as the default skin upon installation. You can select another skin as the default skin for your Web Services site.

To make a default display skin; select a skin and click Set as Default.

You cannot have multiple default skins. The System Standard skin cannot be edited.
Your Print Buyers initiate print jobs on the Print Buyer side of the FreeFlow Web Services system. After the Print Buyer prints the job, and the job quote is ready, the job is transferred to the Print Service Provider side of the system and appears in your Production Queue window. In the Production Queue window, you can do various activities with the job, before approving the job for production. After the job is approved, it enters the Delivery window where you can view and edit shipping information, print shipping labels, and approve jobs for delivery.

This chapter is composed of the following sections:

- Production Queue Overview
- Managing Jobs in the Production Queue
- Managing Notifications and Alerts
- Producing Jobs
- Delivery Queue
- Track Jobs
Production Queue Overview

The Production Queue window displays all the jobs that were ordered by Print Buyers, and that are waiting for your approval before routing to actual production. New jobs that enter the production queue are automatically placed at the end of the queue.

When you select a job in the production queue job list, its details are displayed in the job's details panel. From the job's details panel you can preview the job, and access various dialog boxes that allow you to perform needed tasks and adjustments. For example, examine and change imposition parameters, and reroute jobs to different output devices. One of the main tasks that you perform is creating the job ticket. The Production Queue window, and the activities that you can perform are described in detail in the following sections.

When the job is ready to be printed, you send it to the output device. The approved job is removed from the production queue, enters the delivery queue and the printing queue.

To access the Production Queue window:

1 From the Web Services menu, select Tasks > Production; the Production Queue window appears. All the ordered jobs are listed in the production queue job list on the left side of the window. By default, the first job in the list is selected, and its information is displayed in the job’s details panel on the right side of the window. Figure 50 shows the Production Queue window.

2 Click to select another job in the list; the job’s details panel is updated accordingly. To quickly locate a job in the list, use the Search option. For details, see Managing the Production Queue Job List on page 217.

3 Using the options in job’s details panel, you can edit job parameters, and perform production-related activities, as explained in this chapter.

Figure 50: Production Queue window
Managing Jobs in the Production Queue

Managing the Production Queue Job List

When a new job enters the production queue, it automatically enters the end of the production queue job list. The following information is displayed for each job in the list:

- A job thumbnail.
- The **Job #, Description, Copies, Req. Date** (if requested), **Account** name, **Output Device** (if defined).
- The VI Type column indicates if the job contains variable information.
- The HasMismatch column indicates if the job contains mismatched information. An alert is created if there is a mismatch problem. For details, see Alerts in Managing Notifications and Alerts on page 232.
- The Integration Type column indicates the type of integration that was utilized, if integration was used in the job.
- The Output Format column indicates the job output format. For example, PPML or VIPP.
- The Pricing problem column indicates if there is a pricing problem with this job. An alert is created if there is a problem. For details, see Alerts in Managing Notifications and Alerts on page 232.
- The Imposition status column indicates if there is an imposition problem with this job. An alert is created if there is a problem. For details, see Alerts in Managing Notifications and Alerts on page 232.

You can perform the following activities in the production queue job list:

- Filter jobs in the queue, using the **Search** option.
- Change the order of the jobs in the queue, using the up and down arrows. When the queue is viewed with the **Default sort**, you can move jobs up and down the queue, and move jobs to the beginning or end of the queue. You cannot change the order of the jobs in a sorted queue.
- Refresh the queue to show newly added jobs.
- Define which columns will appear in the queue, using the **Column Selection** option.

For details on how to manage the queue list, refer to Displaying and Hiding Queue Columns on page 8.

The Job Details Panel

The job’s details panel displays the details of the job that is selected in the production queue job list. Using the icons and buttons in the job’s details panel, you access dialog boxes that allow you to view additional job parameters, and perform necessary changes. For example, edit imposition parameters, and create a job ticket.

Icons and buttons that appear at the top of the job’s details panel allow you to perform job modification tasks:

- **Job Properties** icon. For details, see Viewing and Editing Job Properties on page 219.
- **Attach files** icon. For details, see Attaching Files to the Job on page 220.
- **Queue selection** icon. Enabled only when the selected output device has multiple queues. In this case, you can select another queue. For more information,
Production Management

- Modify crop or bleed icon. For details, see Viewing and Editing Job Properties on page 219.
- Device and Imposition icon. For details, see Editing Job Imposition on page 222.
- Gang jobs icon. For details, see Ganging Jobs for Production on page 227.
- Edit Layout icon. For details, see edit a layout using Layout Maker: on page 228.
- Split Composite job icon. Relevant if you used the gang jobs option. For details, see Printing Book Assembly Jobs on More Than One Output Device on page 229.
- Open Job ticket icon. For details, see Creating a Job Ticket on page 230.
- Edit Job ticket icon. For details, see Editing a Job Ticket on page 231.
- Outsource button. For details, see Outsourcing Jobs to a Partner Print Service Provider on page 234.
- Move to button. For details, see Changing the Status of a Job on page 235.
- Approve button. For details, see Approving a Job for Printing on page 236.

The job’s details panel contains additional job information, and allows you to perform administrative job tasks:

- The job # and description appear in the title.
- If there are problems with the job, an alert is created, and the alert icon appears below the title. For details, see Managing Notifications and Alerts on page 232.

**Job Details** information:

- **Colors**—the type of colors, as defined in the job order. For example, Process colors.
- **Paper**—the type of paper, as defined in the job order.
- **Pages**—the number of pages, as defined in the job order.
- **Quantity**—the number of copies to be printed, as defined in the job order.
- **Reference Code**—a job reference number that you can enter. The code can be useful for your records.

Click 📝 (PDF Preview icon) to see a preview of the job.

Click 📝 (Edit note icon) to open the Edit Note for Job # window. The note that is associated with the job, can contain information from the Print Buyer, which you can see; information for the Print Buyer that you enter in this window; and/or an internal note that cannot be viewed by the Print Buyer.

Click 📝 (Preflight icon) to open the File Upload Report window, which displays preflight problems. For example, color, font or image problems. You can also preview the job from this window.

Click 📝 (Info message icon) to open the Job Report window. The font and image report of the original file, and the imposition file are provided. Imposition problems are also listed.

When there is an imposition problem, the Info message icon appears as a red alert icon, and the Job Report window reports the problem.

- **Imposition**—job imposition and layout information, including a thumbnail of the imposition file, an Imposition icon to display the PDF of the imposed job, Device Queue icon (appears only if the device output has a queue).
- **Order**—job order information, including the Order # (and how many jobs in the order) Account name, User name, Price, Order Date, and Shipping Date.
- **Press sheets planned/actual**—shows the planned and actual number of press sheets in the job.
Managing Jobs in the Production Queue

When working with specific types of output devices, you can use the Device Queues option to create workflows that direct jobs to hot folders that are associated with these devices.

Viewing and Editing Job Properties

To view and edit job properties:

1. Select the job that you want to view or edit in the production queue job list. The job's details panel is updated with the parameters of the selected job.

2. Click \(\text{(Job Properties icon)}\) in the job's details panel. The Job properties dialog box appears.

Figure 51: Job Properties dialog box

3. The Job properties dialog box contains several tabs, depending on the type of job:

   - For an Upload File job, the following tabs appear: Job Details, Upload File, Job Specification, File Report, and Pricing.
   - For a Static Template job, the following tabs appear: Job Details, Job Specification, and Pricing.
   - For a VI Template job, the following tabs appear: Job Details, Job Specification, Variable Information, and Pricing.

4. In the Job Properties dialog box, you can change the default properties of a template or override Print Buyer property settings. That is, you can modify a problematic file or resolve a mismatch problem. For details on mismatch problems, refer to the Alerts table on page 233.

5. You can view and edit job properties on these tabs. For more information on editing job properties, refer to Defining Print Imposition on page 41.
### Attaching Files to the Job

You can modify files that have been attached to the job. For example, you can download an attached variable information database, modify the file, and then upload the modified database. Or you can edit an original Adobe Photoshop file to correct something in the file, and upload the corrected file.

You can also attach new files to the job, but this is not the main use of this option in the Production queue window. For information about attaching files, refer to Managing Attachments on page 9.

#### To attach files to a job:

1. Select the job in the production queue job list. The job’s details panel is updated with the job’s details.

2. Click ![Attach files icon](Attach files icon) in the job’s details panel. The Attachments dialog box appears.

3. The dialog box lists files that are attached to the job. Using the icons in this window, you can download the attachment that you want to modify, and you can rename or delete an attachment. From this window you can also open a folder for the files that you will download.

4. If you downloaded attachments, perform the necessary changes, and save the files.

5. To reattach the modified files to the job, click the Upload Files button. The Upload File dialog box:
   a. Select Upload a single file; click Browse to select the file.
   b. Select Upload multiple files using FTP Mutli-file Upload; the FTP window appears. Upload the files in this window.
   c. Click Continue.

6. The system allows you to replace the Web Services Imposition file with a job imposition that was performed by an external system. After uploading the external imposition file, click External Imposition to instruct the system that this file will replace the Web Services Imposition file. An appropriate icon appears near the attached file name in the Attachments dialog box.

For information about attaching files, refer to Uploading Files on page 9.
Viewing and Modifying a Job’s Crop and Bleed Parameters

You can view job crop and bleed parameters, and perform necessary modifications. For example, if the job was prepared on an incorrect page size, you need to modify the crop marks, or if the bleed marks are inside the final job size, you need to scale the job size so that the bleed marks are outside the final job size.

To modify crop and bleed parameters:

1. Click \(\text{Modify the Crop and Bleed icon}\); the Wizard tab on the Trims & Bleeds Editor window appears. You are prompted to read the instructions before clicking Start.

2. After you click Start, follow the wizard instructions to modify the crop and bleed marks. When completed, click Save.

Alternatively, you can modify the crop marks and bleeds without the wizard. Click the Advanced tab on the Trims & Bleeds Editor window. Modify the crop and bleeds, and select the I have set the job size and bleeds successfully check box. Click Save when you are done.

Figure 52: ITrims & Bleeds Editor - Advanced tab

For more information on crop and bleed parameters, refer to To set the press sheet gutters and bleeds: on page 44.


Editing Job Imposition

You can edit the imposition of jobs in the production queue. The imposition parameters override any parameters set at the system level. For system level settings, refer to Defining Print Imposition on page 41.

To edit general imposition parameters:

1. Click (Device & Imposition icon); the Device and Imposition dialog box appears.

   Figure 53: Device and Imposition dialog box

2. From the Output Device dropdown list, select an output device (if one is not selected), or select another device instead of the one that was defined at the system level.

3. From the Press Sheet dropdown list, select a new press sheet size.

4. From the Orientation dropdown list, choose Landscape or Portrait.

5. Define Imposition parameters:
   a. From the Imposition Method dropdown list, choose Same-Up or Multiple-Up.
   b. From the Work Style dropdown list, select one of the options.

6. Define page layout and binding parameters:
   a. From the Page Order dropdown list, select one of the options.
   b. From the Page Rotation dropdown list, select one of the options.
   c. From the Alignment dropdown list, select one of the options.
   d. From the Fill Policy dropdown list, choose Exact or Fill to define how the page imposition on the press sheet.

7. Click OK when done, or continue to edit other imposition parameters. Refer to the following procedures.
Managing Jobs in the Production Queue

To edit the press sheet margins:
On the **Margins** tab of the **Edit Imposition** dialog box, fill in the relevant **Margins** fields.

To edit the press sheet gutters and bleeds:
1. Click the **Gutters and Bleeds** tab of the **Edit Imposition** dialog box.
2. Fill in the **Horizontal Gutters** and **Vertical Gutters** fields.
3. Fill in the **Bleed** fields.
4. Select one of the following bleeds options:
   - **Regular Bleeds** (default)—is suitable when the bleeds are properly defined, and are outside the final job page size. If you discover a bleed problem, choose one of the following bleeds options.
   - **Re-scale Jobs**—use this option when bleeds are required, but the file does not have them. This option increases the size of the job so that it can be cropped to its original page size. The difference between the original job and the enlarged job is the bleeds configurations. The final job is the same as the original job, but it's design is “distorted”.
   - **Reduce Job Size**—use this option when bleeds are required, but the file does not have them. With this option you treat the job margins as a bleed and trim them off. The final job size is reduced.
5. Click **OK** when done, or continue to edit other imposition parameters. Refer to the following procedures.

To add labels and marks to the press sheet:
On the **Labels and Marks** tab of the **Edit Imposition** dialog box, you define what labels and marks you want printed on the press sheet. Select the relevant check boxes:

- **Job Info**—for example, job number, account name, date of production.
- **Crop Marks and Folding Info**—crop marks are indicated by solid lines, and fold marks are indicated by dashed lines at the location of each fold. The word In or Out above the dashed line refers to the fold direction, and the number under the line is the fold order.
- **Registration Marks**—by default, there are four registration marks located on each corner of the press sheet.
- **Gutters, Job Width and Height**
- **Color Bar and Separation Names**

Click **OK** when done, or continue to edit other imposition parameters. Refer to the following procedures.

To edit custom color bar elements:
1. Click the **Custom Color Bar** tab of the **Edit Imposition** dialog box.
2. From the **Color Bar File** dropdown list, select a color bar option.
Web Services provides horizontal and vertical color bars for gray scale and CMYK colors, and you can add these files to the Color Bar File dropdown list:

- Click the Color Bar File link; the Color Bar Files dialog box appears.
- Select the relevant TIFF file, and click Upload Images. For more information, refer to Uploading Files on page 9.

To define the color bar position and dimensions, fill in the Position fields, and the Dimensions fields.

- Click OK when done, or continue to edit other imposition parameters. Refer to the following procedures.

**To edit the ICC Profile:**

1. Click the ICC Profile tab of the Edit Imposition dialog box.
2. From the Convert RGB to CMYK via ICC Profile dropdown file, select an ICC profile to be used when creating the imposed file. For more information, refer to Adding ICC Profiles to the System on page 37.
3. To add ICC profiles to the dropdown list:
   - Click the Convert RGB to CMYK via ICC Profile link; the ICC Profiles dialog box appears.
   - Upload ICC profiles into your Web Services system. For information on uploading files, refer to Uploading Files on page 9.
4. Click OK when done, or continue to edit other imposition parameters. Refer to the following procedures.

**To view the imposed job:**

1. Select the job in the production queue job list.
2. Click (Imposition icon) in the Imposition section of the job's details panel; a high-resolution PDF image of the imposed file appears.
3. On the PDF image of the imposed file, view the crop, registration and fold marks, job page dimensions, gutters, job information, and the embedded color bar, if they were selected on the Labels and Marks tab of the Edit Imposition dialog box.
Manual Impose

Manual Impose is used for saving the job as a non-imposed PDF, and the imposition is done by a third party imposition tool. Manual Impose is also automatically selected when the PDF cannot be imposed by the system, in which case, the following icon appears instead of the Job Info thumbnail:

The Manual Impose option is accessed from the Output Device dropdown list in the Edit Imposition dialog box.

After approval, a manually imposed job is transferred to a folder that the Print Service Provider has specified in the Output Devices window (for more information, refer to the Defining Print Settings chapter: Defining Print Imposition on page 41.

Imposition Schemes

This section illustrates the different imposition schemes.

Horizontal and Vertical Orientation

Figure 54: Imposition Scheme: Vertical Orientation

Imposition Scheme: Vertical Orientation
Figure 55: Imposition Scheme: Horizontal Orientation

Imposition Scheme: Horizontal Orientation

Close Up View

Figure 56: Imposition Scheme: Close Up View

Imposition Scheme: Close Up View
Ganging Jobs for Production

You can print more than one job on a single press sheet using with the Layout Maker option. The advantage of ganging jobs is to reduce production costs by considering the following two factors:

- Maximize the utilization of the press sheet.
- Minimize the amount of cutting and stacking.

To create a layout, you select a base job in the production queue, and select the Layout Maker option. The system automatically selects additional jobs from the production queue that can are candidates to be added to the layout job, according to the following criteria:

- The base job can have one or two pages (two pages are either two one-sided pages or a double-sided page).
- Jobs that are the same size as the base job.
- The number of pages in the additional jobs must be equal to, or smaller than, the base job.

From the list of jobs that are selected by the system, you select the jobs that you want to gang, as explained in this section.

Layout Maker Overview

The Layout Maker window (shown in Layout Maker window on page 228 is divided into two panels:

- Layout information panel—displays the layout information.
- Job information panel—displays the various jobs that are suitable to be included in the layout.

The Layout Maker window provides the following information, which is necessary for maximizing the effectiveness of this option:

- Paper Size—size of the press sheet that is defined for the job. This size is used to calculate the additional jobs that can be printed on the sheet.
- Job Size—size of the selected base job. Jobs that are added to the layout must be the same size.
- Units on Page—total number of units, of the selected jobs, that can be printed on a press sheet.
- Number of Press Sheets—number of press sheets required in this layout job.
- Utilization—a percentage that indicates the utilization of the press sheet. The percentage changes according to the jobs that are selected for the layout.

When selecting jobs to be included in the layout, HP recommends that you do not combine jobs with different bleed settings.
Printing Jobs Using the Layout Maker

To create a layout using Layout Maker:

1. Select a job in the production queue job list that can serve as the basis of the layout (the base job).

2. Click (Gang jobs using Layout Maker icon) in the job's details panel; the Layout Maker window appears. The layout # in the window title is automatically updated by the system.

3. From the list of jobs, select the jobs that you want to gang; these are the jobs that will be included in the layout. When selecting jobs, consider the utilization factor because you want to add jobs that will provide the greatest page utilization.

4. In the Layout name box, type the layout name.

5. To preview the layout, click Preview Layout; a PDF preview of the layout appears.

6. To create a layout, click Create Layout; the jobs appear as a combined layout job in the production queue job list. The job's details panel is updated, and shows a composite job.

To edit a layout using Layout Maker:

1. If a job already has a layout, you can edit the layout. Select the job that contains a layout.

2. Click (Edit Layout icon) in the job's details panel; the Layout Maker window appears.

3. Modify the layout, as needed. For example, you can add or remove jobs to/from the layout. Refer to create a layout using Layout Maker: on page 228.
Printing Book Assembly Jobs on More Than One Output Device

When jobs contain multiple files and components, you can produce the files and components on more than one output device, using the **Split Composite job** option. In this option you can define exception impositions for different components of the book. For example, you might want the black and white pages to be printed on one printer, and the color pages on another.

To print multiple files on different output devices:

1. Select a Book Assembly job.
2. Click (Split composite job icon) in the job’s details panel; the **Split PDF** dialog box appears, showing the various composite job files.
3. Select the check box of the job component that you want to split: color pages, tab, cover and/or B/W pages.
4. Choose one of the two splitting color options, according to component type, color channels, or color content of the files:
   - **Split Colors (By Definition of the Print Provider according to the Color Channels)** — the system splits off color pages from all components for which you specified color channels in the component definition.
   - **Split Colors (By Content exclude B/W pages from Color component)** — the system splits the job according to the color content of the job pages. If the job contains color and B/W pages, it is split into two parts: color pages and B/W pages.
5. From the **Blank Pages** dropdown list, select the option that will define how blank pages are displayed in the split job.
6. Click **OK** to save the changes and close the dialog box.
Creating a Job Ticket

A job ticket is a file that contains detailed job information about production, finishing, delivery, and pricing. The job ticket file can be printed and used on the production floor. The Date and Signature fields, in the printed job ticket pages are left empty, to be completed by the relevant personnel on the production floor.

To create a job ticket:

1. Select a job and click (Open Job Ticket icon); the Job Ticket Creation dialog box appears.

Figure 58: Job Ticket Creation dialog box

2. Select the Job Ticket Pages check boxes of the pages that you want to include in the job ticket: Production, Finishing, Delivery, Pricing Information.

3. Click the Printing Deadline button to set the printing deadline; the Printing Date dialog box appears.
   a. Set the date and time by which the job must be printed.
   b. Click OK; the set date and time are displayed in the Printing Deadline box of the Job Ticket Creation dialog box.

4. Click the Finishing Deadline button to set the finishing deadline; the Finishing Date dialog box appears.
   a. Set the date and time by which the post-printing tasks (for example, folding and binding) must be completed.
   b. Click OK; the set date and time are displayed in the Finishing Deadline box of the Job Ticket Creation dialog box.

If you do not set printing and/or finishing dates, the respective information is displayed as N/A in the job ticket.

5. Click OK in the Job Ticket Creation dialog box; the Download File panel appears.

6. On the Download File panel, click the JobTicket[job #].doc link to download the job ticket file, and then save the job ticket as a Microsoft Word file. Alternatively, click and save the zip file of the job ticket, and extract the file on your computer.
7. After saving the job ticket file, you can print out copies.

**Editing a Job Ticket**

Sometimes you need to edit the job ticket. For example, change the printing deadlines of a job, or change the pages that are included in the job.

When you change the Word file of the job ticket, make sure not to delete links to the other job information.

**To edit a job ticket:**

1. Select a job that has a job ticket, and click ![Edit Job Ticket icon]; the Job Ticket Creation dialog box appears.
2. Modify the job ticket information, as needed. For more information, see Creating a Job Ticket on page 230.
3. Save the modified job ticket.

**Viewing Book Assembly Job Details**

For Web Services Set jobs, you can view details on the different job components, which can include some or all of the following components: cover page, number of color pages, number of B/W pages, binding style and tabs.

**To view the details of a Book Assembly job:**

1. Select a Book Assembly job from the production queue job list, and click the Edit job Ticket icon; the Job Ticket Creation dialog box appear.
2. From the Download File panel, open the Job Ticket file.
3. In the Production section of the Job Ticket file, under Set Definition, view the list of job components that are defined for this Web Services Set job. The following details are provided for each component: definition, page number, page size, color definition, and paper type.
Managing Notifications and Alerts

Notifications and Alerts are indicators that can appear in specific columns in the production queue job list. Notifications are viewed only when specific columns are present in the list, and they provide information that is not critical to the continuation of the job processing.

Alerts contain information that is critical to the continuation of the job processing. You need to view the alert, and address the problems that it raises. The alert information includes steps for processing the problem to which you are being alerted. To ensure that you view and process the Alerts, Alerts appear also in the job's details panel. After the Alert is viewed and acknowledged, it is classified as a Handled Alert.

<table>
<thead>
<tr>
<th>Notification</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Thumbnail</td>
<td></td>
<td>Thumbnail image of the job's front page.</td>
</tr>
<tr>
<td>PDF Preview</td>
<td></td>
<td>Access a high-resolution PDF preview of the job. When the job is part of a combined job, access an imposition proof.</td>
</tr>
<tr>
<td>Hidden Price</td>
<td></td>
<td>The Print Buyer who ordered the job cannot see the job price.</td>
</tr>
<tr>
<td>Print Driver</td>
<td></td>
<td>The job was created using the Print Driver ordering workflow.</td>
</tr>
<tr>
<td>iForm</td>
<td></td>
<td>The job was created from an iForm.</td>
</tr>
<tr>
<td>Variable Data</td>
<td></td>
<td>The job contains variable data, as indicated in the VI column of the production queue job list.</td>
</tr>
<tr>
<td>Combined Job</td>
<td></td>
<td>The job has been imposed with one or more other jobs using Layout Maker. See details in Ganging Jobs for Production on page 227.</td>
</tr>
<tr>
<td>VIPP</td>
<td></td>
<td>This is a VIPP Variable Data job.</td>
</tr>
<tr>
<td>Book Assembly</td>
<td></td>
<td>This is an Book Assembly job.</td>
</tr>
<tr>
<td>Blank Files</td>
<td></td>
<td>The job does not contain data.</td>
</tr>
<tr>
<td>Jobs to Inventory</td>
<td></td>
<td>The job will be printed and stored as inventory.</td>
</tr>
<tr>
<td>Job from Inventory</td>
<td></td>
<td>The job will be shipped from inventory.</td>
</tr>
</tbody>
</table>
### Table 23: Alerts

<table>
<thead>
<tr>
<th>Alert</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Properties Mismatch</td>
<td></td>
<td>There is a disparity between the job properties and the uploaded file parameters. When you click a Mismatch icon, the <strong>Mismatching Parameters</strong> dialog box appears. You can match the job properties with the uploaded file parameter. For more information, refer to Viewing and Editing Job Properties on page 219.</td>
</tr>
<tr>
<td>Price Problem</td>
<td></td>
<td>There are pricing problems. When you click the alert, the <strong>Job Pricing</strong> dialog box appears, and you can modify the price, discount, express charges, and tax. The <strong>Job Pricing</strong> dialog box also allows you to notify your Print Buyers of these modifications. For more information, refer to Pricing on page 175.</td>
</tr>
<tr>
<td>No Production File</td>
<td></td>
<td>The job does not contain data.</td>
</tr>
<tr>
<td>File Preflight Problem</td>
<td></td>
<td>The following information is missing from the job: fonts, low res images, or RGB images.</td>
</tr>
<tr>
<td>View Print Buyer Note</td>
<td></td>
<td>An alert is created whenever there is a note from the Print Buyer. The note must be viewed and acted upon.</td>
</tr>
<tr>
<td>General Problem</td>
<td></td>
<td>There was a problem with the job during preflight or imposition, or when creating the low-res image.</td>
</tr>
</tbody>
</table>
Producing Jobs

When a job is ready for production, you can complete one of the following tasks:

- Outsourcing Jobs to a Partner Print Service Provider.
- Changing the Status of a Job.
- Approving a Job for Printing.

Outsourcing Jobs to a Partner Print Service Provider

When the job will not be printed in your print house, you can still accept the responsibility for producing the job by forwarding it to another Print Service Provider. Working with the Outsource option, you can outsource a job from the Web Services system, directly to a partner Print Service Provider, by sending an email message containing links to the imposed file and job ticket.

This section explains the workflow that the Print Service Provider's does to outsource a job, and the workflow that the partner Print Service Provider does to print the outsourced job.

Print Service Provider Workflow

To outsource to a partner Print Service Provider:

1. Click the target job that you want to send to the partner Print Service Provider.
2. In the job’s details panel, click Outsource; the Outsource Job dialog box appears.
3. For a new partner Print Service Provider, perform this step. To use an existing partner Print Service Provider, continue from Step 4.
   a. Click New Print Provider; the New Print Provider Details dialog box appears.
   b. Type the partner Print Service Provider’s details and click OK.
4. From the Print Provider Name dropdown list, select a partner Print Service Provider; the partner’s details appear in the Select Partner Print Provider panel.
5. In the Job Shipping panel, choose where you want the partner Print Service Provider to send the job upon completion:
   - Ship to Account—send the finished job directly to the Print Buyer.
   - Ship to me by date—the completed job will be returned to you; click the Select Date link to set a time limit for returning the job to you.
6. Click Outsource Job; the Outsource Email Sent message appears, informing that an Outsource Email Sent message was sent to the partner Print Service Provider.
7. Click OK; the Production Queue window appears.

The job is transferred to your Printing queue window, and the icon indicates that the job is waiting to be accepted by the partner Print Service Provider.
Managing Jobs in the Production Queue

8 In the **Printing queue** window, select the target job that has been outsourced; the job details and the **Outsourcing Information** link appear in the **Job Info** panel.

9 Click the **Outsourcing Information** link; the **Outsourcing Information** dialog box appears. **Outsourcing Information** is an initial status report of the job that is sent to the partner Print Service Provider.

10 Click **OK** to close the dialog box.

---

**Partner Print Service Provider Workflow**

After the **Outsource Email** message is sent, you as the partner Print Service Provider, receive the email message with the job details. You can view the job’s PDF, the imposition job PDF and the job ticket. Perform the following tasks:

1 To accept the job and start the printing process, click **Accept** to indicate that the job is accepted and will be produced. The partner Print Service Provider is also requested to click **Shipped** when the job is completed. If the partner Print Service Provider fails to do so, you can click **Relocate to Delivery**, in the **Outsourcing Information** dialog box, to transfer the selected outsourced job to the **Delivery** window.

---

**Changing the Status of a Job**

Sometimes there is a need to change the status of a job. For example, if the job status was changed outside the Web Services system, or if a job in the **Production queue** window is a job that does need to be printed (that is, the final output of this job is not a **printed** item). In such cases, you need to change the job status within the Web Services system, in the **Production queue** window.

1 Click the **Move To** button; the **Move job** dialog box appears.

2 Select **Delivery queue**. For information on the delivery queue, see **Delivery Queue** on page 237.

---

When you **Approve** a job within the **Production queue** window, there is no need to select the **Delivery queue** option in the **Move job** dialog box.
Approving a Job for Printing

Before approving a job for production, HP recommends that you view the job imposition scheme, review the job ticket, re-impose the job if necessary and/or impose the job together with other jobs (refer to Ganging Jobs for Production on page 227). When the job is ready for production, and will not be outsourced to a partner Print Service Provider, you can approve the job for production.

To approve a job for production:

1. Select the target job in the production queue job list.
2. Click **Approve** in the job’s details panel; the job is removed from the **Production queue** window.

   If you **Approve** a job that is not ready for production, a note appears to inform you which job parameter is not defined. You can either confirm that you want to approve the job, or cancel the approval.

   The job is sent to the output device (or the hot folder of a specific output device), and moves from the **Production queue** window to the **Printing queue** window. The job is also added to the **Delivery** window, where its status is automatically changed to **Ready for Delivery**.

3. After the job is approved and removed from the **Production queue** window, you can view the job in the **Delivery** window; for details, see Delivery Queue on page 237.

   In some cases, it is preferable to view the job in the **Delivery** window, rather than the **Printing queue** window.

4. If the job print is not managed by Web Services, select **Move To...** and select the folder to which you want to move the job (for example, the **Delivery** window). After the job is printed and ready for delivery, continue to the delivery tasks. For details, see Delivery Queue on page 237.

To return a job from the Printing Queue to the Approval Queue:

1. In the **Printing queue** window, select the target job.
2. Click **Back to Approval** in the **Job Information** panel; the job returns to the **Production queue** window. For more information, refer to Managing Jobs in the Production Queue on page 217.
Delivery Queue

Delivery Queue Overview

After the job is approved for printing in the Production queue window, the job enters the Delivery window. For details on approving jobs, see Approving a Job for Printing on page 236).

The Delivery window options allow you to process the delivery of your printed jobs. You can view and edit shipping information, print shipping labels, and approve jobs for delivery.

To access the Delivery window:

1. From the Web Services menu, select Tasks › Delivery; the Delivery window appears. All the jobs that were approved for printing are listed in the Jobs for Delivery panel on the left side of the window. By default, the first job in the list is selected, and its job information is displayed in the Batch Order panel on the right side of the window. Figure 59 shows the Delivery window.

2. Click to select another job in the Jobs for Delivery panel; the Batch Order panel is updated accordingly. To quickly locate a job, use the Search option. For details, see Managing the Jobs for Delivery Panel on page 238.

Figure 59: Delivery window
The Delivery window contains three panels:

- **Jobs for Delivery** panel—this is the main panel in the Delivery window; it lists jobs that have been printed and are waiting to be delivered. From here you select jobs that you want to approve for delivery.

- **Batch Order** panel—displays the job that is selected in the Jobs for Delivery panel, and the other jobs in the same order for the same Print Buyer. From here you can update shipping and carrier information, including shipping cost, and approve the printed job for shipping.

The other jobs that are also listed may have a different job status than the selected job. For example, the Batch Order panel can include a job that has not yet entered the Delivery window, as indicated by its job status. Displaying the information on all the jobs in this order allows you to handle the shipment of the order more efficiently. For example, you can decide to approve delivery only when all the jobs are ready to be shipped.

- **Shipping Deliveries** panel—lists the shipped jobs for a selected period (last day, week, or month). An email notification is sent to the Print buyer, who can track the job in the Print Buyer’s Shipping queue.

**Managing the Jobs for Delivery Panel**

The following parameters are displayed for each job in the Jobs for Delivery panel:

- A job thumbnail.
- Job #.
- Job name.
- Account.
- Req.Date, if requested.

You can perform the following activities in the Jobs for Delivery panel:

- By default, the jobs are listed according to Job #, in ascending order. However, you can sort the list according to the other parameters. Click the column of the parameter that you want to use for sorting the list.

- Determine which columns will appear in the list, using the Column Selection option. In the Column Selection dialog box, select or clear the check boxes of the column options, and click OK.

- Filter jobs in the list, using the Search option.

For details on using the Search option, refer to Managing Queues on page 7.
Managing Delivery in the Batch Order Panel

When a job is selected in the Jobs for Delivery panel, its information is displayed in the Batch Order panel. The system automatically searches for other jobs that were ordered by the same Print Buyer, and displays these jobs in the Batch Order panel.

The following parameters are displayed for each job in the Batch Order panel:

- Job #, Order #, and Copies.
- Shipping information: Shipping Address, and Shipping Date.
- Carrier information: Carrier, and Tracking # (a tracking # is provided by carriers that allow you to connect to their online tracking service).
- Status.

Because all the jobs that were ordered by this Print Buyer are listed, some jobs might have a status other than Ready for Shipping.

In the Batch Order panel, you can perform the following activities:

- Sort the jobs by clicking on the column that you want to use for sorting.
- View the status of all the jobs in this order: Printing, Ready for Shipping, or Delivered.
- Select the job(s) that you want to ship.
- Print shipping labels.
- Calculate shipping costs.

Viewing Carrier Tracking Status

Some carriers have an online tracking service that allows you to track your job using the job’s Tracking #, which was provided by the carrier. Using the Tracking #, you can connect to the carrier’s service from the Batch Order panel, and view the job’s shipping status.

To view carrier tracking status:

1. Click the Tracking # of the job that you want to track; the carrier’s Track Shipments window appears.
2. Navigate to the job and view the results. You can see whether the job is in the shipping process, or has already been delivered.
Editing Delivery Information

From the Batch Order panel, you can edit the delivery information of the selected job.

To edit delivery information:

1. In the Batch Order panel, select the job that you want to edit, and click Edit; the Delivery Information dialog box appears.

Figure 60: Delivery Information dialog box

2. To modify the shipping address:
   a. Click the Shipping Address link; the Edit Address dialog box appears.
   b. Type the appropriate information in the address fields.
   c. Click OK to save changes and return to the Delivery Information dialog box.

3. To modify the shipping method:
   a. Click the Shipping Method link; the Select Shipping Method dialog box appears.
   b. From the Shipping Method dropdown list, select a shipping method.
   c. Click OK to save changes and return to the Delivery Information dialog box.

4. To modify the carrier’s tracking information:
   a. From the Carrier dropdown list, select the carrier that is used for this job.
   b. In the Tracking # field, type the tracking information that was provided by the carrier. For details on using the Tracking # field, see Viewing Carrier Tracking Status on page 239.

5. Click OK to save changes in the Delivery Information dialog box.
Printing Shipping Labels

From the Batch Order panel, you can print shipping labels for all the jobs that are delivered in this order.

To print shipping labels:

1. From the Batch Order panel, select the jobs for which you want to print labels.
2. Click Create Delivery Labels; the Edit File window appears.
3. Click the file link; the label file opens as a Word or HTML document.
4. Verify that the shipping label information is correct. If necessary, enter your changes and save the file.
5. Print the shipping label document.

Estimating Shipping Costs

The shipping calculator allows you to estimate the shipping cost of the selected job, based on the shipping method that was defined, and the following two factors:

- Shipment weight.
- Carton size.

To estimate shipping cost:

1. Click Shipping Calculator in the Batch Order panel; the Shipping Cost Calculator dialog box appears.
2. In the Job Information panel of the dialog box:
   a. Select the shipping method from the Shipping Method dropdown list.
   b. Type the shipment weight (in lbs) in the Weight field.
   c. Type the dimensions (in inches) of the shipped carton in the Carton Size fields: Length, Width and Height.
3. In the Shipping Cost Estimate panel, click Estimate Price. The shipping cost is calculated, based on the information that you entered, and the shipping cost for this carrier.
4 Type the cost that was calculated in Step 3 into the Actual Cost field. This cost is useful for future reference.

5 Click OK to return to the Batch Order panel.

**Approving Jobs for Delivery**

After the job is printed and its shipping information has been verified, you can approve the job for delivery.

**To approve a job for delivery:**

1 In the Batch Order panel you can see which job in the batch order can be approved for delivery, as indicated by its job status—Ready for shipping.

   If there are additional jobs in the order that are ready for delivery, you can approve them at one go; press the <CTRL> key to select multiple jobs.

   If you want to deliver the jobs as a batch order, and not all the jobs are ready for shipping, wait until all the jobs are ready.

2 Click Approve Selected Deliveries; the selected job(s) moves from the Jobs for Delivery panel to the Shipped Deliveries panel.

   Jobs that are approved for delivery will also appear in the Print Buyer’s Shipping window.

**Managing the Shipped Deliveries Panel**

The Shipped Deliveries panel lists jobs that were approved for delivery; these jobs are no longer listed in the Jobs for Delivery panel and in the Batch Order panel. In the Shipped Deliveries panel, you can track shipped jobs. If there are other jobs in this order, you can view their status in the Batch Order panel.

The following information is displayed in the Shipped Deliveries panel:

- Job #, Order #, and Copies.
- Shipping information: Shipping Address, and Shipping Date.
- Carrier information: Carrier, and Tracking # (if provided).
- Account name.

When a job is shipped by a carrier that provides online tracking service, you can click the Tracking # to view the job’s shipping status from within the carrier’s system. For details, see Managing the Jobs for Delivery Panel on page 238.
In the **Shipped Deliveries** panel, you can perform the following activities:

- List jobs according to different delivery periods, and different sorting options.
- Return a job for delivery approval.
- View delivery labels.

**To list jobs according to delivery period and sorting options:**

- Delivery period—the jobs listed in the **Shipped Deliveries** panel are according to the last delivery period that was selected. You can select another delivery period:
  
  From the **Shipped in the Last** dropdown list, select **Day**, **Week** or **Month**. The list is updated accordingly.

- Sorting—you can sort the job list according to each of the job parameters. Click the column that you want to use for sorting the list.

**To return a job for delivery approval:**

Sometimes you want to return a job for delivery approval after it was approved for delivery. For example, if the job has not yet been delivered and you realize that additional jobs in this order have not been approved for delivery, and you want to deliver them as a batch.

1. In the **Shipped for Deliveries** panel, select the job that you want to return for delivery approval.

2. Click **Back to Approval**. The job is removed from the **Shipped for Deliveries** panel, and returns to the **Jobs for Delivery** panel and the **Batch Order** panel.

3. Process the job delivery. For details, see Managing Delivery in the Batch Order Panel on page 239.

**To view delivery labels:**

From the **Shipped for Deliveries** panel, you can view and print the job’s delivery labels. You might want to do this if the job was ruined during packing, or if you want to verify the shipping address.

1. Click **View Label** of the job that you want to view; the **Edit File** window appears.

2. Click the link of the delivery label file. The file is either saved as a Word document or an HTML document.

3. If needed, reprint the delivery label file.

The Print Buyer can track the job in Print Buyer's Shipping queue after the shipping email notification is received. When the Print Buyer receives the job, the Print Buyer clicks **Received**. The job enters the Print Buyer's Received queue and the job status automatically changes to **Received**.
Production Management

Track Jobs

The status of a job in the Web Services system is determined by specific actions performed by a Print Buyer or by the Print Service Provider. Using the various options in the Web Services system, you can perform actions that are job-status specific. For example, after the job is printed, it enters the production queue. In the Production queue window, you can perform activities that are relevant to this job status, as described in Managing Jobs in the Production Queue on page 217. However, sometimes you want to track jobs regardless of their status. The Web Services job tracking feature makes it easy for you to track jobs. You can track a job even if you don’t know its current status, and you can track a job that is not located in a specific queue.

In the Track Jobs - Search window, you can display all the job queues in the system; starting from Design, through Ready to Order, Printing, Shipping and Received. For example, you might want to search for all the jobs that were shipped to a specific Print Buyer by a specific date. You can also display jobs that were deleted.

In addition, there are various job modifications that you can perform from the Track Jobs window. For example, create a job ticket, and modify the job and order pricing.

This section describes the activities that can be performed in the Track Jobs window:

- Searching for Jobs.
- Managing Tracked Jobs.

Searching for Jobs

This section explains how to search for jobs, and how to define what information is displayed for each job.

Defining Job Search Criteria

The Web Services system allows you to define search criteria, and perform the search on all job statuses. Alternatively, you can select one of the predefined job statuses to only track jobs that have the selected job status (there no need to define a search criteria).
To track jobs using a search criteria:

1. On the Web Services main menu, select Tasks > Track Jobs; the Track Jobs - Search window appears. In this window, you specify the criteria to be used for the search.

Figure 61: Track Jobs - Search window

The window displays four search fields (status, search field, operator, value) that are used to define the search criteria. You can perform a simple search or an advanced search; see Step 2 on page 245 and Step 3 on page 246, respectively.

2. To perform a simple search:
   a. From the Status dropdown list, select the job status that you want to search for. By default All is selected.
   b. From the Search dropdown list, select the job field that will be the search criteria. The job fields are divided into categories, such as Job, Pricing, and Order, to make it easier to locate the various fields.
   c. In the operator field, select the operator (for example, =, <=) to be used when comparing the search criteria to the value that you type in the value field (Step d).
   d. In the value field, type the value that will be compared to the search criteria (Step b), using the selected operator (Step c).
   e. Click Search. The list of jobs that conform to your search definition is populated by the system and displayed in the Track Jobs - Job List window (refer to Figure 62). To modify the information that is displayed for each job, see Defining and Saving Job Search Information on page 247.

Figure 62: Track Jobs - Job List window
Alternatively, you can narrow down your search by using Advanced Search to define sets of multiple criteria:

a Click Advanced search; the Advanced Search dialog box appears.

Figure 63: Advanced Search dialog box

b From the Status dropdown list, select the job status that you want to search for. By default All is selected.

c You can specify up to three sets of search criteria. For each set of criteria, perform Step b to Step d on page 245. (Same steps as those performed in the simple search.)

The implied relationship between multiple sets of search criteria is **AND**.

d Click **OK** in the Advanced Search dialog box.

e Click **Search** in the Track Jobs - Search window. The list of jobs that conform to your search criteria is populated by the system and displayed in the window. To modify the information that is displayed for each job, see Defining and Saving Job Search Information on page 247.

4 You can perform various job modifications, as described in Managing Tracked Jobs on page 247.

**To track jobs conforming to predefined status:**

When you select Tasks > Track Jobs, the Track jobs - Search window shows All in the Status field (see Figure 61 on page 245). However, you can display jobs that conform to a predefined status without defining search criteria.

1 On the Web Services main menu, select Tasks > Track Jobs.

2 On the Track Jobs ribbon, click the link of the type of jobs that you want to display (for example, Saved Jobs, Ready to Order, Shipped); refer to Figure 64 on page 246.

Figure 64: Track Jobs ribbon

The list of jobs that conform to the selected type of job is populated by the system and displayed in the window.

3 After the jobs that you want to track are displayed in the window, you can modify the information that is displayed for each job. For more information, refer to Defining and Saving Job Search Information on page 247. In addition, you can perform various job modifications, as described in Managing Tracked Jobs on page 247.
Defining and Saving Job Search Information

After searching for the jobs that you want to track, you can modify the information that is displayed for each job, and save the tracked jobs in an Excel file.

The displayed information for each job depends on the information that was defined the last time that the Track Jobs window was displayed. The job information shown in Figure 62 on page 245 includes: Job #, Status, Job Type, Job Name and Creation Date. However, you can select other job fields.

To define the job information and save results:

1. To define what job information is displayed for each job:
   a. Click Column selection.
   b. In the Column Selection window, select the columns to be displayed in the Track Jobs window.
   c. Click OK.

2. To save the list of tracked jobs in an Excel file:
   a. Click Excel Report.
   b. In the Column Selection window, select the columns to that you want to save in the Excel file.
   c. Click Create Excel File.
   d. After the system creates the Excel file, you are requested to specify where to save the report.

3. After the jobs that you want to track are displayed in the window, you can perform various job modifications, as described in Managing Tracked Jobs on page 247.

Managing Tracked Jobs

This section describes the job modifications that you can perform in the Track Jobs window, after the tracked jobs are displayed:

- Viewing Job Details.
- Changing Job Status.
- Deleting Jobs.
- Viewing and Editing Job Properties.
- Viewing and Editing Job Pricing.
- Viewing and Editing Job Ticket.
- Viewing and Editing Order Pricing.
- Reprinting Job.
- Saving a Job as a Template.
- Searching for an Order.
The available job modification options depend on the job status. For example, reprinting a job and search for an order are not available for jobs that are ready to be ordered.

Viewing Job Details

The bottom panel of the Track jobs - Job List window displays the details of the job that is selected in the job list panel of the window. These details include, for example, Job Type, Quantity, and Shipping Date. You can preview the job, view the files that are attached to the job, and perform various other tasks. For more information on job details, see The Job Details Panel on page 217.

Changing Job Status

Sometimes the job status is changed outside the Web Services system, and you need to reflect this change within the Web Services system. You can do this from within the Track Jobs window.

The job status in the production process is not changed; only its status within the Web Services system.
To change a job status:

1. Select the job in the Track Jobs window, and click Change job status; the Change Job Status window appears.

Figure 65: Change Job Status window

2. Select one of the four status options, and click Commit Change. By default, the Do not change the Job Status option is selected.

Deleting Jobs

You can delete jobs from the Track Jobs window. For example, if the job was canceled, or the job has been shipped and delivered. Deleted jobs are saved within the Web Services system, and can be displayed.

To display deleted jobs: select Tasks > Track Jobs, and on the Track Jobs ribbon, click Deleted.

- Select the job that you want to delete in the Track Jobs window, and click Delete job; the Delete Jobs confirmation message appears. Click Yes to confirm the job deletion.
Viewing and Editing Job Properties

You can view basic job properties, preview the job, and modify some of the job properties from the Track Jobs window.

To view and edit job properties:

1. Select the job in the Track Jobs window, and click Job Properties; the Job Properties dialog box appears. See Figure 51 on page 219.

2. Click to preview the job.

3. You can view basic job properties, and modify properties, as needed. For more information on job properties, see Viewing and Editing Job Properties on page 219.

Viewing and Editing Job Pricing

You can view job pricing details, and if necessary, edit the details.

To view and edit job pricing:

1. Select the job in the Track Jobs window, and click Job Pricing; the Job Pricing dialog box appears.

Figure 66: Job Pricing dialog box

2. View the pricing details of the pricing plan that was defined for the job. If necessary, you can edit the pricing details, select another pricing plan or create a new plan. For more information on job pricing, see Pricing Process Overview on page 178.
Viewing and Editing Job Ticket
You can view the job ticket, and if necessary, edit the details.

To view and edit job ticket:
1. Select the job in the Track Jobs window, and click Job Ticket; the Job Ticket Creation dialog box appears. See Figure 58 on page 230.
2. View the job ticket details. If necessary, you can edit the job ticket details. For more information on creating a job ticket, see Creating a Job Ticket on page 230.

Viewing and Editing Order Pricing
You can view and edit the pricing of the order to which the job belongs.

To view and edit order pricing:
1. Select the job in the Track Jobs window, and click Order Pricing; the Order Pricing dialog box appears.
2. View the order pricing details. If necessary, you can edit the order pricing details. For example, add items that are part of the order. For more information on order pricing issues, see Pricing on page 175.
Reprinting Job

The Reprint Job option allows you to submit a job to be reprinted directly from the Track Jobs window.

To reprint a job:

1. Select the job in the Track Jobs window, and click Reprint Job; the Reprint dialog box appears.

   Figure 68: Reprint dialog box

2. The job's printing definition is shown in the dialog box, as it was defined during the job ordering process.

   For more information on printing jobs, see Defining Print Settings on page 33.
**Saving a Job as a Template**

The **Save as Template** option allows you to save a job as a template, and then use the template when ordering a new job.

**To save a job as a template:**

1. Select the job in the **Track Jobs** window, and click **Save As Template**; the **Save As Template** dialog box appears.

![Figure 69: Save Job As Template dialog box](image)

2. Define the template properties. For more information on saving jobs as templates, see [Creating a New Template from an Existing Job](#) on page 154.

**Searching for an Order**

The **Search Order** option allows you to search for all the jobs that are contained in the same order as the selected job. This information might be useful if, for example, you want to know the status of other jobs in that order.

- Select the job in the **Track Jobs** window, and click **Search Order**. The system creates an automatic filter according to the selected job’s order number and runs the search. The **Track Jobs - Job List** window is populated with all the jobs in the selected order.
You can use FreeFlow Web Services Direct Marketing Links to enhance your Print Buyers’ business opportunities with the ability to provide specialized services through the use of customized templates. These templates are created and then customized by integrating external application plug-ins. After purchasing an Web Services Direct Marketing Links license, the relative module adaptors are provided to you by HP to enable use of the modules described below.

This chapter contains information about the following Direct Marketing Links plug-ins:

- **DirectSmile Image Generator** – create personalized image layouts and designs, increase the impact of direct mail.
- **XMPie PersonalEffect Integration** – enables Print Buyers to effectively reach their customers via print, web, and email, within the framework of dynamic publishing campaigns.
- **USADATA** – assign templates automatically to mailing lists targeting all types of audiences.
- **Local DB List Acquisition** – incorporate local address databases to your system template.
DirectSmile Image Generator

You can use DirectSmile Image Generator to create personalized image layouts and benefit from almost unlimited design possibilities. You can increase the impact of direct mail and narrow the distance between your Print Buyers and their customers, using the DirectSmile Image Generator.

This section describes how to use DirectSmile Image Generator within Web Services templates, and contains the following topics:

- Installing DirectSmile Image Generator
- Creating a Template with a DirectSmile Image
- Ordering a Job from a Template with a DirectSmile Image.

You are required to purchase DirectSmile Image Generator .dset files (DirectSmile Image sets) and add them in the DirectSmile Image application.

Ensure that all prerequisite software and components are properly installed and configured before beginning template creation.

Both Print Services Providers and Print Buyers can create Templates only if you have Manage Template privileges.

Installing DirectSmile Image Generator

New Setup

To install and setup DirectSmile Image Generator on the Web Services server, complete the following steps:

1. From the Partner’s Login, download the DirectSmile Image adaptor zip file to the Web Services server.
2. Double-click to open the zip file and then double-click the setup launcher; the setup wizard appears.
3. Follow the wizard steps to Finish.

It is recommended not to make any changes to the Destination Folder path.

Verification

To verify the DirectSmile Image setup on the Web Services server, complete the following steps:

1. In Web Services, on the Print Service Provider side, navigate to the Info Center.
2. In the Grid Extensions panel, verify that the DirectSmile Image icon is present and selected.
**Upgrade**

In order to upgrade from V1.0 to V1.1, complete the following steps:

1. Navigate to **Start > Control Panel > Add or Remove Programs**.
2. Locate the DirectSmile Image Generator application and then click **Remove**; the application is removed from the server.
3. Locate and run the DirectSmile V1.1 Installer.

**Creating a Template with a DirectSmile Image**

After creating a Web Services template, create a template with a DirectSmile Image.

1. On the Print Buyer side, click the **Manage Templates** tab; the **Templates** window appears.
2. Click the **Create a new Template** link; the **Choose Job Type** dialog box appears.
3. Select a job type and click **Select**; the **General Properties** window appears.
4. Type a template name in the **Template Name** field.
5. (Optional) Click the **Change Thumbnail** link to change the thumbnail image.
6. Type valid template property information in the fields provided.
7. Click **Save & Continue**; the **File Upload** window appears showing the **Upload File** view.
8. Browse to the file and click **Save & Continue**; the **Preflight** view appears.
9. To view the **File Report**, click the **Click here to review these problems** link; the template properties are displayed as well as any preflight problems.
   - Click the \( \text{What is} \) and **Click here** links to view preflight problem information. Edit as necessary.
10. Click **Save & Continue**; the **Intent** view appears with the **Web Services Intent List**.

This can also be performed on the Print Service Provider side, by first logging in as Print Service Provider and navigating to **Accounts > Store Setup > Templates**. Continue from Step 2.
Use the Web Services Intent List controls to add tabs, edit properties, and edit the order of Intent List elements:

- adds tab for the Print Buyer to define intent in separate pages
- accesses the Edit Joblet Property dialog box
- moves the selected joblet up a position in the list
- moves the selected joblet down a position in the list
- deletes the selected joblet from the list

Select the Visible column check box to specify a tab is made visible.

Click Save & Continue; the Variable Information window appears, showing the Define Fields view.

To create a variable data template:

1. In the Variable Information window, select VDP (data uploading/editing) in the dropdown list; the Form Editor button is active.

2. Click the Form Editor button; the Form Editor appears.

3. Click New, and in the New Field dialog box select Text and then click OK; a Text Step appears in the Field Name list.

   Alternatively, you can use the selective upload to define images, or you can upload images in the design template or elsewhere. For example SMS Designer, and have the field pre-defined.

4. Click New again, and in the New Field dialog box, select Image and click OK; an Image Step appears in the Field Name list.

5. Click the Image Field name and select the Use Image Generator check box; the Image Generator dropdown list and Settings link appear.

To integrate the template with a DirectSmile Image:

1. In the Generator dropdown list, select DirectSmile Image Generator and click the Settings link; the DirectSmile Parameters dialog box appears.

2. Set the resolution and in the Template File dropdown list, select a .dset (DirectSmile Image sets).

3. In the Text dropdown lists, choose how the text is to be applied:

   - Embedded – Text is permanent and appears on each template page (hidden from the user).
     
     Type text in the Text field and click Save.
     
   - Linked – The text is linked in the existing template field (variable for the user).
Select the Form Editor field name in the Text dropdown list and click Save.

Close the Layout Preview and then click the Form Editor field name.

Type text into the Default Text field and click OK. (For the Preview only.)

4 Click OK; the Preview the Template window reappears.

5 Click Save & Continue; the Save As Template window appears.

6 Type a name, include reference information, and select a filing folder.

7 Click Finish.

**Ordering a Job from a Template with a DirectSmile Image.**

You can create print jobs after the DirectSmile Image is integrated with the template.

1 On the Print Buyer side, in the Order Jobs window, select the template created in the above procedure.

2 Click Save & Continue; the Enter Variable Data window appears.

3 Type data and click Add to Cart and Checkout; the Shopping Cart window appears.

4 Complete the Print Buyer workflow process. For information about the Print Buyer workflow, refer to FreeFlow Web Services Print Buyer Guide.
XMPie PersonalEffect Integration

FreeFlow Web Services XMPie PersonalEffect enables Print Buyers to effectively reach their customers via print, web, and email, within the framework of dynamic publishing campaigns. By integrating XMPie PersonalEffect with Web Services, Print Buyers can access the XMPie PersonalEffect application using the Web Services workflow.

XMPie PersonalEffect with Web Services facilitates the following possibilities:

- Print Buyers can access, customize, and order VI campaigns directly from Web Services.
- Dynamic proofing and the generation of all VI output formats, supported in PersonalEffect, and are available directly from Web Services, in a completely transparent way.
- An integrated, online solution that places a Print Service Provider at the center of all relevant media campaign information.

The following chapter describes the procedure involved in importing an XMPie PersonalEffect template to the Web Services system. The chapter continues by outlining how to create a job from an XMPie PersonalEffect template located in the Web Services system and contains the following topics:

- Installing XMPie PersonalEffect
- XMPie PersonalEffect Server Information
- Importing an XMPie PersonalEffect Template to the Web Services System
- Restrictions and Known Limitations

The XMPie PersonalEffect application must be locally installed on the same domain or workgroup as Web Services.

Before using XMPie PersonalEffect, the XMPie PersonalEffect server’s IP address, Customer Name, User, and Password must be accessed.

An expert level of understanding of the XMPie PersonalEffect accounts and campaigns, and variable template creation is required to effectively present the templates for order by a Print Buyer.

Installing XMPie PersonalEffect

New Setup

To set up XMPie PersonalEffect in Web Services, complete the following steps:

1. On the Print Service Provider side, Navigate to System Setup > Integration > External Systems > XMPie PersonalEffect; the XMPie PersonalEffect window appears.

2. Select the Enable checkbox.

3. Enter account details.
4 Click OK.

Upgrade

In order to upgrade from V1.0 to V1.1, complete the following steps:

1 Navigate to Start > Control Panel > Add or Remove Programs.
2 Locate the XMPie PersonalEffect application and then click Remove; the application is removed from the server.
3 Locate and run the XMPie PersonalEffect V1.1 Installer.

XMPie PersonalEffect Server Information

- Server IP:
- Customer:
- User:
- Password:

Print Service Provider Side

Set-up Configuration

You need to create a link for Account(s) and Campaign(s) between the XMPie PersonalEffect Server and Web Services.

To create a link for Account(s) or Campaign(s) between the XMPie PersonalEffect Server and Web Services:

1 On the Print Service Provider side, select System Setup > Integration > External Systems; the External Systems window appears.
2 In the Systems pane, select XMPie PersonalEffect.
3 Type the following XMPie PersonalEffect parameter values in the fields:
   - Server IP
   - Production Server Local IP
   - Customer
   - User
   - Password
4 Click OK.
Configuration Check

To verify the configuration settings, perform the following step:

Click Check Configuration in the Set-up Configuration panel; the Production Server Tests window appears.

If you have configured a setting correctly, the status in the Production Server Tests window appears as Passed. However, when a setting has been configured incorrectly, the status appears as Failed and the Production Server Tests window displays a comment message on the failure.

### Table 24: Configuration Check

<table>
<thead>
<tr>
<th>Test</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMPie Api calls</td>
<td>Verify that the XMPie server is installed. Verify in the Settings view that the XMPie Server Local IP field is correctly configured.</td>
</tr>
<tr>
<td>Validate Login Info</td>
<td>Verify that the XMPie server is installed. Verify in the Settings view that the Customer, User, and Password fields are correctly configured.</td>
</tr>
<tr>
<td>Copy file to XMPie server</td>
<td>Verify the following:</td>
</tr>
<tr>
<td></td>
<td>- In the Settings view, the Production Server Local IP field is correctly configured</td>
</tr>
<tr>
<td></td>
<td>- The NewEdition folder on the Production server is shared</td>
</tr>
<tr>
<td></td>
<td>- The share name is WebServiceDataFiles with full permission to Everyone</td>
</tr>
<tr>
<td>Copy file from XMPie server</td>
<td>Verify that the XMPie server is installed. Verify in the Settings view that the XMPie Server Local IP field is correctly configured.</td>
</tr>
</tbody>
</table>

To verify XMPie PersonalEffect connectivity with the Web Server server:

1. On the XMPie PersonalEffect server, click Start and then click Run.
2. In the Run dialog box, type the value appearing in the XMPie uProduce Server Tests field box.
3. Click OK.

The appearance of Windows Explorer confirms XMPie connectivity. However, if a dialog box appears prompting you to enter a login and a password, refer to Installing XMPie PersonalEffect on page 260.
Importing an XMPie PersonalEffect Template to the Web Services System

To import an XMPie PersonalEffect template to the Web Services system:

1. On the Print Service Provider side, select Accounts > Store Setup > Templates; the Store Setup Templates window appears.

2. Click the Synchronize with External Repository link; the Import Template Wizard opens, displaying the Choose Document Source window.

3. Select the XMPie option and click Start Import Wizard; the Choose Campaign window appears.

4. In the dropdown lists, select an account and a campaign and click Next; the Choose XMPie PersonalEffect Document window appears.

5. Select a document (template) and click Next; the Choose Job Type window appears.

6. Select a job type and click Next; the Edit Properties window appears.

7. Define the job's properties and click Next; the Choose Output Device window appears.

8. In the dropdown lists, select an output format and an output device and click Next; the Template Pricing window appears.

9. Select the pricing model, type in template pricing values and select the pricing options, and click Next; the Template Attributes window appears.

   Information entered into Template Attributes will be used by the Template search engine for establishing the precise location of the template.

   Data entered to Template Attributes is sourced by the Template search engine to locate a template.

10. Define the template attributes and click Finish; the XMPie template appears in the Customers > Templates window.

   XMPie PersonalEffect templates are represented by the icon.

   Information entered into Template Attributes will be used by the Template search engine for establishing the precise location of the template.

   Data entered to Template Attributes is sourced by the Template search engine to locate a template.
Print Buyer Side

Ordering From a Template

After you have uploaded an XMPie PersonalEffect template to Web Services, the template is ready to use for creating new jobs. The workflow follows regular Web Services template procedures.

To order a new job from an XMPie PersonalEffect template:

1. On the Print Buyer side, click Order Jobs; the Order Jobs window appears.
2. On the Catalog launch pad, click Start Order; the Choose a Template window appears.
3. Select the target template and click Continue; the Enter the Variable Data window appears.
4. To complete the job order, click Add to Cart and Checkout.
5. Proceed with the Web Services workflow. For more information, refer to the FreeFlow Web Services Print Buyer Guide.

Uploading a Database File

To upload a database file into Variable Data Form:

1. Click the Add Records link; the Add Variable Data Records window appears.

   When you use the add records option, complete only those fields marked with the icon.

2. Browse to a target database and click Continue; the Upload Variable Data Database window appears.
3. Select a field name in each Field Name dropdown list and click Continue; the Variable Data Express window appears.

   You can view a PDF preview using the Variable Data Express window. All PDF previews in the XMPie workflow are automatically generated as low resolution images by the XMPie server.

4. Click Add to Cart to send the job to the Shopping Cart, or click Add to Cart and Checkout to complete the workflow.
Restrictions and Known Limitations

Imposition

The Imposition feature cannot be used with the VDX format.

USADATA

Successful business managers understand that a direct marketing campaign is not complete without a clearly defined audience. Using USADATA, you can select a template and automatically assign to it a mailing list.

This section describes how to create install and configure the USADdata module, as well as use the templates and order jobs using the USADATA module. It contains the following topics:

- Installing USADATA
- Creating a Template with a USADATA Database
- Ordering a Job with a USADATA Database

You must obtain a USAData account at the following site:


Make sure that the account is set up to integrate with FreeFlow Web Services.

You can create Templates only if you have Manage Template privileges.

Installing USADATA

New Setup

To install USADATA, complete the following steps:

1. From the Partner’s Login, download the USADATA adaptor zip file to the Web Services server.
2. Double-click the zip file and then double-click the setup launcher; the setup wizard appears.
3. Follow the wizard steps to Finish.

It is recommended not to make any changes to the Destination Folder path.
To set up USADATA in the Web Services system, complete the following steps:

1. On the Print Service Provider side, navigate to **System Setup > Integration > External Systems > USADATA**; the USADATA window appears.
2. Select the **Enable** checkbox.
3. Enter account details.
4. To run on the production server, enter the following Web Services URL: http://leadsengine.usadata.com/service.asmx.
5. Click **Check Connection** to perform a connection check.
6. Click **Update Queries**.

By entering a number (representing seconds) into the GetStatus Check Interval field, the system can perform ongoing status checks of the USADATA database download.

**Verification**

Verify that the USADat module appears in the Info Center, under the Grid Extensions pane, and has a check mark by its side. This indicates that there is an active license for the USADat module.

**Upgrade**

In order to upgrade (for example from V1.1 to V1.3), complete following steps:

1. Navigate to **Start > Control Panel > Add or Remove Programs**.
2. Locate the USADATA application and then click **Remove**; the application is removed from the server.
3. Locate and run the USADATA V1.3 Installer.
Creating a Template with a USADATA Database

To create a template with a USADATA database, you first create a new Web Services template.

1. On the Print Buyer side, click the Manage Templates tab; the Templates window appears.
2. Click the Create a new Template link; the Choose Job Type dialog box appears.
3. Select a job type and click Select: the General Properties window appears.
4. Type a template name in the Template Name field.
5. (Optional) Click the Change Thumbnail link to change the thumbnail image.
6. Type valid template property information in the fields provided.

Information you provide in the General Properties window is made available for template search filters.

7. Click Save & Continue; the File Upload window appears.
8. Browse to the file and click Save & Continue; the Preflight view appears.
9. To view the File Report, click the Click here to review these problems link; the template properties are displayed as well as any preflight problems.
   - Click the What is and Click here links to view preflight problem information. Edit as necessary.
10. Click Save & Continue; the Intent view appears with the Web Services Intent List.
11. Use the Web Services Intent List controls to add tabs, edit properties, and edit the order of Intent List elements:
   - Add Tab – adds a new tab to the list
   - Edit – accesses the Edit Joblet Property dialog box
   - Move Up – moves the selected tab up a position in the list
   - Move Down – moves the selected tab down a position in the list
   - Remove – deletes the selected tab from the list
12. Select the Visible column check box to specify a tab is made visible.
13. Click Save & Continue; the Variable Information window appears, showing the Define Fields view.
To create a variable data template:

1. In the Variable Information window, select VDP (data uploading/editing) in the dropdown list; the Selective Upload button is active.
2. Click the Selective Upload button; the Modify PDF dialog box appears.
3. In the Select Text/Image dropdown list, select Select text/Image; the Selected Fields box appears.
4. Select areas of the PDF to create variable data fields. For each data field, define a step name in the Selected Fields box.
5. Click OK; the Font Report dialog box appears and indicates if the font is missing. If a font is not available, select another font and click OK.
6. The Form Editor window reappears, displaying the newly selected fields, and the List Acquisition button.

To include the USADATA database:

1. In Form Editor window, click the List Acquisition button; the Data Acquisition window appears in the Query view.
2. In the Data Acquisition Sources dropdown list, select USADATA.
3. In the Query Type dropdown list, choose one of the following options:
   - Consumer Lists – define Query Input Fields for direct marketing campaign lists designed for specific consumer audience targeting such as by age, gender, real-property data, and industry.
   - Business Lists – define Query Input Fields for direct marketing campaign lists designed specifically for the business sector.
4. Click Query Input Field, the Query Input Field window appears in the Consumer view.
5. Assign an input field to Geographic Criteria.

   Geographic Criteria is a mandatory field. It is recommended that you use at least one more criteria.

6. Choose another Query Input Field and assign an input field.
iForm fields include the following options:

- **Explicit** – the query criteria is determined in advance and Print Buyer users cannot influence it. There are two type of fields:
  - Text field
  - Dropdown list field

  When using Explicit with the Geographic Criteria, only text fields appear. The remaining fields are closed fields, and show the dropdown containing the parameters.

- To enter fixed data, select **Explicit** and in the **Explicit** field, enter the values according to the Query Input Field tables found in the *Direct Marketing Links*.
- **Not used** – removes the specific Query Output Field.
- **Form Editor Field Names** – the Print Buyer user can map names of the **Form Editor** fields to that of the **Query Input** fields.
- Using CTRL+SHIFT selects more than one value in the Explicit values.

7 Click **Query Output Field**; and in the **Query Output Field** dropdown lists, select and map iForm Populated fields to **Query Output** fields.

8 Click **OK**; the **Form Editor** window reappears.

To facilitate the database criteria search, with the exception of one Field name, make each field non-editable by selecting the fields, and then selecting the **Non-Editable** option.

9 Click **OK**, and in the **Preview Template** window, click **Continue** and save the template as USADATA.

### Ordering a Job with a USADATA Database

You can create print jobs after USADATA database is integrated with the template.

1 On the Print Buyer side, in the **Order Jobs** view, on the **Order from Our Catalog** panel, click **Start Ordering**; the **Choose a Template** window appears.

2 Select the target **USADATA** template and click **Continue**; the **Enter the Variable Data** window appears.

3 Type data in the field and click **Add To Cart**.

4 Select the explicit values in the list.
You can use the cached option in order to save time and money (reordering existing records). Records with the same input parameters are first checked locally on the existing database. If items do not already exist, they are ordered via USADATA.

Limitations by USADATA:
- The test account is configured in USADATA; between 100 to 500 records can be ordered.
- The production account can order 100 to 65000.
Local DB List Acquisition

Successful business managers understand that a direct marketing campaign cannot be complete without a clearly defined audience. Local DB List Acquisition enables you to upload and incorporate data from local address databases, which can then be uploaded to a template in the Web Services system.

This chapter describes how to create templates and order jobs using the Local DB List Acquisition module, and includes the following sections:

- Installing Local DB List Acquisition
- Creating a Template with a Local Database
- Ordering a Job with a Local Database

Ensure that all prerequisite software and components are properly and configured before beginning template creation.

You can create Templates only if you have Manage Template privileges.

Installing Local DB List Acquisition

New Setup

To install Local DB List Acquisition, complete the following steps:

1. From the Partner’s Login, download the Local DB List Acquisition adaptor zip file to the Web Services server.
2. Double-click to open the zip file and then double-click the setup launcher; the setup wizard appears.
3. Follow the wizard steps to Finish.

It is recommended not to make any changes to the Destination Folder path.

4. Navigate to NewEdition > IPanel > Integrations > ListAcquisition > LocalDB
5. Edit config.xml; a block for each query can be entered under ‘database’.
The format of the file is:

```xml
<query id="enter query id here" name="enter name of query here"
DSN="dsn=enter ODBC name here">
  NOTE: dsn=<ODBC System DNS Name>(e.g. DSN="dsn=listDB" or
  DSN="Dsn=listDB;uid=sa;pwd=sa")
  <queryStr>Enter a "select" query here. Replace in the query fields
to be provided to the queries by designating them _nw_field:1,
  _nw_field:2, _nw_field:3, etc </queryStr>
  <input>
    <parameter id="1" name="enter here name to be used in iFormEditor to
      map to field 1 in the query above" />
    <parameter id="2" name="enter here name to be used in iFormEditor to
      map to field 2 in the query above" />
    ... repeat for all fields in the query ...
  </input>
  <output>
    <field id="1" name="enter here name to be used in iFormEditor to map
to this field in the results of the query above" sqlName="enter here
      name of the field in the results og the query above" />
    <field id="2" name="enter here name to be used in iFormEditor to map
to this field in the results of the query above" sqlName="enter here
      name of the field in the results og the query above" />
    <field id="3" name="enter here name to be used in iFormEditor to map
to this field in the results of the query above" sqlName="enter here
      name of the field in the results og the query above" />
    ... repeat for each output from the query which needs to be exposed in
      iFormEditor ...
  </output>
</query>
... repeat for other queries ...
```

6 From the Info Center, verify that the Local DB List Acquisition icon is present and is accompanied by a checkmark.

**Upgrade**

In order to upgrade from V1.0 to V1.1, complete the following steps:

1 Navigate to **Start > Control Panel > Add or Remove Programs**.

2 Locate the Local DB List Acquisition application and then click **Remove**; the application is removed from the server.

3 Locate and run the Local DB List Acquisition V1.1 Installer.
Creating a Template with a Local Database

To create a template with a Local DB List Acquisition, you first create a new Web Services template.

1. On the Print Buyer side, click the Manage Templates tab; the Templates window appears.
2. Click the Create a new Template link; the Choose Job Type dialog box appears.
3. Select a job type and click Select: the General Properties window appears.
4. Type a template name in the Template Name field.
5. (Optional) Click the Change Thumbnail link to change the thumbnail image.
6. Type valid template property information in the fields provided.

   The information you provide in the General Properties window is made available for template search filters.

7. Click Save & Continue; the File Upload window appears showing the Upload File view.
8. Browse to the file and click Save & Continue; the Preflight view appears.
9. To view the File Report, click the Click here to review these problems link; the template properties are displayed as well as any preflight problems.

   Click the What is and Click here links to view preflight problem information. Edit as necessary.
10. Click Save & Continue; the Intent view appears with the Web Services Intent List.
11. Use the Web Services Intent List controls to add tabs, edit properties, and edit the order of Intent List elements:

   - adds a new tab to the list
   - accesses the Edit Joblet Property dialog box
   - moves the selected tab up a position in the list
   - moves the selected tab down a position in the list
   - deletes the selected tab from the list

12. Select the Visible column check box to specify a tab is made visible.
13. Click Save & Continue; the Variable Information window appears, showing the Define Fields view.
To create a variable data template:

1. In the Variable Information window, select VDP (data uploading/editing) in the dropdown list; the Selective Upload button is active.

2. Click the Selective Upload button; the Modify PDF dialog box appears.

3. In the Select Text/Image dropdown list, select Select text/Image; the Selected Fields box appears.

4. Select areas of the PDF to create variable data fields. For each data field, define a step name in the Selected Fields box.

5. Click OK; the Font Report dialog box appears and indicates if the font is missing. If a font is not available, select another font and click OK; the Form Editor window reappears, displaying the newly selected fields, and the List Acquisition button.

To integrate the template with a local database:

1. In Form Editor window, click the List Acquisition button: the Data Acquisition window appears in the Query view.

2. In the Data Acquisition Sources dropdown list, select Local DB List Acquisition.

3. In the Query Type dropdown list, choose one of the following options:
   - Family Targeting – define Query Input Fields for direct marketing campaign lists designed for specific consumer audience targeting by local address databases.
   - Real Estate – similar to Family Targeting, containing fewer Query Input Fields, and specifically focused on the real estate sector.

   Family Targeting and Real Estate are supplied in the sample files. You can add and edit the Query Type field in the config.xml file relating to this integration. The Local DB List Acquisition database is connected through the ODBC.

4. From the dropdown lists, map the Query Output fields to the iForm fields.

   To enter precise data into the iForm fields, select Explicit and type the information into the Explicit field.

5. Click Query Output Field; the Query Output Field view appears.

6. Select elements in the dropdown lists to map the Query Output fields to the iForm Populated fields.

7. Click OK; the Form Editor reappears.

   To facilitate the database criteria search, with the exception of one Field name, make each field non-editable by selecting the fields and then selecting the Non-Editable option.
8  Click OK; the Preview Template window appears.

9  Click Continue and save the template as Local DB List Acquisition.

**Ordering a Job with a Local Database**

You can create print jobs after a local database is integrated with the template.

1  On the Print Buyer side, in the Order Jobs view, on the Order from Our Catalog panel, click Start Ordering; the Choose a Template window appears.

2  Select the target Local DB List Acquisition template and click Continue; the Enter the Variable Data window appears.

3  Enter the data into the fields and click Add To Cart.

4  Select a number from the Quantity dropdown list, click Get Quote and complete the ordering process.
FreeFlow Web Services Credit Card enables Print Buyers to carry out payment for Print Provider services through the use of an credit card service. Credit Card is available according to licensing authorization.

Currently, Web Services supports Credit Card through the following payment services:

- Authorize.Net ([www.authorize.net](http://www.authorize.net))
- Paymaster ([www.computop.de](http://www.computop.de))
- PayPal ([www.paypal.com](http://www.paypal.com))
- SaferPay ([www.saferpay.com](http://www.saferpay.com))
- Tranzila ([www.tranzila.com](http://www.tranzila.com))
- DebiTech ([www.dibspayment.com](http://www.dibspayment.com))
- Moneris ([www.moneris.com](http://www.moneris.com))
- Citelis ([www.citelis.fr](http://www.citelis.fr))

To work with Payment Services not yet supported by the system, refer to Adding Web Services Credit Card Service Vendors on page 279.
Integrating with Web Services Credit Card Vendors

To configure Web Services to work with one of the supported online vendors:

1. Log in to Web Services and go to System Setup > Integration > Credit Card.
2. Select the online vendor from the Payment Service dropdown list and click Settings.
3. Enter the account details, for example account name and password, as they were provided when you registered with the vendor. For a list of the account details for each vendor, refer to Table 25.
4. Click OK.
5. Go to Accounts > Account Setup > Preferences and select the account for which you want to change the settings.
6. Select the CC (Credit Card) check box. Credit card becomes the default payment method.
7. Click Save.

Table 25: Vendor Account Details

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorize.net</td>
<td><img src="##" alt="Login ID" /> <img src="##" alt="Transaction Key" /></td>
</tr>
<tr>
<td>Paymaster</td>
<td><img src="##" alt="Merchant ID" /> <img src="##" alt="Blowfish Key" /></td>
</tr>
<tr>
<td>PayPal</td>
<td><img src="##" alt="Merchant ID (email)" /></td>
</tr>
<tr>
<td>SaferPay</td>
<td><img src="##" alt="Account ID" /></td>
</tr>
<tr>
<td>Tranzila</td>
<td><img src="##" alt="Merchant ID" /></td>
</tr>
<tr>
<td>DebiTech</td>
<td><img src="##" alt="Account Name" /></td>
</tr>
<tr>
<td>Moneris</td>
<td><img src="##" alt="Store ID" /> <img src="##" alt="Store Key" /></td>
</tr>
<tr>
<td>Citelis</td>
<td><img src="##" alt="Store ID" /> <img src="##" alt="Store Key" /></td>
</tr>
</tbody>
</table>

You must be registered with a credit card vendor before proceeding.
Adding Web Services Credit Card Service Vendors

To add Credit Card vendors to the system’s list of available vendors, send an e-mail to your Web Services representative with the following information:

- Name of the Payment Service vendor
- Website of Payment Service vendor
- Test account in the Payment Service vendor site or a description of the way in which to create a test account
- Documentation, in English, outlining the means by which to interact with the Payment Service vendor’s site or a link to a location where such documentation can be downloaded

Adding Credit Card vendors is a service that is charged to the Print Provider. For more information, contact your local distributor.
Excel Pricing has been developed for Print Providers who prefer a pricing solution other than that provided by FreeFlow Web Services. The reasons you might prefer an extraneous pricing system are two-fold:

- You have your own unique way of calculating the price and are not able to find a satisfactory way in which to define pricing within the Web Services system
- You already have your own tool by which you can define a price list and calculate prices

Excel Pricing enables you to upload an Excel file that contains all pricing parameters and then assign the file to an intended customer.

| ![Excel Pricing Information Flow](#) |

**By working with an Excel file, all calculation methods are possible (i.e. any formula or any information that will generate the specific price can be employed).**

**To activate Excel pricing, you must purchase the Business Links module.**

**Working with an Excel File**

To work with Excel Pricing, you must first create an Excel file (see Excel Pricing File Format on page 283 for more information) and then upload the file to the Print Buyer account. When the Print Buyer clicks on Get Quote, all relevant information related to the job and customer, is exported from Web Services to the Excel file.

The Excel file receives the new information and, according to the formulas that you provided, updates and calculates the price. The price and the output device information are automatically imported back to Web Services, where it is displayed to the Print Buyer.

**Figure 71: Excel Pricing Information Flow**

When working with Excel Pricing, you can price a multitude of additional parameters. A few examples are: B&W and color pages, click charges, job tickets, and paper types.
Settings in Web Services

This section describes the interaction between Web Services and the pricing file for a specific customer.

The following issues are covered in this section:

- How to assign an Excel pricing file to a Print Buyer
- How to download an Excel file that is assigned to a customer

Assigning Excel Pricing to a Print Buyer

To assign a pricing file to a Print Buyer, perform the following:

1. Log in to Web Services and go to Accounts > Account Setup > Preferences.
2. In the Pricing sub panel, select Excel from the Customer Pricing Model dropdown menu; the Excel File link becomes enabled.
3. Select the Excel file to be assigned to the specific customer.

Importing/Exporting the Excel Pricing File

You can upload an unlimited number of Excel files for pricing, however, only one Excel file can be assigned to a customer.

To upload an Excel file:

1. Click on the Excel File link; the Excel File dialog box appears and displays a list of all of the Excel files that exist within Web Services.

The Sample Excel Pricing.xls and the Sample Excel Pricing with Set.xls are the samples files provided by the system and demonstrate the general format that Excel Pricing sheets should follow. Do not delete these files since they will act as a basis for the Excel Pricing sheets. For more information about the Excel Pricing file format, refer to Excel Pricing File Format on page 283.

2. Select the files that you want to upload and click Upload Files.
Excel Pricing File Format

Web Services provides two Excel sample files:

- Sample Excel Pricing.xls
- Sample Excel Pricing with Set.xls

Excel file for pricing has a special format which cannot be modified. In this section, a full description of the file format is provided to help you create your own pricing mechanisms using the Excel Pricing model. These descriptions are based on the content in the Sample Excel Pricing.xls file.

Understanding the File Format

The Sample Excel Pricing.xls file contains 2 sheets:

- Info
- Calculation

These sheets cannot be modified, removed, or deleted, and must be present when creating the Excel file. The Calculation sheet contains 4 columns:

- Column A - Fields names that are exported from Web Services.
- Column B - Values of the field names exported from Web Services.
- Column C - Fields names that are imported into Web Services.
- Column D - Values of the field names that are imported into Web Services.

You cannot make any modifications in Columns A, B or C. You need to generate values for Column D according to calculations inserted in each cell.

Column A

Column A contains field names related to job properties, shipping and print buyer information, which are exported from Web Services. Table 26 lists the fields in Column A and their descriptions:
### Column B

**Table 26: Column A Fields (Sheet 1 of 4)**

<table>
<thead>
<tr>
<th>Fields Name</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>JobID</td>
<td>Unique job# that the system generates</td>
</tr>
<tr>
<td>JobName</td>
<td>Job name as it appears in the Shopping cart</td>
</tr>
<tr>
<td>JobStatusID</td>
<td>Job status ID as it appears on the Database</td>
</tr>
<tr>
<td>JobStatusName</td>
<td>Job status</td>
</tr>
<tr>
<td>CustomerRefCode</td>
<td>Reference code that the customer entered</td>
</tr>
<tr>
<td>JobTypeID</td>
<td>Job type ID</td>
</tr>
<tr>
<td>JobTypeName</td>
<td>Job type name as defined in the job type library</td>
</tr>
<tr>
<td>JobSubtypeID</td>
<td>Job sub type ID</td>
</tr>
<tr>
<td>JobSubtypeName</td>
<td>Job sub type name as defined in the job type library</td>
</tr>
<tr>
<td>Copies</td>
<td>Number of copies of the job (if it is a VI job the number of copies is for one record)</td>
</tr>
<tr>
<td>FlatCount</td>
<td>Number of original pages of this job (for one copy) without folding</td>
</tr>
<tr>
<td>FlatWidth</td>
<td>Job original page width (without folding)</td>
</tr>
<tr>
<td>FlatHeight</td>
<td>Job original page height (without folding)</td>
</tr>
<tr>
<td>FlatSize</td>
<td>Job page size (without folding)</td>
</tr>
<tr>
<td>FlatOrientation</td>
<td>Job page orientation</td>
</tr>
<tr>
<td>FlatSides</td>
<td>Job sides</td>
</tr>
<tr>
<td>PageCount</td>
<td>Number of folded counts of this job (for one copy)</td>
</tr>
<tr>
<td>PageWidth</td>
<td>The job width after folding</td>
</tr>
<tr>
<td>PageHeight</td>
<td>The job Height after folding</td>
</tr>
<tr>
<td>PaperCategory</td>
<td>The paper category (on which the job will be printed) as was defined in the stock library</td>
</tr>
<tr>
<td>PaperTexture</td>
<td>The paper texture (on which the job will be printed) as was defined in the stock library</td>
</tr>
<tr>
<td>PaperBrand</td>
<td>The paper brand (on which the job will be printed) as was defined in the stock library</td>
</tr>
<tr>
<td>PaperColor</td>
<td>The paper color (on which the job will be printed) as was defined in the stock library</td>
</tr>
<tr>
<td>PaperWeight</td>
<td>The paper weight (on which the job will be printed) as was defined in the stock library</td>
</tr>
</tbody>
</table>
### Table 26: Column A Fields (Sheet 2 of 4)

<table>
<thead>
<tr>
<th>Fields Name</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>OutputDeviceID</td>
<td>Printer ID that was assigned automatically by the system</td>
</tr>
<tr>
<td>OutputDeviceName</td>
<td>Printer name that was assigned automatically by the system</td>
</tr>
<tr>
<td>PrintQualityID</td>
<td>Print quality ID as defined in the printer</td>
</tr>
<tr>
<td>PrintQualityName</td>
<td>Print quality name as defined in the printer (cost effective, high quality)</td>
</tr>
<tr>
<td>ColorGroup</td>
<td>The job color details: process or B/W</td>
</tr>
<tr>
<td>BlackColorCount</td>
<td>If B/W according to the job properties</td>
</tr>
<tr>
<td>ProcessColorCount</td>
<td>Number of processes according to the job properties</td>
</tr>
<tr>
<td>SpotColorCount</td>
<td>Number of spot colors according to the job properties</td>
</tr>
<tr>
<td>RequiredDate</td>
<td>The delivery date</td>
</tr>
<tr>
<td>UrgencyID</td>
<td>Urgency ID according to the definition in the system</td>
</tr>
<tr>
<td>UrgencyRate</td>
<td>Urgency Rate according to the definition in the system</td>
</tr>
<tr>
<td>JobTaxRate</td>
<td>Tax rate for this job</td>
</tr>
<tr>
<td>PdfFlatCount</td>
<td>Number of pages of this job (for one copy) without folding, after converting to PDF</td>
</tr>
<tr>
<td>PdfFlatWidth</td>
<td>Job original page width (without folding) after converting to PDF</td>
</tr>
<tr>
<td>PdfFlatHeight</td>
<td>Job original page height (without folding) after converting to PDF</td>
</tr>
<tr>
<td>PdfBlackColorCount</td>
<td>If B/W after conversion to PDF</td>
</tr>
<tr>
<td>PdfProcessColorCount</td>
<td>Number of process colors after conversion to PDF</td>
</tr>
<tr>
<td>PdfSpotColorCount</td>
<td>Number of spot colors after conversion to PDF</td>
</tr>
<tr>
<td>PdfBlackAndWhitePageCount</td>
<td>Number of pages of the job that are B/W</td>
</tr>
<tr>
<td>PdfColorPageCount</td>
<td>Number of pages of the job that are process</td>
</tr>
<tr>
<td>VardataCount</td>
<td>Number of records (VI) for this job</td>
</tr>
<tr>
<td>HasForm</td>
<td>Is it an iForm job</td>
</tr>
<tr>
<td>CustomerID</td>
<td>Customer ID (generated by the system when a customer is created)</td>
</tr>
<tr>
<td>CostCenterID</td>
<td>Cost Center ID</td>
</tr>
<tr>
<td>CustomerName</td>
<td>Print Buyer name</td>
</tr>
<tr>
<td>CustomerDiscountRate</td>
<td>Print Buyer discount rate (as set in preferences)</td>
</tr>
<tr>
<td>CustomerTaxRate</td>
<td>Print Buyer tax rate (as set in preferences)</td>
</tr>
<tr>
<td>StaplingType</td>
<td>Stapling type (as defined for this job)</td>
</tr>
</tbody>
</table>
### Table 26: Column A Fields (Sheet 3 of 4)

<table>
<thead>
<tr>
<th>Fields Name</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>StaplingPosition</td>
<td>Stapling position (as defined for this job)</td>
</tr>
<tr>
<td>StapleCount</td>
<td>Staple count (as defined for this job)</td>
</tr>
<tr>
<td>CombBindingType</td>
<td>Comb binding type (as defined for this job)</td>
</tr>
<tr>
<td>CombBindingPosition</td>
<td>Comb binding position (as defined for this job)</td>
</tr>
<tr>
<td>CombThickness</td>
<td>Comb binding thickness (as defined for this job in Inches)</td>
</tr>
<tr>
<td>VardataCount</td>
<td>How many recodes are in a VI job</td>
</tr>
<tr>
<td>LaminatingTexture</td>
<td>Laminating texture</td>
</tr>
<tr>
<td>LaminatingSides</td>
<td>Laminating sides (one side or two sided)</td>
</tr>
<tr>
<td>DrillingPosition</td>
<td>Drilling position (as defined for this job)</td>
</tr>
<tr>
<td>DrillingRadius</td>
<td>Drilling radius (as defined for this job in Inches)</td>
</tr>
<tr>
<td>DrillingHoleCount</td>
<td>Drilling hole counts (as defined for this job)</td>
</tr>
<tr>
<td>CollatingType</td>
<td>Collating (if defined for this job)</td>
</tr>
<tr>
<td>PerfectBindingType</td>
<td>Perfect binding type (as defined for this job)</td>
</tr>
<tr>
<td>PerfectBindingPosition</td>
<td>Perfect binding position (as defined for this job)</td>
</tr>
<tr>
<td>NumberingType</td>
<td>Numbering type (as defined for this job)</td>
</tr>
<tr>
<td>NumberingPosition</td>
<td>Numbering position (as defined for this job)</td>
</tr>
<tr>
<td>NumberingSides</td>
<td>Numbering sided</td>
</tr>
<tr>
<td>HasCustomFinishing</td>
<td>Does this job has custom finishing</td>
</tr>
<tr>
<td>CustomFinishingName</td>
<td>Custom finishing name</td>
</tr>
<tr>
<td>CustomFinishingDescription</td>
<td>Custom finishing description</td>
</tr>
<tr>
<td>FoldCount</td>
<td>Number of folding in the job (for 1 copy)</td>
</tr>
<tr>
<td>ShipToFirstName</td>
<td>First name as appears in the shipping address</td>
</tr>
<tr>
<td>ShipToLastName</td>
<td>Last name as appears in the shipping address</td>
</tr>
<tr>
<td>ShipToFullName</td>
<td>First name and Last name as appears in the shipping address</td>
</tr>
<tr>
<td>ShipToCompany</td>
<td>Company name as appears in the shipping address</td>
</tr>
<tr>
<td>ShipToDepartment</td>
<td>Department name as appears in the shipping address</td>
</tr>
<tr>
<td>ShipToStreet</td>
<td>Street name as appears in the shipping address</td>
</tr>
<tr>
<td>ShipToCity</td>
<td>City name as appears in the shipping address</td>
</tr>
<tr>
<td>ShipToState</td>
<td>State name as appears in the shipping address</td>
</tr>
</tbody>
</table>
When a Print Buyer clicks on the Get Quote button in the Shopping Cart, the values related to the job are exported to Column B. The following windows in Web Services update the values in Column B:

- **Get Quote** - Data concerning the Job properties and customer details will be updated
- **Choose Shipping Address** - Shipping Address information
- **Choose Your Shipping Options** - Shipping date and urgency

Values of measurement - All sizes that are exported to the Excel file are in inches, even if the default language is not English US. You need to convert these values to mm using an Excel formula. For example, to convert Cell B16 from inches to mm use $B16 \times 25.4$.

Fields Format - Excel provides an option for setting the cell format whereby the view is changed but not the value. In the Excel that arrived with the system, all cells are set to General. Cell format can be changed by right-clicking on the cell and selecting the format cell option from the menu. For example, Cell B37, which is the required date value with a number, can be changed to a date format (with any date format).
Column C

Column C contains field names of the pricing and output device information, which are imported into Web Services. Table 27 lists the fields in Column C and their descriptions:

Table 27: Column C Fields

<table>
<thead>
<tr>
<th>Field Names</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost</td>
<td>Cost for the Print Provider</td>
</tr>
<tr>
<td>Price</td>
<td>Customer price without tax and discount</td>
</tr>
<tr>
<td>AdjustedPrice</td>
<td>Customer price + the negative discount</td>
</tr>
<tr>
<td>CustomerPrice</td>
<td>Customer price + the positive discount</td>
</tr>
<tr>
<td>DiscountRate</td>
<td>Discount rate</td>
</tr>
<tr>
<td>Discount</td>
<td>Discount price</td>
</tr>
<tr>
<td>UrgencyRate</td>
<td>Urgency rate</td>
</tr>
<tr>
<td>UrgencyPrice</td>
<td>Urgency price</td>
</tr>
<tr>
<td>TaxRate</td>
<td>Tax rate</td>
</tr>
<tr>
<td>Tax</td>
<td>Tax price</td>
</tr>
<tr>
<td>TotalNoTax</td>
<td>The total price without the tax</td>
</tr>
<tr>
<td>Total</td>
<td>The total price + discount + urgency + taxes</td>
</tr>
<tr>
<td>PressSheetSize</td>
<td>The Run Size that will be used for printing this Job (not obligatory)</td>
</tr>
<tr>
<td>OutputDeviceID</td>
<td>The printer that the Job will be print on (not obligatory)</td>
</tr>
</tbody>
</table>
Column D

You should insert the values for Column D. These are the values imported back to Web Services after the Print Buyer clicks Get Quote.

- **N/A value** - A Print Buyer, using the Excel Pricing model, may receive a pricing error (N/A) in place of the price, after clicking on Get Quote. This is an indication that there is an error in the Column D calculation. To resolve this problem, download the Excel file used for this customer and review the formula for values in Column D.
- **Fields Format** - In Excel, there are options for setting the cell format, which will change the view and not the value. In the file that came with the system, all cells are set to General. An option exists for changing the Excel default cell format by right-clicking on the cell and choosing the format cell option from the menu. For example, Cell D6 is the price that the customer will see in the Shopping Cart. You can set this cell format to be Currency according to your decision (this change will not effect the currency value that was set in Web Services).
- **Field Value** - Column D, Cells D4-D15 can accept only numbers. If the cells contain text, an error will be generated when a Print Buyer clicks on the Get Quote button.
- Ensure that the Excel file used by the Print Buyer for the price calculation is closed prior to the customer ordering. If the file is open and a Print Buyer requests a quote, instead of the price, a Microsoft Excel message will appear on the server.

You can make other changes in the other columns (except A-D) of the Calculation sheet and you can add new sheets to the file. Linking between two Excel files may cause an error, so any information that exists in a different file can be copied to a new sheet in the file that will be used for the Print Buyer.

Excel Pricing with the Book Assembly Module

The file format, which can generate a quote for jobs ordered with the Book Assembly module and for simple jobs, is similar to the file format that was described in the previous section.

This section describes the fields and sheets that were added to the Sample Excel Pricing with Set.xls file:

- **Additional Fields** - In the Calculation sheet, there are 2 new fields which are exported from FreeFlow Web Services
- **Binding** - This field contains the binding style that was chosen for the Book Assembly Job.
- **Material** - The Material that was chosen for this Book Assembly Job. If there is no material for a Job, the value of this field will be set to 0
- **Additional Sheet** - Component sheet was added to the Sample Excel Pricing with Set.xls file. Columns A-F described the Book Assembly components and are exported from FreeFlow Web Services
- **Column A**: Component - describes the component type: Color Pages, B/W, Cover, Tag or any other type that the Print Provider will define
- **Column B**: Component Type - The type of the component that was defined in Column A
- **Column C**: Page Count - Number of pages for the current component
- **Column D**: Paper Type - Paper Type for the current component
- **Column E**: Finishing - Finishing for the current component
- **Column F**: PDF Colors - Number of PDF color pages that were originally uploaded for the current component
Excel Pricing

- The numbers of rows that are added depends on the number of components that were defined for a **Book Assembly** Job.

To import the updated Excel file with Book Assembly, perform the following:

1. Log in to Web Services and go to Accounts > Account Setup > Preferences.
2. In the Pricing sub panel, select **Excel, including Set jobs** from the Customer Pricing Model dropdown menu; the Excel File link becomes enabled.
3. Select the Excel file to be assigned to the specific customer.

The Excel File dialog box displays the Last Output of-Sample Excel Pricing With Set.xls file. Last Output of-Sample Excel Pricing With Set.xls contains all the data that was imported and exported by Web Services during the last use. This means that in this file, you can find all the information about the job being ordered by the Print Buyer when the Print Buyer clicked **Get Quote**.

Excel Programming and Useful Excel Functions

This section lists examples of several useful Excel formulas and functions.

### IF Function

The Excel If function examines whether a certain condition is true or false. If the condition is true, the function will do one thing, if the condition is false, the function will do something else.

**Sample IF Syntax**

Using the IF function, we will select on which printer a job is processed.

If the job is B/W, the printer will be Xerox_DC6060. If this is a process job, the printer will be Xerox_iGen3.

```
=IF(B33="process", "Xerox_iGen3", "Xerox_DC6060")
```

### Vlookup Function

The Vlookup function searches for a value in the first column of a table array and returns a value in the same row from another column in the table array.

**Syntax**: VLOOKUP (lookup_value, table_array, col_index_num, range_lookup)

- lookup_value - the value to search for in the first column of the table_array
- table_array - two or more columns of data that are sorted in ascending order
- col_index - the column number in table_array from which the matching value must be returned. The first column is 1
Range lookup - determines if you are looking for an exact match based on lookup_value. Enter FALSE to find an exact match. Enter TRUE to find an approximate match, which means that if an exact match is not found, then the VLOOKUP function will look for the next largest value that is less than value.

Example

Using the VLOOKUP function, we will define a discount according to number of copies. We set a table of discounts according number of copies. The first column displays the minimum number of copies required to receive the discount displayed in the second column. The function and database appear in the image below:

The lookup_value must be in the first (left) column on the table_array which sometimes can have limits and the user will have to change their own database for this limitation. To solve this limitation, use the functions MATCH and INDEX.

**MATCH**

The Match function searches for a value in an array and returns the relative position of that item.

**Syntax:** MATCH (lookup_value, lookup_array, match_type)

- lookup_value - the value to search for in the lookup_array.
- lookup_array - a range of cells that contains the lookup_value that you are searching for.
- match_type = FALSE or 0: exact match.
- match_type = TRUE or 1: if the exact value was not found the function will look for the closest value but small than the lookup_value).

**INDEX**

The Index function returns a value or the reference to a value from within a table or range.

**Syntax:** INDEX (array, row_num, column_num)

- array - a range of cells or table.
- row_num - the row number in the array to use to return the value.
- column_num - the column number in the array to use to return the value.

**DGET Function**

One of the powerful functions which operates on databases is the DGET function. DGET function retrieves from a database a single record that matches a given criteria.

**Syntax:** DGET (database, field, criteria)

- Database - the range of cells that you want to apply the criteria against.
- Field - the column to retrieve.
- Criteria - table that contains the criteria + column names.
Excel Pricing

VBA

With Excel, there is an option to write a code with VBA. Using this option, you can create any function that you would like, especially for complex pricing calculations. It is important to remember that if you are using this functionality in one of the Excel files, there is a need to change the Macro security on Microsoft Excel that is installed on the server.

To change the Macro security, go to Microsoft Excel/Tools/Options/Security/Macro Security and set the Security Level to Medium.
Set enables you to determine those parameters necessary for a Print Buyer to create a multi-component job.

Set jobs are comprised of an optional binding element such as a binder or a spiral, and components such as color pages, black and white pages, tabs, and blank pages.

A Set job type is identified by a binding style. Therefore the term binding style is used instead of Set job type.
Set Definitions

Set is comprised of several different pieces. This section describes the different parts that make up a book.

Binding Styles

The binding style identifies the job type. To create a binding style, you need to define basic parameters as the type of binding, the possible page sizes, additional materials, pricing, and available components.

The binding collects the components into one physical entity that can contain covers, pages, inserts, and tabs. The binding element can take the form of binders, saddle stitching, perfect binding, wire binding, thermal binding or any other similar means.

Components

Components are the elements comprising a Set. Set is supplied with four default components. You can modify these components, delete them and add as many other components as required.

The default components are:

- Cover - The Cover component is used when the cover has been designed as a separate file encompassing the front cover, spine and back cover of the Web Services Set.
- Tab - The Tab component is used for inserting tabs in a Web Services Set. It is possible to define the text to be printed on a tab and the text parameters. When the Tab component is used, the application takes into account the number of tabs that can fit along a page side and provides feedback if this number has been exceeded.
- Color Pages - A standard component type which can be one or two-sided.
- B/W Pages - A standard component type which can be one or two-sided.

Set Pricing

The price of Set jobs is calculated as follows:

Total Price of a Set = Base Price per unit + [Price per Unit + Price Per Materials + Price Per Components * Pages]
Defining a Set Job Type

You must first define the available components, their paper, color, finishing and pricing. When the components are ready, you must determine which binding styles are available and which components are available for each binding style.

To define Set job types, click Print Settings > Job Business Flow > Set.

Defining Binding Properties

The Binding Styles list contains all the binding styles that are available to the Print Buyer. The following default binding styles are available:

- Binder
- Saddle Stitch
- Perfect
- Double Wire-O
- Thermal Bind

After selecting the binding style, you should navigate through the various tabs and set values for the following properties:

- General - define the General Binding Style properties.
- Page Size - define the sizes available for each Binding Style.
- Material - define the different materials used for the Set job.
- Pricing - define the price for assembling each Set unit and to define quantity discounts.

Setting General Properties

You can define Spine type and width for Binding Styles that do not have binding materials (such as saddle-stitching). When the binding style requires binding materials, the spine type and width are defined in the Materials tab. If the spine is set from the Materials tab, the Spine and Width boxes do not appear in the General view.

Select one of the following options from the Spine drop down box:

- Fixed - define a binding spine that is not affected by the actual thickness of a job. Type 0 in the Width box to define that there is no spine.
- Calculated - used for binding styles in which the binding spine width results from the actual job thickness. Calculated Spine enables setting the maximum spine width to prevent the Print Buyer from creating a job that cannot be handled. With this setting, the system automatically calculates the spine width according to the total thickness of the files that the Print Buyer adds to the job.
Setting Page Size Properties

Select the page size for the Set job. Available options include:

Fixed Sizes - select the sizes which are appropriate for this binding style. These sizes will be presented as a selection option to the Print Buyer during ordering. The sizes displayed are based on the paper sizes defined in your system.

Custom Sizes - when required page sizes do not appear in the Fixed Sizes list, you can create any number of custom sizes.

Setting Material Properties

Binding styles can involve different materials for operator selection (i.e. ring binders, spiral binders, etc.). Each material can have a different price and a different preview.

When a Print Buyer orders a job and selects a binding style with a list of materials, these materials will be presented to him as selection options. For example: If the Print Buyer selects a binder job type, the next stage will be to select the appropriate binder.

Material Properties enables defining the Spine type and width. You can also add front cover, back cover and pages spine images that will be superimposed on the PDF preview.

Setting Pricing Properties

You can determine the price for each unit of a Set job, as well as determine the range of discounts for the job.

Defining Component Properties

The Component Properties pane appears when you select a component, and it includes the following tabs:

- General
- Paper Selection
- Color Channels
- Finishing
- Pricing

General Properties

The General view enables you to determine the following:

- Specify whether the component is one-sided or two-sided (also known as simplex and duplex).
- Enter an internal note and a note for the print buyer for the specific component.
Paper Selection Properties

The Paper Selection tab enables you to define the paper types on which the component can be printed and enables you to set the default paper category names. The Print Buyer can view these options in the Paper box of the Set job properties window.

Paper Category

Paper Category enables you to create name aliases for a specific paper and simplifies the ordering process for the Print Buyer. For each Paper Category, at least one valid Paper must be defined.

Paper List

The Paper List contains a list of papers that are connected to a specific paper category. The color of the paper items in the list is significant. Black color signifies a paper item that is in stock; gray color signifies that the paper has been temporarily disabled in the stock library; and red color signifies that the paper has been removed from the stock library.

When there is more than one paper in the Paper List, the first item in the list is the default. To set another paper as default, select the target paper and move it up until it is the first one in the list.

Color Channel Properties

Color Channels enables you to define whether the component will be printed in process colors or with black ink only.

The Color Channels tab contains the following elements:

- Process - When selected, the component becomes a Full Color component and when it is assigned to Set pages, these pages will be priced and printed as color pages.
- Black & White - When selected, the component becomes a Black and White component and when it is assigned to Set pages, these pages will be printed with black ink and priced accordingly.

Finishing Properties

The Finishing tab enables you to define whether the component will be laminated.

Pricing Properties

The Pricing tab enables you to set up the component pricing, and includes the following:

Price per Page

Price per Page enables defining a base price per page, for each page size that is possible for this component. Enter the price only for page sizes that you expect to be using in Set Jobs.
Pages Quantity Discount

Pages Quantity Discount enables define discount levels based on the total number of pages for this component type in a specific Set job.

- Min - Minimum number of pages ('1' by default)
- Max - Maximum number of pages ('Infinite' by default)
- Discount - Fixed discount, according to the number of printed pages
- Add Row - Click to add an empty row to the bottom of the table
- Delete Last Row - Click to delete the last row at the bottom of the table
- Add Paper Price - When selected, the application will add the cost of the paper to the printing price

Defining a Set Preview

Set enables the Print Buyer to receive a simulated view of the entire job, with all its various elements. The preview allows the Print Buyer operator to flip through and review the job during the creation process, functioning as a tool for avoiding design flaws and mistakes. For the preview to achieve its full potential, it has to be defined for each binding style and appropriate size.

Material Properties enables providing default settings for A4, A5, Letter, and Ledger page sizes. These settings can be changed according to need. In the default preview settings, the preview size appears larger than the default size in order to display the background.

The system does not require preview information for a specific size in order to provide a preview. If preview information is missing from a size that is available to the Print Buyer, the system will search among the existing sizes with preview information and will choose the size that is closest to the size lacking the preview information. The chosen size is then automatically scaled to the size lacking the preview.
Defining a Set Preview

**Preparation**

Before you can start setting up the preview, you have to define the preview size, and then create appropriate images.

To create a realistic-looking preview, Set places the supplied background image (A), superimposes onto it the file content as uploaded by the Print Buyer (B), and places on the top an image simulating the appearance of the binding element (C).

**Figure 72: Stages of a Set Preview**

![Set Preview Stages](image)

- The view's image is placed in the background
- The uploaded file information is positioned above
- Any binding-related images (such as the binder rings or the spiral) is positioned on top

**Optional Spine**

Optional Spine enables providing the following settings only when the spine/cover and foreground are required in the style:

- External Spine Image; which will serve as the background image of the spine
- Spine Position (top-left corner)
- Spine Width; the size of the spine in the original image

The Binding Preview Spine Width is not the size of the spine that has been set for the binding style. Binding Preview Spine Width is a setting that is necessary for placement calculation. The size number must be entered (and should be greater than 0) if a file, under the External Spine Image, exists.

**Establish the Preview Size**

The width of the preview must be double that of the page size plus the width of the margins. If no margins are added, the background will not appear in the preview.

When setting height and width of the preview size to the same size as the page size dimensions, the background will not be displayed. This is suitable for graphically depicting binding types such as thermal binding. To view the background as well, the height and width of the preview size should be larger than two pages side by side. This is suitable for depicting binding types such as binder.
Prepare the following background files for the display:

- External Front Cover
- Internal Front Cover
- Pages
- Internal Back Cover
- External Back Cover

All the background files must be the same size.

If the binding has a prominent visual feature that can be seen when flipping through a real similar product (such as binder rings) you might wish to create appropriate foreground images for each of the following views:

- Internal Front Cover
- Pages
- Internal Back Cover

**Establish the Left and Right Page Position**

The left page position is defined by the position of its top-right corner relative to the top-left corner of the background image.

The right page position is defined by the position of its top-left corner relative to the top-left corner of the background image.

If know these numbers are unknown, they can be found by using Acrobat. In order to locate this point, carry out the following steps:

**Left Page**

1. Open the image in Acrobat, on the local PC.
2. Click on the Crop Tool (Tools > Advanced Editing > Crop Tool) and outline the left page.
3. Double-click on the image; the Crop Pages dialog box appears; the Top-right corner is the composite of the top and right coordinates.

**Right Page**

1. Click on the Crop Tool and outline the right page.
2. Double-click on the image; the Crop Pages dialog box appears; the Top-left corner is the composite of the top and left coordinates.
Setting up a New Preview

To set up a new Preview, carry out the following steps:

1. To access the preview definition, select Print Settings > Job Business Flow > Set.
2. Select a binding style and then click the Page Size tab.

Add/Edit Preview Link

Adjacent to each Page Size is a PDF icon and a Preview link which accesses the Binding Preview window. The system provides the following two Preview link options:

- Add Preview (with a gray PDF icon) - A preview does not exist but can be created by entering the appropriate information into the various Binding Preview data boxes
- Edit Preview (with a red PDF icon) - An editable preview already exists and can be edited by entering the appropriate information into the various Binding Preview data boxes

Click on Add Preview near a selected page size; the Binding Preview dialog box appears.

Setting up a Binding Preview

Binding Preview enables defining the background image on which the Set job created by the Print Buyer will appear, creating a full preview experience.

In addition, you must set the following:

- The Preview sizes
- Left and Right page positions

If a Spine is defined and there is a cover for the style, you must also set the position and width of the spine.

Producing a Set Job

To produce a Set job, perform the following:

1. Click Tasks > Production; the Production window appears.
   Set jobs waiting in the Approval queue are marked by the Set icon.
2. Select a job.
   The Files tab displays a list of the files comprising the job. Since the job can contain multiple files and components, its production is often split between several devices.
3. Click Split Files; the Split PDF dialog box appears.
4. Select the splitting options, component types, color channels, or color content of the files and click OK.
5. Click Approve to send the files to production.